
Sun Microsystems, Inc.
4150 Network Circle
Santa Clara, CA 95054 U.S.A.
650-960-1300

请将关于本文档的意见提交到：http://www.sun.com/hwdocs/feedback

Sun StorEdge™ 3000 系列
Configuration Service 1.3

用户指南

Sun StorEdge 3310 SCSI 阵列

Sun StorEdge 3510 FC 阵列

部件号 817-2773-11
2003 年 6 月，修订版 A



请
回收

版权所有 © 2002-2003 Dot Hill Systems Corporation, 6305 El Camino Real, Carlsbad, California 92009, USA. 保留所有权利。

Sun Microsystems, Inc. 和 Dot Hill Systems Corporation 可能拥有与本产品或文档中涉及的技术相关的知识产权。具体来说 （且不仅限于此），
这些知识产权包括 http://www.sun.com/patents 所列出的美国专利中的一项或多项，以及在美国或其他国家 （地区）申请的一项或多项补充
专利或未决专利。

本产品或文档按照限制其使用、复制、分发和反编译的许可证进行分发。未经 Sun 及其许可方 （如果有）的事先书面授权，不得以任何形式或
任何手段复制本产品或文档的任何部分。

第三方软件由 Sun 供应商提供版权及许可授权。

本产品的某些部分来源于 Berkeley BSD 系统，已获得 University of California 的许可。 UNIX 是在美国和其他国家 （地区）的注册商标，已通
过 X/Open Company, Ltd. 获得独家许可。

Sun、 Sun Microsystems、 Sun 标志、 Sun StorEdge、 AnswerBook2、 docs.sun.com, 和 Solaris 是 Sun Microsystems, Inc. 在美国和其他国家
（地区）的商标或注册商标。

美国政府权利 － 商业用途。政府用户必须遵循 Sun Microsystems, Inc. 标准许可协议和 FAR 及其补充规定中的适用条款。

文档按 “原样”提供，不做任何明示或暗示的条件假设、陈述和保证，包括不对任何适销性、适用性或非侵害性做任何暗示保证，除非此类声
明在法律上是无效的。

Copyright © 2002–2003 Dot Hill Systems Corporation, 6305 El Camino Real, Carlsbad, California 92009, Etats-Unis. Tous droits réservés.

Sun Microsystems, Inc. et Dot Hill Systems Corporation peuvent avoir les droits de propriété intellectuels relatants à la technologie incorporée 
dans le produit qui est décrit dans ce document. En particulier, et sans la limitation, ces droits de propriété intellectuels peuvent inclure un ou 
plus des brevets américains énumérés à http://www.sun.com/patents et un ou les brevets plus supplémentaires ou les applications de brevet 
en attente dans les Etats-Unis et dans les autres pays.

Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent l’utilisation, la copie, la distribution, et la 
décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune forme, par quelque moyen que ce soit, sans 
l'autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y ena.

Le logiciel détenu par des tiers, et qui comprend la technologie relative aux polices de caractères, est protégé par un copyright et licencié par des 
fournisseurs de Sun.

Des parties de ce produit pourront être dérivées des systèmes Berkeley BSD licenciés par l’Université de Californie. UNIX est une marque 
déposée aux Etats-Unis et dans d’autres pays et licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, Sun StorEdge, AnswerBook2, docs.sun.com, et Solaris sont des marques de fabrique ou des marques 
déposées de Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays.

LA DOCUMENTATION EST FOURNIE “EN L’ÉTAT” ET TOUTES AUTRES CONDITIONS, CONDITIONS, DECLARATIONS ET 
GARANTIES EXPRESSES OU TACITES SONT  FORMELLEMENT EXCLUES, DANS LA MESURE AUTORISEE PAR LA LOI APPLICABLE, 
Y COMPRIS NOTAMMENT TOUTE GARANTIE IMPLICITE RELATIVE A LA QUALITE MARCHANDE, A L'APTITUDE A UNE 
UTILISATION PARTICULIERE OU A L’ABSENCE DE CONTREFAÇON.



目录

前言 xvii

1. 介绍 1

2. 开始之前 3

屏幕示例 3

Solaris 操作环境 3

Windows NT/2000 操作系统 4

超级用户 / 管理员特权 4

3. 将 Sun StorEdge Configuration Service 安装在运行 Solaris 操作环境的系统上 5

系统要求 5

安装 Sun StorEdge Configuration Service 前的准备工作 6

安装软件 7

安装软件包 7

▼ 安装 Agent 和 Console 8

▼ 启动或停止 Agent 12

用户和口令 13

管理 （用户）安全级别和准则 13

▼ 创建密码和权限 14

卸载 Sun StorEdge Configuration Service 15
iii



▼ 卸载 Sun StorEdge Configuration Service 15

恢复配置 15

4. 在 Windows NT 或 Windows 2000 操作系统上安装 Sun StorEdge Configuration 
Service 17

系统要求 17

安装 Sun StorEdge Configuration Service 前的准备工作 18

安装软件 19

安装软件包 19

▼ 安装 Agent 和 Console 19

▼ 在 Windows NT Server 上启动或停止 Agent 20

▼ 在 Windows 2000 Server 上启动或停止 Agent 20

用户和口令 20

管理员 （用户）安全级别和准则 20

多台服务器上的全局密码 21

▼ 要创建 Windows NT 用户 22

▼ 创建 Windows 2000 用户 22

卸载 Sun StorEdge Configuration Service 23

▼ 卸载 Sun StorEdge Configuration Service 23

5. 将 Sun StorEdge Configuration Service 安装在运行 Linux 操作环境的系统上 25

系统要求 25

安装 Sun StorEdge Configuration Service 前的准备工作 26

安装软件 27

安装软件包 27

▼ 安装 Agent 和 Console 27

▼ 启动或停止 Agent 29

用户和密码 30

管理 （用户）安全级别和准则 30

▼ 创建密码和权限 31
iv Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



卸载 Sun StorEdge Configuration Service 32

▼ 卸载 Sun StorEdge Configuration Service 32

6. 设置 Sun StorEdge Configuration Service 33

启动 Sun StorEdge Configuration Service 34

▼  在 Solaris/Linux 操作环境中启动 Sun StorEdge Configuration 
Service 34

▼ 在 Microsoft Windows NT/2000 操作系统中启动 Sun StorEdge 
Configuration Service 34

首次使用前后的主窗口 35

如果 Console 在使用过程中锁死 35

▼ 停止 Sun StorEdge Configuration Service 35

菜单、工具条和选项卡 36

菜单栏 36

工具栏 36

选项卡 38

物理 （硬盘）驱动器 38

导航 38

▼ 添加服务器 39

▼ 登录和注销 44

▼ 选择用于管理控制器的服务器 45

通过控制台分配控制器 45

更改服务器分配 48

▼ 取消分配管理服务器 49

▼ 使用终端窗口手动删除服务器 49

▼ 配置代理参数 （可选） 50

▼ 启用 JBOD 支持 （仅对 SCSI） 52

▼ 验证存储配置 53

▼ 保存逻辑驱动器配置 55

▼ 在运行 Solaris 操作环境的系统中，在服务器上创建分区 56
目录 v



▼ 在使用 Windows NT 操作系统的服务器上创建分区 57

▼ 在 Windows 2000 操作系统中在服务器上创建分区 58

下一步骤 60

7. 完全配置 61

配置逻辑驱动器和逻辑卷 62

▼ 要对 Configure Logical Drives （配置逻辑驱动器） 使用 Standard 
Configuration （标准配置） 62

▼ 用 Custom Configuration 配置逻辑驱动器和逻辑卷 65

New Configuration （新配置） 选项 66

使用 New Configuration 之前 67

▼ 准备容量超过 253 GB 的逻辑驱动器 68

▼ 使用 New Configuration 创建逻辑驱动器并对其进行分区 69

▼ 创建和分区逻辑卷 74

▼ 清除配置 76

▼ 从配置级别注销 76

主机 LUN 分配 76

▼ 添加 （映射）主机 LUN 77

▼ 删除 （取消映射）主机 LUN 78

配置文件 79

▼ 将配置保存到备份文件 79

装入配置 80

8. LUN 过滤 （仅用于光纤通道） 81

概述 81

分配 LUN 过滤器 83

▼ 访问 LUN Filter 视图 83

▼ 手动添加 HBA 设备 84

▼ 删除标准主机映射 86

▼ 将逻辑驱动器映射到主机 87
vi Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



▼ 删除 LUN 过滤器 89

9. 监控阵列 91

主窗口 91

联机帮助 93

产品配置的树视图 93

组 94

监控过程 96

Auto Discovery 选项 97

查看详细设备信息 98

View Group 99

View Server 100

查看控制器配置 101

Controllers 选项卡 102

Physical Drives 选项卡 103

Enclosure Info 选项卡 104

View FRU 104

View Controller Parameters 104

View Primary/Secondary Controller Configuration （查看主 / 辅助控制
器配置） 105

Logical Drives 选项卡 107

View Logical Drive 107

查看物理驱动器 108

View Enclosure 109

View FRU 110

Array Administration Progress 111

Agent Options Management 111

事件日志 111

事件日志文件 112
目录 vii



Event Log 窗口 113

严重级别 114

Save Report 115

View Report 118

带外存储管理 118

▼ 使用带外管理 120

▼ 通过带外管理删除阵列 122

通过 Web 管理存储设备 123

Web 浏览器要求 123

Solaris/Linux 操作环境 123

Windows NT/2000 操作系统 124

设置阵列 124

▼ 通过 Web 浏览器访问控制台 125

10. 维护阵列 127

Array Administration Activities （阵列管理活动） 127

▼ 进行奇偶校验  128

▼ 进行奇偶校验调度  129

故障驱动器 131

▼ 使用备用驱动器自动重建驱动器 131

▼ 在没有备用驱动器的情况下进行设备重建 132

▼ 检查重建过程的进度 132

▼ 手动重建故障驱动器 132

▼ 恢复逻辑驱动器配置 134

▼ 重置控制器 136

▼ 将控制器蜂鸣器静音 137

▼ 让故障控制器恢复联机 137

▼ 将双控制器阵列转换为单控制器阵列 138

▼ 显示 Performance Statistics 139
viii Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



11. 更新配置 141

▼ 添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷 142

▼ 将逻辑驱动器添加到逻辑卷 143

▼ 将现有的逻辑驱动器添加到逻辑卷 144

▼ 删除逻辑驱动器或逻辑卷 146

逻辑驱动器 / 逻辑卷号码 147

▼ 创建分区 148

逻辑驱动器 / 逻辑卷号码 150

▼ 删除分区 150

▼ 扩展逻辑驱动器或逻辑卷的容量 151

逻辑驱动器 / 逻辑卷号码 152

▼ 将 SCSI 驱动器添加到现有逻辑驱动器 153

逻辑驱动器 / 逻辑卷号码 154

▼ 复制并替换成员驱动器 154

逻辑驱动器 / 逻辑卷号码 155

▼ 扫描新硬盘驱动器     156

▼ 下载 RAID 控制器固件 157

▼ 升级固件和引导记录 159

下载用于设备的固件 160

▼ 升级硬盘驱动器上的固件 160

▼ 升级 SAF-TE/SES 设备的固件 161

▼ 更改控制器参数 162

▼ 保存已更改值 163

Channel 选项卡 163

RS 232 选项卡 165

Cache 选项卡 166

Disk Array 选项卡 169

Drive I/F 选项卡 170
目录 ix



Host I/F 选项卡 172

Redundancy 选项卡 173

Network 选项卡 174

▼ 将控制器蜂鸣器静音 175

▼ 指定或更改备用驱动器 176

可用服务器 177

▼ 编辑服务器条目 177

A. RAID 基本知识 179

RAID 术语概述 179

RAID 级别 185

本地和全局备用驱动器 191

B. 监控 JBOD （仅用于 SCSI） 195

▼ 启用 JBOD 支持 195

▼ 查看组件和警报特性 197

下载用于设备的固件 198

▼ 升级硬盘驱动器上的固件 198

▼ 升级 SAF-TE 设备的固件 199

▼ 更换故障驱动器 200

C. 使用群集配置 （仅限 SCSI） 201

规划群集配置 201

群集配置要求 202

▼ 设置群集配置 202

D. 确定主机全球广域名称 （仅限光纤通道） 207

▼ 确定 WWN 207

▼ 确定 WWNN 209

▼ 确定 WWPN 210
x Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



E. 电子邮件和 SNMP 211

为每台服务器发送电子邮件消息 212

▼ 为每台服务器发送电子邮件消息 212

设置服务器发送陷阱 215

▼ 检查社区字符串 215

▼ 指定陷阱接收者 216

▼ 设置 Solaris 操作环境服务器 217

▼ 设置 Linux 操作环境服务器 218

SNMP 的工作方式 218

▼ 在不使用 Sun StorEdge Configuration Service 的情况下发送 SNMP 陷
阱 222

F. 故障检修 223

G. 错误代码和消息 231

错误代码 231

错误和状态消息    246

安装和程序提示 262

词汇表 267

索引 273
目录 xi



xii Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



图

图 8-1 LUN 筛选示例 82

图 9-1 带内管理 119

图 9-2 带外管理 119

图 11-1 复制并替换成员驱动器 154
xiii



xiv Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月 



表

表 3-1 控制台系统要求 6

表 3-2 代理系统要求 6

表 3-3 Solaris 操作环境必需的 Sun StorEdge Service 安装软件包 7

表 4-1 控制台系统要求 18

表 4-2 代理系统要求 18

表 5-1 控制台系统要求 25

表 5-2 代理系统要求 26

表 9-1 设备状态状况 93

表 9-2 双服务器组颜色 95

表 9-3 事件记录字段 114

表 11-1 对于 2U 阵列，每个逻辑驱动器的磁盘最大数量 167

表 11-2 对于 2U 阵列，每个逻辑驱动器的最大可用容量 (GB) 167
xv



xvi Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



前言

本用户指南介绍如何安装和使用 Sun StorEdge Configuration Service 对 Sun StorEdge 
3510 FC 和 3310 SCSI 阵列进行配置、监视和管理。

除非另行指出，否则 Sun StorEdge 3510 FC 阵列和 3310 SCSI 阵列在本书中通称为阵
列。本指南还介绍使用 Sun StorEdge 3000 Family Diagnostic Reporter （Sun 
StorEdge Configuration Service 的伴随实用程序）在主机和阵列之间发送和接收系统
消息。有关安装和使用 Sun StorEdge Diagnostic Reporter 的详细信息，请参考 Sun 
StorEdge 3000 Family Diagnostic Reporter 用户指南。

本指南是为已经熟悉 Sun 的硬件和软件产品的有经验的系统管理员编写的。

本书的结构
本书包含下列主题：

第 1 章介绍 Sun StorEdge Configuration Service 的功能。

第 2 章列出了在安装和使用 Sun StorEdge Configuration Service 之前确保阵列正确配
置所要采取的步骤。

第 3 章提供了在运行 Solaris 操作环境的系统上安装 Sun StorEdge Configuration 
Service Console 和 Agent 的系统要求和过程。

第 4 章提供了在 Windows NT/2000 系统上安装 Sun StorEdge Configuration Service 
Console 和 Agent 的系统要求和过程。

第 5 章提供了在运行 Linux 操作环境的系统上安装 Sun StorEdge Configuration 
Service Console 和 Agent 的系统要求和过程。

第 6 章包含设置 Sun StorEdge Configuration Service 的过程。

第 7 章提供了配置阵列的指导。
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第 8 章介绍如何创建 LUN 筛选器，以维护共享公共存储设备的大型光纤通道网络（仅
限光纤通道）。

第 9 章说明如何监控阵列。

第 10 章 说明如何维护阵列的完整性。

第 11 章说明如何对当前阵列配置进行更改或添加。

附录 A 提供基本的 RAID 信息。

附录 B 解释如何监控固件以及将其下载到独立的 JBOD （仅限 SCSI）。

附录 C 提供如何设置群集配置的信息 （仅限 SCSI）。

附录 D 介绍如何确定运行 Solaris 操作环境和 Windows NT 的系统上的主机全球广域
名称 (WWN)。

附录 E 解释如何设置完整的事件监控和电子邮件通知功能。

附录 F 提供针对一系列症状的故障检修建议。

附录 G 包含 Configuration Service 错误代码和消息的列表。

词汇表提供在产品文档中使用的 RAID 术语和定义。
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使用 UNIX 命令
本文档可能不包含有关关闭系统、引导系统以及配置设备等基本 UNIX® 命令和过程的
信息。

此类信息请阅读以下文件：

■ Solaris Handbook for Sun Peripherals
■ 适用于 Solaris 操作环境的 AnswerBook2 联机文档。
■ 随系统一起提供的其他软件文档。

排印惯例

字体*

* 您所用浏览器的设置可能与这里的设置不同。

含义 示例

AaBbCc123 命令、文件和目录的名称；计算

机屏幕输出

编辑您的 .login 文件。

使用  ls -a  列出所有文件。

% You have mail.

AaBbCc123 您键入的文字，与屏幕上的计算
机输出形成对比

% su

Password:

AaBbCc123 书名、新词或者要强调的术语、
词用实际名称或值代替命令行参

数。

请阅读用户指南 中的第 6 章。

这些称作类选项。

您必须是超级用户才能执行此操作。

要删除文件，请键入 rm 文件名。
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Shell 提示符

相关文档

Shell 提示符

C shell 机器名称 %

C shell 超级用户 机器名称 #

Bourne shell 和 Korn shell $

Bourne shell 和 Korn shell 超级用户 #

产品 标题 部件号

仅限 Sun StorEdge 3310 SCSI 
阵列

Sun StorEdge 3310 SCSI Array Release Notes 816-7292

Sun StorEdge 3000 系列最佳做法手册 817-2996

Sun StorEdge 3000 Family RAID Firmware 3.25 User's Guide 816-7296

Sun StorEdge 3000 系列安装、操作和维护手册 816-7960

仅限 Sun StorEdge 3510 FC 
阵列

Sun StorEdge 3510 FC Array Release Notes 816-7301

Sun StorEdge 3000 系列最佳做法手册 817-2763

 Sun StorEdge 3000 Family RAID Firmware 3.27 User's Guide 816-7934

Sun StorEdge 3000 系列安装、操作和服务手册 817-2760

Sun StorEdge 3310 SCSI 和
Sun StorEdge 3510 FC 阵列

Sun StorEdge 3000 系列 Diagnostic Reporter 1.3 用户指南 817-2776

Sun StorEdge 3000 系列机架安装指南 817-2770

Sun StorEdge 3000 系列 FRU 安装指南 817-2767

Sun StorEdge 3000 Family Safety, Regulatory, and Compliance 
Manual

816-7930
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联系 Sun 技术支持
要获得最新的新闻和故障检修的提示，请查看相应目录中与您的阵列相关的发行说明： 

www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/

如果您关于此产品的技术问题在文档中没有答案，请转到：

http://www.sun.com/service/contacting

要发出或检查仅限美国的服务请求，请与 Sun 支持部门联系：

800-USA4SUN

要获得国际技术支持，请通过如下网址联系各个国家的的销售部门：

www.sun.com/service/contacting/sales.html

访问 Sun 文档
所有的 Sun StorEdge 3000 系列文档都有 PDF 和 HTML 两种格式，可以从如下位置在
线获得：

http://www.sun.com/products-n-solutions/ 
hardware/docs/Network_Storage_Solutions/Workgroup/

您可以通过下面的网址查看、打印或购买种类繁多的 Sun 文档：

http://www.sun.com/documentation

您可以通过下面的网址订购 Sun StorEdge 3000 系列手册的印刷副本：

http://corppub.iuniverse.com/marketplace/sun
前言 xxi



508 辅助功能
Sun StorEdge 文档也有相应的满足 508 规范的 HTML 文件，有视觉缺陷的用户可以借
助相关程序使用这些文件。您的产品的文档 CD 中提供了这些文件，前面的 “访问 
Sun 文档”部分指明的 Web 站点中也提供了这些文件。此外，该软件和固件应用程序
提供了键盘导航和快捷键，用户指南中有此说明。

Sun 欢迎您提出意见和建议
Sun 乐于对其文档进行改进，欢迎您提出意见和建议。您可以到下面的网址提交您的
意见：

http://www.sun.com/hwdocs/feedback

请在您的反馈中包含文档的标题和部件号：Sun StorEdge 3000 系列 Configuration 
Service 1.3 用户指南，部件号 817-2773-11。
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第 章1

介绍

本部分简要介绍 Sun StorEdge Configuration Service 的特点。

注意 - Sun StorEdge Configuration Service 在本指南中有时被简称为程序。

Sun StorEdge Configuration Service 是一个基于 Java™ 编程语言的复杂程序，它将存
储配置、资源分配、维护和监控工具集成到一个应用程序中，从而实现对阵列的集中管
理。

仅通过网络中的单一控制台，系统管理员就能够通过直观的图形用户界面 (GUI) 初始化
网络存储设备，更改配置，监控状态并调度例程维护。

管理员还可以根据随全网络存储需求变化而改变的存储要求，动态地分配、重新分配或
扩展容量。 

一旦状态发生变化，该程序就会通过控制台显示、电子邮件或字母数字寻呼机发送报
警。该程序还可以将报警发送到任何简单网络管理协议 (SNMP) 企业管理器 （如 HP 
OpenView）。 
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Sun StorEdge Configuration Service 包含两个组件：

■ Sun StorEdge Configuration Service Agent - Solaris 8 和 Solaris 9 操作环境、
Windows NT 和 Windows 2000、 Sun™ Linux 5.0 以及 Red Hat Linux 7.2 和 7.3 
操作环境。

此代理监控连接的磁盘存储设备，并向控制台报告这些设备的状态。需要在网络中
作为 Sun StorEdge Configuration Service 的一部分的每台独立服务器上安装代理软
件。可以从网络中的单一工作站通过远程方式完成安装。 

■ Sun StorEdge Configuration Service Console - Solaris 8 和 Solaris 9 操作环境、
Windows NT 和 Windows 2000、 Sun Linux 5.0 以及 Red Hat Linux 7.2 和 7.3 操
作环境。

控制台包含 Sun StorEdge Configuration Service 的 GUI 部分，用来显示代理报告
的信息。控制台还提供了从单一工作站对设备进行远程配置和管理的功能。控制台
需要安装在管理网络中的服务器的计算机上。
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第 章2

开始之前

本章包含在安装和使用 Sun StorEdge Configuration Service 之前需要注意的重要信
息。本章包含以下主题：

■ 第 3 页的 “屏幕示例”
■ 第 3 页的 “Solaris 操作环境”
■ 第 4 页的 “Windows NT/2000 操作系统”
■ 第 4 页的 “超级用户 / 管理员特权”

屏幕示例
本指南中提供了许多屏幕示例，用来对该程序进行说明。这些屏幕在输出中可能会标识
出 Sun StorEdge 3310 阵列或 Sun StorEdge 3510 阵列。除非特别声明某项功能（及其
示例屏幕）是 Sun StorEdge 3510 FC 阵列所特有的，否则表示该功能对两种阵列都适
用。

Solaris 操作环境
在将 Sun StorEdge Configuration Service 安装在运行 Solaris 操作环境的系统之前：

■ 确保安装有  Sun StorEdge Configuration Service Agent 的主机服务器已连接到一
个分配有主 ID 的通道上。请参考适用于您的阵列的 Sun StorEdge 3000 系列安装，
操作和维护手册，了解控制器默认值和初始配置信息。

■ 对于 Sun StorEdge 3310 SCSI 阵列，请确保操作环境能够识别同一 ID 下的多个 
LUN。您可能需要为附加的主机 LUN 分配修改 /kernel/drv/sd.conf。有关如
何修改此文件的信息，请参考适用于您的 SCSI 阵列的 Sun StorEdge 3000 系列安
装、操作和维护手册。如果对 sd.conf 进行了任何更改，则需要重新引导工作站才
能使更改生效。
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Windows NT/2000 操作系统
在将 Sun StorEdge Configuration Service 安装到 Microsoft Windows 操作系统之前：

■ 确保安装有  Sun StorEdge Configuration Service Agent 的主机服务器已连接到一
个分配有主 ID 的通道上。请参考适用于您的阵列的 Sun StorEdge 3000 系列安装、
操作和维护手册，了解控制器默认值和初始配置信息。

■ 确保服务器已连接到操作系统，而且服务器能够识别存储设备。

超级用户 / 管理员特权
您必须有超级用户 / 管理员特权才能安装 Sun StorEdge Configuration Service 和运行
控制台。
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第 章3

将 Sun StorEdge Configuration 
Service 安装在运行 Solaris 操作环境
的系统上

本章介绍在运行 Solaris 操作环境的系统上安装 Sun StorEdge Configuration Service 
Console 和 Agent 的过程。本章包含下列主题：

■ 第 5 页的 “系统要求”
■ 第 6 页的 “安装 Sun StorEdge Configuration Service 前的准备工作”
■ 第 7 页的 “安装软件”
■ 第 13 页的 “用户和口令”
■ 第 15 页的 “卸载 Sun StorEdge Configuration Service”
■ 第 15 页的 “恢复配置”

系统要求
■ Netscape™ 4.0 或更高版本 - 用于查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 - 每个控制台必须具有符合 TCP/IP 的网络接口
（如以太网或令牌环网卡，或串行线调制解调器）。 

■ 控制台在 1024 x 768 像素显示器分辨率和 256 色时查看效果最佳。有关其它控制台
要求，请参阅下表。
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■ 符合 TCP/IP 的代理网络接口 - 每个代理必须具有支持 TCP/IP 的网卡接口和驱动
程序集 （包括在操作环境中）。有关其它代理要求，请参阅下表。

安装 Sun StorEdge Configuration Service 
前的准备工作
在安装程序及其相关软件组件前，应注意以下必需的过程和附加选项。

■ 务必阅读适用于您的阵列的发行说明。

■ 安装操作环境更新程序。要在运行 Solaris 操作环境的系统上使用 Sun StorEdge 
Configuration Service，需要安装 Sun 建议的用于 Solaris 8 和 Solaris 9 操作环境的
最新操作环境修补程序和 Java 修补程序。有关 Sun 所建议的修补程序的列表，请参
考适用于您的阵列的发行说明。 

■ 如果操作环境包含企业管理控制台，则可以选择将代理配置为用 SNMP 服务向控制
台发送陷阱事件。SNMP 服务是操作环境附带的，并在安装 TCP/IP 协议栈后安装。

■ 如果要让网络上的服务器将 SNMP 陷阱发送到企业管理控制台，请参阅第 211 页的
“电子邮件和 SNMP”。

■ 可选项。要安装和使用 Sun StorEdge Diagnostic Reporter，需要一个 Sun 
StorEdge Configuration Service 伴随程序向指定电子邮件地址发送您的存储系统事
件，请参考 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

表 3-1 控制台系统要求 

Solaris 操作环境版本 内存 磁盘空间

安装了 Sun 所建议的修补程

序的 Solaris 8 和 9。
（有关 Sun 所建议的修补程
序的列表，请参考适用于您

的阵列的 发行说明。）

建议 64 MB 16 MB 的最小可用磁盘空间

表 3-2 代理系统要求 

Solaris 操作环境版本 内存 磁盘空间

Solaris 8 和 Solaris 9 128 MB （最少） 1 MB （可用磁盘空间）
（最少）
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■ 可选项。要使用多路径功能，必须要有用于 Solaris 操作环境的 Sun StorEdge 
Traffic Manager 软件（包含在 Sun StorEdge SAN Foundation 软件中）。有关的详
细信息，请参考适用于您的阵列的发行说明中的 “支持的其它软件”部分。

注意 - 必须是超级用户才能安装 Sun StorEdge Configuration Service 和运行控制台。

安装软件
Sun StorEdge Configuration Service 包含以下组件：

■ Sun StorEdge Configuration Service Agent。

■ Sun StorEdge Configuration Service Console。

■ Diagnostic Reporter （可选实用程序） - 有关安装和操作的信息，请参考 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南。

■ 命令行界面 (CLI) - 有关安装的信息，请参考适用于您的阵列的 Sun StorEdge 3000 
系列安装、操作和维护手册。

安装软件包

Sun StorEdge Configuration Service Agent 和 Console 安装软件包包含在 Sun 
StorEdge 3000 系列 Professional Storage Manager CD 中。该程序支持四种语言。下
表指明了每种语言所必需的文件。

注意 - 每种语言都需要用于控制台和代理的英文安装软件包。

表 3-3 Solaris 操作环境必需的 Sun StorEdge Service 安装软件包

英语 法语 日语 简体中文

Agent SUNWscsd SUNWscsd
SUNWfscsd

SUNWscsd
SUNWjscsd

SUNWscsd
SUNWcscsd

控制台
SUNWscsu SUNWscsu

SUNWfscsu
SUNWscsu

SUNWjscsu

SUNWscsu
SUNWcscsu
第 3 章 将 Sun StorEdge Configuration Service 安装在运行 Solaris 操作环境的系统上 7



▼ 安装 Agent 和 Console
将代理安装在作为 Sun StorEdge Configuration Service 的一部分的每台服务器上。在
计划用于管理和维护存储系统的计算机或工作站上安装控制台。

控制台可以安装在服务器或任何客户机系统上。代理必须安装在存储器所连接的服务器
上。

完成下列步骤以安装代理、控制台，或者两者都安装。必须至少安装一个代理和一个控
制台才能使该程序运行。

注意 - 确保在要安装 Sun StorEdge Configuration Service 的计算机或工作站上已安装
了 Java 运行时环境 1.2 或更高版本。 

注意 - 在升级控制台或代理时，必须卸载 Sun StorEdge Configuration Service。有关
卸载的详细信息，请参阅第 15 页的 “卸载 Sun StorEdge Configuration Service”。

注意 - 如果要添加法语、日语或简体中文语言支持，必须首先 安装该程序的英文版本。

1. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 并键入

2. 使用下列方式之一安装软件包：

a. 如果只安装代理 （英文），请键入

b. 要添加法语、日语或简体中文语言支持，请键入

其中的 x 根据要安装的语言分别为 c、 j 或 f。请参阅第 7 页的“Solaris 操作环境必
需的 Sun StorEdge Service 安装软件包”了解语言包的名称。

c. 如果只安装控制台 （英文），请键入

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWxscsd

# pkgadd -d SUNWscsu
8 Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



d. 要添加法语、日语或法语语言支持，请键入

其中的 x 根据要安装的语言分别为 c、 j 或 f。请参阅第 7 页的“Solaris 操作环境必
需的 Sun StorEdge Service 安装软件包”了解安装软件包的名称。

e. 如果安装所有软件包，则应键入

f. 要从菜单中选择要安装的软件包，应键入

g. 如果只安装这两个代理 （Sun StorEdge Configuration Service 和 Sun StorEdge 
Diagnostic Reporter）（英文版），请键入

h. 如果只安装这两个代理 （Sun StorEdge Configuration Service 和 Sun StorEdge 
Diagnostic Reporter），且带有法语、日语或简体中文语言支持，请键入

其中的 x 根据要安装的语言分别为 c、 j 或 f。请参阅第 7 页的“Solaris 操作环境必
需的 Sun StorEdge Service 安装软件包”了解安装软件包的名称。有关 Sun 
StorEdge Diagnostic Reporter 软件包名称，请参考 Sun StorEdge 3000 系列 
Diagnostic Reporter 用户指南。

3. 在每个标准安装提示出现时，提供相应的响应。

安装提示都是标准的 pkgadd -d 提示，用于控制所要安装的软件包以及处理脚本的
方式 （使用超级用户特权）。

a. 在 Select 软件包提示处，根据安装方法的不同键入相应的响应。 

例如，如果选择 2a 或 2b，则键入 1 并按 Return。

# pkgadd -d SUNWxscsu

# pkgadd -d . all

# pkgadd -d .

# pkgadd -d .SUNWscsd SUNWscsa

# pkgadd -d .SUNWxscsd SUNWxscs

请选择要使用的软件包 （或选择 “all”（全部）以使用所有软件包）。
(default:all)（默认值为 “全部”） [?,??,q]: 1
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b. 如果您以前安装过该代理，则将询问您是否要恢复其配置。

键入 y 可以恢复配置。如果键入 n，则需要重新启用管理服务器。

注意 - 卸载 Sun StorEdge Configuration Service 时会删除用户口令。如果有以前的配
置，则必须重新输入 ssmon、 ssadmin 和 ssconfig 口令，如第 13 页的“用户和口
令”中所述。

c. 如果您以前安装过该控制台，则将询问您是否要恢复其配置。

按 y 可以恢复配置。如果键入 n，则需要重新添加服务器信息。

d. 要继续安装，请键入 y 并按 Return。

安装完代理以后，将显示以下信息，指示代理已经成功安装并且已经启动。 

以前的配置已保存。需要恢复以前的配置？ [y,n,?,q]:必须重新输入用户口令。 
[y,n,?,q]:y

以前的配置已保存。需要恢复以前的配置？ [y,n,?,q]: [y,n,?,q]:y

需要继续安装？ [y,n,?] y

配置并启动 Sun StorEdge(tm) Configuration Service 代理守护进程：
       配置已完成。
       Sun StorEdge(tm) Configuration Service 代理服务器守护进程已启动。
       Sun StorEdge(tm) Configuration Service 代理监视器守护进程已启动。
Sun StorEdge(tm) Configuration Service 代理启动完成。

<SUNWscsd> 的安装已成功完成。
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安装程序会检查是否安装了 Java 运行时环境 1.2 或更高版本。如果未能发现该运行时
环境，将要求您指定路径。如果您确定已经安装了 Java 运行时环境 1.2.2、 1.3 或 1.4，
而安装程序却没有找到它，请检查 /usr 目录以确认存在从 Java 到最新版本的链接，
而不是 Java 1.1。要获得有关创建链接的指示，请参阅第 223 页的 “故障检修”。

代理和控制台安装在下面的目录中：/opt/SUNWsscs/sscsconsole。

4. 要访问联机帮助，您需要指定指向 Web 浏览器 （Netscape 4.0 或更高版本）的路径。

a. 转到 /opt/SUNWsscs/sscsconsole 并键入 

b. 键入指向 Web 浏览器的绝对路径。

注意 - 可以随时配置浏览器路径名称；但是，如果不指定某一点的浏览器路径名称，将
无访问联机帮助。

5. 对于 Sun StorEdge 3310 SCSI 阵列，请编辑 /kernel/drv/sd.conf，条件是：

■ 使用带有多个驱动器和多个 LUN 的第三方 HBA
■ 使用光纤设备
■ 所有的 LUN 都具有相同的 ID

根据您的配置为逻辑单元号 (LUN) 添加行。 LUN 可以编号为 0 到 31。一般来说，添
加的 LUN 定义不应多于实际计划的数目，因为这样会增加扫描每个 SCSI 总线花费的
时间，而无论存储设备是否连接。有关修改 sd.conf 文件的信息，请参阅适用于您的 
SCSI 阵列的 Sun StorEdge 3000 系列安装、操作和维护手册。

6. 编辑完 sd.conf 文件之后，请执行重新配置重新引导。

./config_sscon
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▼ 启动或停止 Agent
通过在 /etc/init.d/ssagent 中使用运行命令脚本可以手动停止和启动代理。

1. 要启动代理，请键入

注意 - 要启动代理，必须具有超级用户特权。

如果使用了 start 前，没有先使用 stop，则脚本将重新启动所有已经停止的代理。
如果所有的代理都已经停止 （如使用了 stop 选项），则脚本将在重新启动代理之前重
新配置运行时环境。

2. 要停止代理，请键入

3. 要确定代理是否正在运行，请键入

ssmon 和 ssserver 两者都会显示在输出中。如果已经启用了 SNMP 陷阱生成，则还
会看到名称 sstrapd。

4. 如果在初始引导后没有显示存储系统，则应停止代理，并在命令行提示符处运行

5. 给所需的磁盘添加卷标，然后重新启动代理。

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# format
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用户和口令
以下部分介绍如何创建用户和口令。

管理 （用户）安全级别和准则
如果在使用 Solaris 操作环境的系统上运行该程序，则在安装过程中会自动创建管理员
安全级别。只需要根据所需的权限级别设置密码并指定用户。 

管理功能要求提供访问登录名和口令，以防止某个管理员未经授权重新分配或删除了属
于其它客户机或主机的存储资源。 

您要为程序的三个安全级别指定各自的口令。这是通过在具有由该程序管理的存储设备
的代理上创建三个用户实现的。在安装代理的过程中会自动添加这三个用户。

安全级别必须使用以下确切名称： 
■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule Parity Check 
以及监控功能的访问。 

■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些登录名称。安装后，必须为每个安全名称分配密码。

ssmon、ssadmin 和 ssconfig 是只对应到程序内安全级别的登录名。对于 UNIX 操
作环境 （Solaris 或 Linux 操作环境），这些帐户的默认 shell 将被指定到 
/bin/false，以防止用户 ID 被用于交互式登录。

可以对 Sun StorEdge Configuration Service 进行设置，使监控程序不要求用户键入 
ssmon  口令。这可以通过如下途径来实现：在控制台上将服务器添加到 “Managed 
Servers”（受管服务器）列表时选择 “Auto Discovery”（自动发现）选项。可以在每
台服务器上以本地方式设置这三个登录名称和密码。（如果需要，这些帐户可以在每台
服务器上具有不同的密码。） 

只要在这些受管代理上设置了这三个登录名，系统管理员通常就能够通过向员工分配相应
的口令提供对程序的用户访问权限，分配口令的依据是完成任务所需的安全级别。例如，
为特定服务器上具有管理特权的每个用户都分配了为用户 ssadmin 建立的相同密码。

注意 - 要将服务器添加到 Managed Servers 列表，请参阅第 39 页的 “添加服务器”。
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▼ 创建密码和权限

要为每个新用户创建密码，应键入 

管理员可能还想更改组权限，组权限位于安装期间创建的 
/opt/SUNWsscs/sscsconsole 目录内的 svrlist.dat 文件中。 

控制台是基于 Java 程序的实用程序，因此不能用于控制 Sun StorEdge Configuration 
Service 创建的文件的权限和所有权。 svrlist.dat 文件容易被不同形式的 ASCII 文
本处理器读取。其中包括用户 ssmon 的加密密码，也可以解密。 

注意 - 在添加所监控的所有代理之后，不要更改 svrlist.dat 的权限以及组所有权。

# passwd user-name
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卸载 Sun StorEdge Configuration Service 
在升级控制台或代理时，必须卸载 Sun StorEdge Configuration Service。注意有些文
件不会被删除，因为它们是在安装后创建的，并且仍对升级环境有效。

▼ 卸载 Sun StorEdge Configuration Service
使用 pkgrm 命令，后面加上要卸载的软件包名称。 

注意 - 如果添加了法语、日语或简体中文语言支持，在卸载英文软件包之前，应该先卸
载这些软件包。

其中 xxxxx 是要卸载的软件包。请参阅第 7 页的 “Solaris 操作环境必需的 Sun 
StorEdge Service 安装软件包”了解语言包的名称。

恢复配置
如果重新安装代理或控制台，则在安装过程中将询问您是否要恢复配置。如果选择恢复
配置，则将从下列文件中恢复信息：

■ /var/opt/SUNWsscs/sscsagt.cfg.tar ñ Sun StorEdge Configuration Service Agent

■ /var/opt/SUNWsscs/sscscon.cfg.tar ñ Sun StorEdge Configuration Service 
Console

注意 - 如果要永久删除 Sun StorEdge Configuration Service，您可能需要手动删除这
些文件；但是，如果您重新安装该程序，将不能恢复代理和控制台配置。

# pkgrm SUNWxxxxx
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第 章4

在 Windows NT 或 Windows 2000 
操作系统上安装 Sun StorEdge 
Configuration Service

本章介绍在 Windows NT/2000 操作系统上安装 Sun StorEdge Configuration Service 
Console 和 Agent 的过程。本章包含下列主题：

■ 第 17 页的 “系统要求”
■ 第 18 页的 “安装 Sun StorEdge Configuration Service 前的准备工作”
■ 第 19 页的 “安装软件”
■ 第 20 页的 “用户和口令”
■ 第 23 页的 “卸载 Sun StorEdge Configuration Service”

系统要求
■ Netscape 4.0 或更高版本，或者 Microsoft Internet Explorer 4.0 或更高版本 - 用于

查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 - 每个控制台必须具有符合 TCP/IP 的网络接口
（如以太网或令牌环网卡，或串行线调制解调器）。

■ 控制台在 1024 x 768 像素显示器分辨率和 256 色时查看效果最佳。有关其它控制台
要求，请参阅下表。
17



■ 符合 TCP/IP 的代理网络接口 - 每个代理必须具有符合 TCP/IP 的网卡接口和驱动
程序集 （包括在操作系统中）。有关其它代理要求，请参阅下表。

安装 Sun StorEdge Configuration Service 
前的准备工作
在安装程序及其相关软件组件前，应注意以下必需的过程和附加选项。

■ 务必阅读适用于您的阵列的发行说明。

■ 如果操作环境包含企业管理控制台，则可以选择将代理配置为用 SNMP 服务向控制
台发送陷阱事件。SNMP 服务是操作环境附带的，并在安装 TCP/IP 协议栈后安装。

■ 如果要让网络上的服务器将 SNMP 陷阱发送到企业管理控制台，请参阅第 211 页的
“电子邮件和 SNMP”。

■ 可选项。要安装和使用 Sun StorEdge Diagnostic Reporter，需要一个 Sun 
StorEdge Configuration Service 伴随程序向指定电子邮件地址发送您的存储系统事
件，请参考 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

■ 可选项。要使用多路径功能，必须要有 Sun StorEdge Traffic Manager 软件 （包含
在 Sun StorEdge SAN Foundation 软件中）。有关的详细信息，请参考适用于您的
阵列的发行说明中的 “支持的其它软件”部分。

注意 - 必须是管理员才能安装 Sun StorEdge Configuration Service 和运行控制台。

表 4-1 控制台系统要求

操作系统版本 内存 磁盘空间

Windows NT 4.0 
（SP 3 或更高版本）

Windows 2000

32 MB （最少）

建议 64 MB
20 MB 的最小可用磁盘空间

建议 40 MB

表 4-2 代理系统要求

操作系统版本 内存 磁盘空间

Windows NT 4.0 （Service 
Pack 3、 4、 5 或 6）
Windows 2000

32 MB （最小），建议使用 64 MB 或更多
内存。要求是由其他诸如数据库等大型应用

程序决定的。

2 MB （可用磁
盘空间）
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安装软件
Sun StorEdge Configuration Service 包含以下组件：

■ Sun StorEdge Configuration Service Agent。

■ Sun StorEdge Configuration Service Console。

■ Diagnostic Reporter （可选实用程序，有关安装和操作的详细信息，请参考 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南）。

■ 命令行界面 (CLI) - 有关安装的信息，请参考适用于您的阵列的 Sun StorEdge 3000 
系列安装、操作和维护手册。

在每台由 Sun StorEdge Configuration Service 管理其存储设备的服务器上安装代理。
在计划用于管理和维护系统存储的计算机或工作站上安装控制台。

安装软件包

安装软件包 setup.exe，包含在 Sun StorEdge 3000 系列 Professional Storage 
Manager CD 上，其中包括下列组件：

■ Sun StorEdge Configuration Service Agent
■ Sun StorEdge Configuration Service Console

▼ 安装 Agent 和 Console 
您需要在希望用 Sun StorEdge Configuration Service 管理其存储设备的每台 
Windows NT 或 Windows 2000 服务器上安装代理。 

注意 - 确保在要安装控制台的计算机或工作站上已安装了 Java 运行时环境 1.2 或更高
版本。 

1. 为确保软件安装实用程序工作最优化，须关闭所有的 Windows 应用程序。

2. 插入 Sun StorEdge 3000 系列 Professional Storage Manager CD 并转到 \product\
windows 目录。

3. 双击 setup.exe 并选择要安装的软件组件：SUNWsscs Agent 或 SUNWsscs 
Console。
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4. 在 Choose Destination Location（选择目的地位置） 窗口上，安装默认文件夹并单击 
Next。代理将安装在 C:\Program Files\Sun\ssagent 中；控制台将安装在 C:\
Program Files\Sun\sscs 中。

要安装到不同的文件夹，可以单击 Browse，选择另一个文件夹，并单击 Next。 

安装完成后，代理将自动启动。

▼ 在 Windows NT Server 上启动或停止 Agent
要在服务器上启动代理，必须重新引导服务器或者启动三个 Sun StorEdge 
Configuration Service 服务：位于 Settings（设置） → Control Panel（控制面板） → 
Services （服务） 下的 SUNWscsd Startup、 SUNWscsd Server 和 SUNWscsd 
Monitor。  

要停止代理，请转到 “设置” → “控制面板” → “服务”，选择要停止的代理，然后
单击 “停止”。

▼ 在 Windows 2000 Server 上启动或停止 Agent
1. 选择 Start （开始） → Administrative Services （管理服务） → Computer 

Management （计算机管理）。 

2. 单击 Services & Applications （服务和应用程序）。

3. 右击要启动或停止的服务 （SUNWscsd Monitor、 SUNWscsd Server、 SUNWscsd 
Startup）。 

另外也可以使用 Start（开始） → Settings（设置） → Control Panel（控制面板） → 
Admin Tools （管理工具） → Computer Management （计算机管理）。 

用户和口令
以下部分介绍如何创建用户和口令。

管理员 （用户）安全级别和准则

管理功能要求提供访问登录名和口令，以防止某个管理员未经授权重新分配或删除了属
于其它客户机或主机的存储资源。 
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您要为三个安全级别指定各自的口令。这是通过在具有由该程序管理的存储设备的代理
上创建三个用户实现的。 

安全级别必须使用以下确切名称： 
■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild （重建）、 Parity Check （奇偶校验）、
Schedule Parity Check （排期奇偶校验） 以及监控功能的访问。 

■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些名称。安装后，必须为每个安全名称分配密码。

ssmon、 ssadmin 和 ssconfig 是只对应到程序内安全级别的登录名。

可以对 Sun StorEdge Configuration Service 进行设置，使监控程序不要求用户输入 
ssmon 口令。这可以通过如下途径来实现：在 Console 上向 “Managed Servers”
（受管服务器）列表中添加服务器时选择 “Auto Discovery”（自动发现）选项。可以
在每台服务器上以本地方式设置这三个登录名称和密码。（这些帐户可以在每台服务器
上具有不同的密码。） 

只要在这些受管代理上设置了这三个登录名，系统管理员通常就能够通过向员工分配相
应的口令提供对程序的用户访问权限，分配口令的依据是完成任务所需的安全级别。例
如，为特定服务器上具有管理特权的每个用户都分配了为用户 ssadmin 建立的相同密
码。

注意 - 要将服务器添加到 Managed Servers （受管服务器） 列表，请参阅第 39 页的
“添加服务器”。

多台服务器上的全局密码

如果已经具有一个庞大的网络，而不想单独设置登录名，并且可以接受在多台服务器上
使用相同的密码，则可以在 Microsoft Windows 下的域服务器上建立三个登录名。从
而使 Microsoft Windows 域中的其他所有服务器都能够用它们相应的密码访问三个登
录名。
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▼ 要创建 Windows NT 用户

1. 使用 NT User Manager （NT 用户管理器） 程序添加用户。 

2. 选择 Policies （策略）然后选择 User Rights （用户权限）。 

3. 选择 Show Advanced User Rights （显示高级用户权限）。

4. 向 NT User Administrator （NT 用户管理员）赋予作为操作系统一部分的 Rights to 
Act 。

5. 在“User Properties”（用户属性）下，取消选择“User Must Change Password at 
Next Login”（用户下次登录时必须更改口令）。

6. 在  User Properties （用户属性） 下，选择 User Cannot Change Password （用户无
法更改口令） 和 Password Never Expires （口令无时限）。

7. 如果计划在域服务器上建立用户名从而避免多服务器设置，应确保要管理的服务器属于
在其中建立 Sun StorEdge Configuration Service 用户帐户的域。

请参阅 Windows NT 文档，以获得详细信息。

▼ 创建 Windows 2000 用户

1. 在 Settings （设置） → Control Panel （控制面板） → Administrative Tools （管理
工具） → Computer Management （计算机管理） → System Tools （系统工具） → 
Local Users and Groups （本地用户和组） 下，选择 Users （用户）。

2. 右键单击 Users （用户） 文件夹并选择 New User 以增加三个用户 （ssmon、
ssconfig 和 ssadmin）。

3. 在 User 名称下添加其中一个用户。如果需要可以在 Description （说明） 下输入说
明。

4. 如果需要可以输入密码，选择 User Cannot Change Password （用户无法更改口令） 
和 Password Never Expires （口令无时限）。
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卸载 Sun StorEdge Configuration Service
使用 Windows “添加 / 删除程序”实用程序从 Microsoft Windows 控制台中删除 
Sun StorEdge Configuration Service。 

▼ 卸载 Sun StorEdge Configuration Service
1. 转到 Start （开始） → Settings （设置） → Control Panel （控制面板） → 

Add/Remove Programs （添加 / 删除程序）。

2. 选择 Sun StorEdge Configuration Service Agent，然后选择 “添加 / 删除”。对提示
做出相应的响应。

3. 选择 Sun StorEdge Configuration Service Console，然后选择 “添加 / 删除”。对提
示做出相应的响应。
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第 章5

将 Sun StorEdge Configuration 
Service 安装在运行 Linux 操作环境
的系统上

本章介绍在运行 Sun Linux 或 Red Hat Linux 操作环境的系统上安装 Sun StorEdge 
Configuration Service Console 和 Agent 的过程。本章包含下列主题：

■ 第 25 页的 “系统要求”
■ 第 26 页的 “安装 Sun StorEdge Configuration Service 前的准备工作”
■ 第 27 页的 “安装软件”
■ 第 30 页的 “用户和密码”
■ 第 32 页的 “卸载 Sun StorEdge Configuration Service”

系统要求
■ Netscape™ 4.0 或更高版本 - 用于查看联机帮助。

■ 符合 TCP/IP 的控制台网络接口 － 每个控制台必须具有符合 TCP/IP 的网络接口
（如以太网或令牌环网卡，或串行线调制解调器）。 

■ 控制台在 1024 x 768 像素显示器分辨率和 256 色时查看效果最佳。有关其它控制台
要求，请参阅下表。

表 5-1 控制台系统要求 

 Linux 版本 内存 磁盘空间

Sun Linux 5.0
Red Hat Linux 7.2 和 7.3

256 MB （最少） 10 MB
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■ 符合 TCP/IP 的 Agent 网络接口 - 每个代理必须具有符合 TCP/IP 的网卡接口和驱
动程序集 （包括在操作环境中）。有关其它代理要求，请参阅下表。

安装 Sun StorEdge Configuration Service 
前的准备工作
在安装程序及其相关软件组件前，应注意以下必需的过程和附加选项。

■ 务必阅读适用于您的阵列的发行说明。

■ 如果操作环境包含企业管理控制台，则可以选择将代理配置为用 SNMP 服务向控制
台发送陷阱事件。 

■ 如果要让网络上的服务器将 SNMP 陷阱发送到企业管理控制台，请参阅第 211 页的
“电子邮件和 SNMP”。

■ 可选项。要安装和使用 Sun StorEdge Diagnostic Reporter，需要一个 Sun 
StorEdge Configuration Service 伴随程序向指定电子邮件地址发送您的存储系统事
件，请参考 Sun StorEdge 3000 系列 Diagnostic Reporter 用户指南。

■ 可选项。要使用多路径功能，必须要有 Sun StorEdge Traffic Manager 软件 （包含
在 Sun StorEdge SAN Foundation 软件中）。有关的详细信息，请参考适用于您的
阵列的发行说明中的 “支持的其它软件”部分。

注意 - 必须是超级用户才能安装 Sun StorEdge Configuration Service 和运行控制台。

表 5-2 代理系统要求 

Linux 版本 内存 磁盘空间

 Sun Linux 5.0
Red Hat Linux 7.2 和 7.3

128 MB （最少） 1 MB
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安装软件
Sun StorEdge Configuration Service 软件包含以下组件：

■ Sun StorEdge Configuration Service Agent。

■ Sun StorEdge Configuration Service Console。

■ Diagnostic Reporter （可选实用程序） - 有关安装和操作的详细信息，请参考 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南。

■ 命令行界面 (CLI) - 有关安装的信息，请参考适用于您的阵列的 Sun StorEdge 3000 
系列安装、操作和维护手册。

安装软件包

安装软件包包含在 Sun StorEdge 3000 系列 Professional Storage Manager CD 上，其
中包括下列文件：

■ SUNWscsu.rpm - Sun StorEdge Configuration Service Console
■ SUNWscsd.rpm - Sun StorEdge Configuration Service Agent

▼ 安装 Agent 和 Console
将代理安装在作为 Sun StorEdge Configuration Service 的一部分的每台服务器上。在
计划用于管理和维护存储系统的计算机或工作站上安装控制台。

Sun StorEdge Configuration Service Console 软件包 (SUNWscsu.rpm) 可以安装在服
务器或任何客户机系统上。 Sun StorEdge Configuration Service Agent 软件包 
(SUNWscsd.rpm) 必须安装在连接存储设备的服务器上。

完成下列步骤以安装代理、控制台，或者两者都安装。必须至少安装一个代理和一个控
制台才能使该程序运行。

注意 - 确保在要安装 Sun StorEdge Configuration Service 的计算机或工作站上已安装
了 Java 运行时环境 1.2 或更高版本。 

1. 如果在要安装 Sun StorEdge Configuration Service 的计算机或工作站上没有安装 
Java 运行时环境 1.2 或更高版本，请立即安装。
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2. 如果您的文件系统上尚未安装 CD ROM，请先安装它。

3. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 并键入

4. 使用下列方式之一安装软件包：

a. 如果只安装代理，则应键入

b. 如果只安装控制台，则应键入

5. 要访问联机帮助，必须在安装控制台的系统上安装 Web 浏览器。如果没有检测到 Web 
浏览器，将要求您指定指向 Web 浏览器 （Netscape 4.0 或更高版本）的路径。

a. 转到 /opt/SUNWsscs/sscsconsole 并键入 

b. 键入指向 Web 浏览器的绝对路径。

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm

./config_sscon
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注意 - 可以随时配置浏览器路径名称；但是，如果不指定某一点的浏览器路径名称，将
无访问联机帮助。

安装完代理以后，将显示以下信息指示组件已经成功安装并且已经启动。 

安装完控制台以后，将显示以下信息指示组件已经成功安装并且已经启动。

代理和控制台安装在下面的目录中：/opt/SUNWsscs/sscsconsole。

▼ 启动或停止 Agent
通过在 /etc/init.d/ssagent 中使用运行命令脚本可以手动停止和启动代理。

1. 要启动代理，请键入

或者

# rpm -ivh SUNWscsd.rpm 准备中 ...
########################################### [100%] 1:SUNWscsd

########################################### [100%] 添加用户 ssmon 
添加用户 ssadmin 添加用户 ssconfig 配置并开始 Sun StorEdge(tm) 
Configuration Service 守护进程 [ OK ] 
开始 Sun StorEdge(tm) Configuration Service 代理守护进程 [ OK ] 
开始 开始 StorEdge(tm) Configuration Service 代理监视器守护进程 [ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%] 
Installation completed successfully!

# /etc/init.d/ssagent start

# service ssagent start
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注意 - 要启动代理，必须具有超级用户特权。

如果使用了 start 前，没有先使用 stop，则脚本将重新启动所有已经停止的代理。
如果所有的代理都已经停止 （如使用了 stop 选项），则脚本将在重新启动代理之前重
新配置运行时环境。

2. 要停止代理，请键入

3. 要确定代理是否正在运行，请键入

或者

ssmon 和 ssserver 两者都会显示在输出中。如果已经启用了 SNMP 陷阱生成，则还
会看到名称 sstrapd。

用户和密码
以下部分介绍如何创建用户和口令。

管理 （用户）安全级别和准则

如果在使用 Solaris 操作环境的系统上运行该程序，则在安装过程中会自动创建管理员
安全级别。只需要根据所需的权限级别设置密码并指定用户。 

管理功能要求使用访问登录名和口令，以防止某个管理员未经授权重新分配或删除属于
其它客户机或主机的存储资源。 

您要为程序的三个安全级别指定各自的口令。这是通过在具有由该程序管理的存储设备
的代理上创建三个用户实现的。在安装代理的过程中会自动添加这三个用户。

安全级别必须使用以下确切名称： 

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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■ ssmon

代表软件的监控级别。

■ ssadmin

代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule Parity Check 
以及监控功能的访问。 

■ ssconfig

代表软件的配置级别，并为安装程序提供对配置功能和程序的其他所有相关方面的
直接访问。 

三个安全级别都需要这些名称。安装后，必须为每个安全名称分配密码。

ssmon、ssadmin 和 ssconfig 是只对应到程序内安全级别的登录名。对于 UNIX 操
作环境（Solaris/Linux 操作环境），这些帐户的默认 shell 将被指定为 /bin/false，
以防止用户 ID 被用于交互式登录。

可以对 Sun StorEdge Configuration Service 进行设置，使监控程序不要求用户键入 
ssmon  口令。这可以通过如下途径来实现：在控制台上将服务器添加到 “Managed 
Servers”（受管服务器）列表时选择 “Auto Discovery”（自动发现）选项。可以在每
台服务器上以本地方式设置这三个登录名称和密码。（如果需要，这些帐户可以在每台
服务器上具有不同的密码。） 

只要在这些将被管理的代理上设置了这三个登录名，系统管理员通常就能够通过向员工
分配相应的口令提供对程序的用户访问权限，分配口令的依据是完成任务所需的安全级
别。例如，为特定服务器上具有管理特权的每个用户都分配了为用户 ssadmin 建立的
相同密码。

注意 - 要将服务器添加到 Managed Servers 列表，请参阅第 39 页的 “添加服务器”。

▼ 创建密码和权限

要为每个新用户创建密码，应键入 

# passwd user-name
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管理员可能还想更改组权限，组权限位于安装期间创建的 
/opt/SUNWsscs/sscsconsole 目录内的 svrlist.dat 文件中。 

控制台是基于 Java 的实用程序，因此不能提供用于控制 Sun StorEdge Configuration 
Service 创建的文件的权限和所有权的功能。 svrlist.dat 文件容易被不同形式的 
ASCII 文本处理器读取。其中包括用户 ssmon 的加密密码，也可以解密。 

注意 - 在添加所监控的所有代理之后，不要更改 svrlist.dat 的权限以及组所有权。

卸载 Sun StorEdge Configuration Service 
在升级控制台或代理时，必须卸载 Sun StorEdge Configuration Service。注意有些文
件不会被删除，因为它们是在安装后创建的，并且仍对升级环境有效。

▼ 卸载 Sun StorEdge Configuration Service
使用 rpm -e 命令 （后面跟有要卸装的软件包）、 SUNWscsu.rpm（控制台）或 
SUNWscsd.rpm（代理）。 

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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第 章6

设置 Sun StorEdge Configuration 
Service

本章介绍了设置 Sun StorEdge Configuration Service 的一般过程。本章包含下列过程：

■ 第 34 页的 “启动 Sun StorEdge Configuration Service”
■ 第 34 页的 “在 Solaris/Linux 操作环境中启动 Sun StorEdge Configuration 

Service”
■ 第 35 页的 “首次使用前后的主窗口”

■ 第 39 页的 “添加服务器” 
■ 第 44 页的 “登录和注销”
■ 第 45 页的 “选择用于管理控制器的服务器” 
■ 第 50 页的 “配置代理参数 （可选）” 
■ 第 53 页的 “验证存储配置” 
■ 第 55 页的 “保存逻辑驱动器配置” 
■ 第 56 页的 “在运行 Solaris 操作环境的系统中，在服务器上创建分区” 
■ 第 58 页的 “在 Windows 2000 操作系统中在服务器上创建分区”
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启动 Sun StorEdge Configuration Service

注意 - 您必须是超级用户或管理员才能运行控制台。

注意 - 因为控制台只有在运行时才能接收事件报警，所以在配置阵列后，应始终保持 
Sun StorEdge Configuration Service 以它的最小化 模式在控制台工作站中运行。或
者，不采用保持控制台运行的方式，而使用 Sun StorEdge Diagnostic Reporter，它是 
Sun StorEdge Configuration Service 的一个伴随实用程序，作为后台服务运行，能够
从主机和阵列将消息发送到指定的电子邮件地址。有关的详细信息，请参考 Sun 
StorEdge 3000 系列 Diagnostic Reporter 用户指南。有关另一种接收事件警示的方法，请
参阅第 222 页的 “在不使用 Sun StorEdge Configuration Service 的情况下发送 
SNMP 陷阱”。

注意 - 为使 Sun StorEdge Configuration Service 能够查看和管理阵列，每个 HBA 卡
必须连接到主控制器。

▼  在 Solaris/Linux 操作环境中启动 Sun StorEdge 
Configuration Service

在命令提示符处，键入

▼ 在 Microsoft Windows NT/2000 操作系统中启动 
Sun StorEdge Configuration Service

选择 Start → Programs → Sun StorEdge 3000 Family → Configuration Service。 

# ssconsole
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首次使用前后的主窗口
当程序首次初始化之后，主窗口是空白的。出现 “Add Server”（添加服务器）窗口，
允许您将服务器添加到正在使用的控制台的 “Managed Servers”（受管服务器）列
表。要获得有关添加服务器的详细信息，请参阅第 39 页的 “添加服务器”。

在首次启动之后 再次启动程序，以及在选择“Managed Servers”（受管服务器）之后 
启动程序，主窗口都会显示 “Managed Servers”（受管服务器）列表中服务器的服务
器图标。单击 OK （确定） 或 Cancel （取消） 以继续。

在配置了新阵列并引导了工作站之后，只有在为逻辑驱动器添加卷标后程序才能够发现
阵列，因为 Sun StorEdge Configuration Service 使用本机 Sun 驱动程序。

如果 Console 在使用过程中锁死

在运行 Solaris 或 Linux 操作环境的系统中，如果控制台在使用期间锁死，您可以停止 
Sun StorEdge Configuration Service，然后关闭并重新打开窗口，而不会影响代理。

▼ 停止 Sun StorEdge Configuration Service

1. 在命令提示符处，键入

2. 重新运行程序。 

该窗口会再次显示，而不会影响代理。

# ssconsole stop
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菜单、工具条和选项卡

详细了解主窗口很有用，它包括菜单栏、选项卡和一个用于访问主要功能的工具条。

菜单栏

下图显示各主菜单选项。

工具栏

菜单栏下面的工具栏提供了一些供您快速访问常用功能的图标。选择一个图标可以启动
其功能。根据主窗口中可用资源的不同，工具条图标可能显示为活动或非活动（灰色）。

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

File View

Configure Host/WWN (Fibre Channel only) 

LUN Filter Properties (Fibre Channel only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Configuration Array Administration

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check

Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management

Display HDD under LD
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图标 说明

Server List Setup （服务器列表设置）。添加由控制台管理的服务
器，编辑服务器信息，或指定对某个可用的服务器进行管理。

Event Log （事件日志）。查看诸如存储设备状态更改、硬件状态
更改或操作通知等事件。

Save Event Log （保存事件日志）。显示 Save Event Log File
（保存事件日志文件） 对话框，您无需转到 Event Log （事件日

志） 窗口即可保存 Event Log （事件日志）。

Delete Event Log （删除事件日志）。手动删除 eventlog.txt 文件
的内容。（在事件数量达到 10,000 之前，程序将一直收集事件。

如果事件数量达到了 10,000，事件日志将被自动删减，留下最新
的 500 个事件。）

Save Report （保存报告）。创建一个文本文件，其中包含选定服

务器上每个存储组件到当前日期为止的数据。

Standard Configuration （标准配置）。在选定的阵列控制器上创

建一个或多个具有一个 RAID 级别的逻辑驱动器。如果您希望使
用一个预定义的配置，而在该配置中 Sun StorEdge 
Configuration Service 会自动配置存储设备，则可以使用标准配

置。

Custom Configuration （自选配置）。提供了多种选择，用于在

选定的阵列控制器上对具有各种 RAID 级别的逻辑驱动器或逻辑
卷进行配置或重新配置。当您希望手动定义配置时可以使用此项

功能，例如设置或更改控制器 ID 和参数，定义或修改 RAID 集
和备用驱动器等。
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选项卡

位于工具条下的选项卡能够让您快速移动到其它 Sun StorEdge Configuration Service 
视图。

物理 （硬盘）驱动器

随着阵列配置的不断完备，主窗口将显示多个组件。默认情况下将显示组成逻辑驱动器
的物理驱动器；但是，要使主窗口更易于浏览，可以选择不显示物理 （硬盘）驱动器，
方法是取消选择 “View”（查看） → “Display HDD under LD”（在 LD 下显示 
HDD）。 

导航

程序符合标准的 Java 编程语言键盘和导航操作。

制表符 说明

单击可以转到 Sun StorEdge Configuration Service 主窗口。

单击可以转到 Resource Allocation View。（留作将来使用。）

单击可以转到 LUN Filter View。（仅对光纤通道。）
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▼ 添加服务器

在监控或配置服务器之前，需要通过 Server List Setup （服务器列表设置） 将服务器
添加到 Managed Servers （受管理的服务器） 列表。

1. 如果还没有运行 Sun StorEdge Configuration Service，应启动它。

2. 选择 File （文件） → Server List Setup （服务器列表设置）。 

Server List Setup 窗口显示。

3. 将服务器组织到组中：

a. 单击 Server List Setup （服务器列表设置） 窗口中的 Groups （组）。 

Group List Setup （组列表设置） 窗口显示。

b. 在 Group Name （组名） 字段中键入名称并单击 Add （添加）。

c. 要删除组，从 Available Groups （可用组） 列表选择组名称并单击 Delete （删
除）。
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d. 在添加或删除完组后，单击 OK （确定）。 

Server List Setup （服务器列表设置） 窗口显示。

4. 添加服务器：

a. 单击 Available Servers 列表下的 Add （添加）。 

Add Server （添加服务器） 窗口显示。

b. 在 Server name （服务器名） 字段中键入服务器名称并单击 Return。 

这是用于标识服务器的名称。如果该名称在网络的名称服务器数据库中， Sun 
StorEdge Configuration Service 将确定服务器的 IP 地址并将其显示在 “IP 
Address”（IP 地址）字段中。

如果程序无法找到该名称的 IP 地址，可能是因为名称键入不正确或者该名称没有记
录在服务器的名称数据库中。

c. 如有必要，请在 “IP Address”（IP 地址）字段中键入服务器的 TCP/IP 地址。

例如：192.168.100.1。

如果程序还没有显示 IP 地址 （如上一步骤所示），应手动键入 IP 地址。

选择 “IP Address”（IP 地址）字段下的 “Get IP Address by Name”（通过名称
获取 IP 地址），也可以让程序搜索并自动显示 IP 地址。如在先前步骤中提到的，只
有网络具有名称服务器数据库并且您键入了该数据库中记录的服务器名称时，它才
起作用。否则，必须手动键入 IP 地址。
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5. 选择或取消选择服务器的 Automatic Discovery （自动发现）：

a. 如果需要一个非常安全的环境，在该环境中即使对服务器库存数据进行访问都要受
到限制，则应为 Auto Discovery （自动发现）选择 No （否）。

如果选择了 “No”（否），程序不会在启动时检索服务器信息。服务器的图标显示
为白颜色 （而不是亮紫色），以表示它未被发现。双击一个未被发现的服务器时，
Sun StorEdge Configuration Service 会提示您输入 ssmon 用户口令。另外，也可
以选择服务器，然后选择 File （文件） → Login （登陆）。

为 “Auto Discovery”（自动发现）选择 “Yes”（是），可以在控制台启动时检索
该服务器的所有可用信息。 

b. 如果为 Auto Discovery （自动发现） 选择了 Yes （是），应键入先前在服务器（或
如果有域或 DNS 树，则为服务器组）上建立 ssmon 用户时键入的密码。

如果已经使用“Auto Discovery”（自动发现）建立了服务器，则在登录到 Sun 
StorEdge Configuration Service 时不需要键入 ssmon 口令；您会自动拥有监控特权。

但是，无论何时在选择了执行管理或配置命令的操作后，都会提示用户键入先前建
立的 ssadmin 或 ssconfig 用户的密码。

c. 单击 OK （确定）。

6. 设定电子邮件地址： 

a. 如果要让 Sun StorEdge Configuration Service 使用电子邮件发送事件消息，可以
选择 “Mailing Lists”（邮件列表）选项卡并继续执行下列操作。 

用户可能想要键入自己的电子邮件地址或选定用户的地址，以实现接收关于服务器
关键事件信息的目的。

注意 - 您可以将 Sun StorEdge Diagnostic Reporter 用作 Sun StorEdge Configuration 
Service 的伴随实用程序，作为从主机和阵列向指定电子邮件地址发送消息的后台服务
运行，而不必保持控制台在前台运行。有关的详细信息，请参考 Sun StorEdge 3000 系
列 Diagnostic Reporter 用户指南。要确保 Sun StorEdge Configuration Service 能够接
收电子邮件，请参阅第 211 页的 “电子邮件和 SNMP”，了解有关设置陷阱的信息。
有关另一种接收事件警示的方法，请参阅第 222 页的 “在不使用 Sun StorEdge 
Configuration Service 的情况下发送 SNMP 陷阱”。
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b. 对于每一个用户，将电子邮件地址键入 Mail Address 字段中。

c. 在 Severity （严重程度） 列表框中，滚动严重级别列表，选择下列项目之一：

“Critical”（危险）- 要求网络管理员干预，例如设备、电源或风扇发生故障的消息。

“Warning”（警告） - 通常指示内部程序事件的消息。如果看到大量的此类消息，
可能表示服务器或网络存在问题。 

“Informational”（信息） - 关于服务器上非必需设备的消息不要求网络管理员的干
预。

无论选择的级别如何，都会接收到该级别以及任何更高严重级别的事件消息。例如，
如果选择了 Informational，则将向您通知任何类型的故障。相反，如果只需要在发
生严重情况时获得通知，可以选择 Critical，这样就不会获得任何 Informational 或 
Warning （警告） 事件通知了。

d. 单击 Add to List （添加到列表）。

要从列表上删除用户，选择邮件地址并单击 Delete from List （从列表中删除）。

e. 指示要使用的邮件服务器。 

注意 Setup Mail Server （设置邮件服务器） 按钮与 Change Mail Server （更改邮
件服务器） 按钮可根据以前是否已经定义了邮件服务器而相互切换。

对于新设置，应单击 Setup Mail Server （设置邮件服务器）。将显示类似下面的 
Mail Server Setup （邮件服务器设置） 窗口。
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f. 键入简单邮件传输协议 (SMTP) 邮件服务器的 IP 地址或名称 （该服务器用于将电
子邮件消息传输到先前所指定的目标地址）。

g. 如果对 Mail Server （邮件服务器） 窗口中的信息满意，则单击 OK （确定）。 

显示 Add Server（添加服务器） 窗口，其中有 Mailing Lists （邮件列表） 选项卡。

7. 完成 Add Server 功能：

a. 如果想让该服务器成为组的一部分，可选择 Grouping （分组） 选项卡。 

Add Server （添加服务器）窗口显示。

b. 选择列表框，以查看可用选项。 

c. 选择需要的组并释放鼠标按钮。

d. 单击 OK （确定） 以注册更改。

8. 如果要添加更多的服务器，应为每台服务器重复步骤 3 到 7。

9. 将想要受此控制台控制的服务器移动到 Managed Servers （受管服务器） 列表 （请参
阅第 39 页的 “添加服务器”）。
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■ 如果要让该控制台管理所有可用的服务器，应单击对话框顶部的 Add All （添加全
部）。

■ 要将单独服务器移动到受管理列，应单独选择每台服务器并单击两个列表框之间的 
Add （添加）。

■ 如果在添加服务器过程中，需要进行修改，请参阅第 177 页的 “编辑服务器条目”。

10. 在添加完服务器后，单击 OK 返回到主窗口。

注意 - 如果阵列连接到多个主机，且每个主机上都安装有代理，则必须输入每个主机的 
IP 地址并添加到 “Managed Servers”（受管服务器）列表中。

▼ 登录和注销

登录和注销功能提供了程序内的安全性。安全性级别是通过设置三个用户来建立的：
ssmon、 ssadmin 和 ssconfig，每个用户都带有密码。

■ ssmon 代表软件的监控级别，它显示来自控制器的警示。  

■ ssadmin 代表软件的管理级别，并提供对 Rebuild、 Parity Check、 Schedule 
Parity Check 以及监控功能的访问。 

■ ssconfig 代表配置级别，它提供了对配置命令和程序所有方面的访问。

1. 要登录，请选择 File （文件） → Login （登录）。

仅在作为监控用户时才保持连续访问。在选择需要管理级别或配置级别的命令时，将显
示登录对话框，您可以使用相应的密码登录到该级别。在完成活动后，注销。
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2. 要注销，请选择 File （文件） → Logout （注销）。 

如果从管理或配置级别注销，将为您提供选项，以选择注销到监控模式还是从服务器完
全注销。

▼ 选择用于管理控制器的服务器

要管理和监控阵列，代理需要访问一个已映射到逻辑驱动器 （已分配给阵列的主控制
器）分区的主机 LUN。  

代理忽略所有已映射到逻辑驱动器 （已分配给冗余配置阵列中的辅助控制器）分区的
主机 LUN。

注意 - 请参阅第 179 页的 “RAID 基本知识”，了解针对逻辑驱动器和 LUN 的讨论。 

如果同一阵列连接了多台服务器，可以让运行在每台服务器上的代理尝试管理和监控同
一阵列。因为限制一次只能有一台服务器将监控命令发送到阵列控制器，因此如果多台
服务器同时发送监控命令，有些监控命令可能会失败。这会导致产生不准确的报告情
况，或进程停止响应。要防止发生这种情况，可以将代理配置为在服务器上启用 / 禁用
阵列监控。

通过控制台分配控制器

可以从控制台执行下列过程以便为控制器分配服务器控制。

1. 请确保所有直接连接的服务器都是依照第 39 页的“添加服务器”中的指示进行添加的。 

这可以确保两个主机名都出现在 Controller Assignments （控制器分配） 下。

2. 从主窗口单击 “Array Administration”（阵列管理） − “Controller Assignment”
（控制器分配）。 

Assign Server to Manage a RAID Controller （指定用于管理 RAID 控制器的服务器）
窗口显示。 
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3. 从 Server to manage this controller（管理此控制器的服务器） 列表选择一个服务器，
单击 Apply （应用）。

这可以让所选定的服务器对阵列控制器进行管理。还禁止所有列出的其他服务器管理同
一阵列。

4. 单击 Close （关闭） 以关闭视图。
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主窗口只将阵列控制器设备图标显示在已为该阵列启用监控功能的服务器下。 
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更改服务器分配 

当分配一台服务器来管理控制器时，将会生成有关该管理服务器的信息。程序将该信息
存储在控制器上，并使用该信息来跟踪管理服务器。如果关闭了服务器 （例如进行维
护时），而您尝试分配另一台服务器来管理该控制器，此时程序会从该控制器上读取存
储的服务器信息，并警告您已在对该控制器进行管理。

注意 - 如果希望强制使用新的服务器分配，则可以覆盖当前的服务器分配。

可以查看管理服务器的名称，方法是使用固件应用程序菜单 view and edit Host luns 
→ Edit Host-ID/WWN Name List。

例如，您由于正在将阵列移到新位置而希望更改服务器分配，则在移动该阵列之前，需
要根据第 49 页的 “取消分配管理服务器”中所述的步骤取消分配管理服务器。 

如果已经移动了阵列，则当该阵列启动时，您可能会看到一条警告信息，该信息指示该
控制器正在由另一台服务器管理。您需要按照第 49 页的 “使用终端窗口手动删除服务
器”中所述的步骤手动删除该服务器。有关访问固件应用程序的信息，请参考适用于您
的阵列的 Sun StorEdge 3000 Family RAID Firmware User's Guide。

服务器名称
以 ASCII 字符集的
十六进制值的形式存储。
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▼ 取消分配管理服务器

1. 从主窗口，单击 “Array Administration”（阵列管理） → “Controller 
Assignment”（控制器分配）。

2. 选择您要为其取消服务器分配的阵列控制器。

3. 从 Server to manage this controller （管理此控制器的服务器） : 列表框中，选择 
none （无）。

当显示以下警告信息时单击 Close （关闭），确认不再通过服务器对选定的控制器进行
管理。

4. 按照第 45 页的 “通过控制台分配控制器”中所述的步骤选择希望用于管理控制器的服
务器。

▼ 使用终端窗口手动删除服务器

有关访问固件应用程序的信息，请参考适用于您的阵列的 Sun StorEdge 3000 Family 
RAID Firmware User's Guide。

1. 在主菜单上，选择 view and edit Host luns，然后按 Return。

2. 选择 Edit Host-ID/WWN Name List，然后按 Return。

3. 从 Name List 中选择 sscsMgr，然后按 Return。

4. 选择 Delete Host-ID/WWN Name List，然后按 Return。

5. 选择 Yes，然后按 Return。
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▼ 配置代理参数 （可选）

本节提供了配置代理参数的步骤，其中包括轮询时间、周期性设备发现时间、智能监控
和带外存储管理 （使用 View （查看） → Agent Options Management （代理选项管
理）命令）。 

1. 从主窗口中，选择 View（查看） → Agent Options Management（代理选项管理）。 

Agent Options Management （代理选项管理） 窗口显示。

注意 - 如果已经配置了一个或多个组，并且在主窗口中选择了其中一个，则 Agent 
Options Management （代理选项管理） 不可用。要启用它，选择一个图标，而不是一
个组，然后单击 View （查看）。

2. 对于 Monitoring Frequency in Seconds （以秒为单位的监视频率），以秒为单位键入
需要的数目。

该值是代理向设备、阵列控制器和附件监控连续轮询状态更改的间隔。默认值为 60 
秒。如果想要控制台更频繁地更新设备状态更改，可以减小该值。
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注意 - 增加轮训间隔可能会对高 I/O 负载时的错误消息传递造成负面影响。

3. 对于 “Periodic Device Discovery”（定期设备发现），请以分钟为单位键入希望检查
新设备的周期值。

周期性设备发现值用于确定扫描每个设备 ID 以发现新设备的频率。默认值 “0”意味
着不扫描新设备。注意，数字值增加时，设备 ID 的扫描频率降低。

反之，数字值降低时，设备 ID 的扫描频率提高。 5 分钟是最小值。

4. 对于 Interval of trap generation （陷阱生成间隔），键入发送两个陷阱消息之间间隔
的时间量 （以秒为单位）。 

如果值为 60 秒或更高，则系统会按该时间间隔发送关于特定陷阱的消息，直到清除或
更正该事件为止。例如，如果风扇发生故障，则每隔 60 秒发送一条关于风扇故障的消
息，直到修复为止。

如果值为 0，则 Sun StorEdge Configuration Service（以及 Sun StorEdge Diagnostic 
Reporter）对于特定事件只发送一个消息。例如，如果发生风扇故障，则只发送一封电
子邮件。

5. 对于 Timeout of heartbeat lost （心跳消失超时），设置发送故障服务器消息之间以分
钟为单位的等待时间。 

默认值为 15 分钟，取值范围为 1 到 30 分钟。 

6. 要 Enable SMART Monitoring （启用 SMART 监视），选择该复选框。

SMART 监控是报告硬盘驱动器预测故障的方法。大多数磁盘供应商都提供带有此功能
的驱动器。代理通过主动发出请求检测对此功能进行监控。如果该请求与底层的主机操
作环境 / 系统设备驱动程序冲突，则可以将 SMART 监控功能关掉。有关 SMART 监
控功能的详细信息，请参考适用于您的阵列的 Sun StorEdge 3000 Family RAID 
Firmware User's Guide。

7. 要启用 JBOD 支持，请参阅第 52 页的 “启用 JBOD 支持 （仅对 SCSI）”。

8. “Controller Primary Agent Information”（控制器主代理信息）下的参数 （包括
“Password”（口令）字段）属于带外管理。有关配置这些参数的信息，请参阅第 120 
页的 “使用带外管理”。

9. 如果选择了前面的任何选项，单击 OK （确定） 以保存更改。
第 6 章 设置 Sun StorEdge Configuration Service 51



即可出现 “Setting Agent Options”（设置代理选项）通知消息框，显示服务器的 
TCP/IP 地址。

10. 单击 OK （确定） 以完成过程。

▼ 启用 JBOD 支持 （仅对 SCSI）
对于 Sun StorEdge 3310 SCSI 阵列，仅在有直接连接到工作站的 JBOD 时，才可以使
用简单磁盘捆绑 (JBOD) 支持。这使得您能够监控外围设备的状况和事件。如果有连接
到 RAID 阵列的 JBOD， RAID 控制器为您监控 JBOD 条件和事件。 

注意 - 启用 JBOD 支持可能会影响 I/O。

1. 按照第 50 页的 “配置代理参数 （可选）”中的步骤操作。

2. 选择 Enable JBOD support。

要获得有关监控 JBOD 的详细信息，请参阅第 195 页的 “监控 JBOD （仅用于 
SCSI）”。
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▼ 验证存储配置

安装 Sun StorEdge Configuration Service 并为要管理的存储器添加了所有的服务器之
后，需要验证存储配置。 

注意 - 大多数阵列都预先进行了配置。如果想要完全删除现有配置并重新开始，请参阅
第 61 页的 “完全配置”。如果想要更改现有的配置或者在其中添加内容，请参阅第 
141 页的 “更新配置”。

1. 确保服务器图标是联机的 （即服务器符号是紫色的）。  

在通电期间， Sun StorEdge Configuration Service 会自动启动。

2. 观察主窗口，并检查存储配置。

3. 如果有多个受管服务器，选择要检查的服务器。 

如果服务器图标不是紫色的，则应确定服务器的状态 （请参阅表 9-1）。如果服务器图
标附有一个盘式卫星天线 ，则服务器可能正处于发现进程中，在短暂延迟后即可
使用。  

4. 单击要检查其存储设备的服务器左面的容器符号 。

如下图所示，程序以图形方式显示了连接到服务器的每个阵列控制器。 

5. 要查看其他详细信息，单击要查看其存储设备的阵列控制器旁的容器符号 。

如果还没有配置阵列，则不显示逻辑驱动器 （对于控制器为 LUN）。

如果已经完全配置了阵列，程序会显示与选定的阵列控制器相关联的设备和逻辑驱动
器。它的外观与下图中显示的设备相似。  
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选择任何逻辑驱动器左侧的容器符号  能够显示其分配的物理驱动器。

注意 - 可以选择查看组成逻辑驱动器的物理 （硬盘）驱动器，方法是选择或取消选择 
View （查看） → Display HDD under LD （在 LD 下显示 HDD）。

根据您安装的阵列产品的不同，配置可能与前面图中显示的有很大的差别。

如果没有配置阵列，请参阅第 61 页的 “完全配置”，以获得配置阵列的指令。

6. 检查 RAID 级别和逻辑驱动器结构。

7. 如果已经配置了阵列，并且配置符合您的要求，则应继续下一节。 

如果想要更改配置，请参阅第 61 页的 “完全配置”。 
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▼ 保存逻辑驱动器配置

即便逻辑驱动器配置信息存储在阵列控制器或连接到它们的物理驱动器上，还可能发生
火灾等极端情况，这些情况都会造成控制器和驱动器的损坏。须在软盘或阵列以外的外
部介质上保留当前逻辑驱动器 （或 LUN）配置的多个备份副本。至少应该将一个备份
副本保存在密室或其他远离现场的安全地点。配置的备份副本用于将配置恢复到新控制
器，而不必完全重新配置阵列。如果没有当前配置的备份副本，则数据可能会丢失。

无论下列何种情况下，都应随时将阵列控制器配置保存到文件：

■ 安装新的存储系统机箱或更改现有机箱中控制器的 SCSI ID

■ 更换阵列控制器

■ 重新配置或将逻辑驱动器添加到阵列控制器

■ 从故障驱动器将数据重建到备用驱动器

要从文件中恢复配置，请参阅第 134 页的 “恢复逻辑驱动器配置”。

1. 选择带有要保存其配置的控制器。

2. 选择 Configuration （配置） → Save Configuration （保存配置）。 

Save Configuration （保存配置） 窗口显示。

3. 转到所要求的驱动器和文件夹，以找到要更新的配置文件，该文件是由 .cfg 扩展名
表示的。

将文件保存到软盘或阵列以外的驱动器。也就是说，在远离现场的地方保存这些配置文
件的副本。
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4. 指定配置文件名称，然后单击 Save （保存）。 

Save Configuration （保存配置） 窗口显示。

5. 为要保存的配置键入一段说明，然后单击 OK （确定）。

控制器配置信息保存到 .cfg 文件中。

▼ 在运行 Solaris 操作环境的系统中，在服务器上创
建分区

如果对存储配置满意，可以为操作环境进行存储阵列分区。 

下列步骤是通用性准则。要获得详细信息，请阅读 Sun Solaris 操作环境手册中关于创
建分区和文件系统的内容。

1. 键入以下命令为 LUN 加卷标

format 命令显示系统磁盘以及连接到阵列的其他驱动器。

# format
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在设置新的 LUN 供阵列使用之前，必须使用 format 命令为其加卷标。启动 format 
命令时，将显示可用的 LUN 和硬盘。  

2. 选择要使用的设备。 

如果提示，则为设备加卷标。

3. 键入单词 “partition”以查看现有的分区表。

4. 根据需要编辑分区表，并在完成更改后为其加上卷标。

5. 使用 newfs 命令在分区上创建文件系统。

6. 使用 mount 命令，或通过编辑 /etc/vfstab 并使用 mountall 命令，可以安装文件
系统。

▼ 在使用 Windows NT 操作系统的服务器上创建分区

在开始本节前，需要重新启动计算机，以便 Windows NT 识别新的存储容量。下面列
出的步骤是一般性准则；要获得详细信息，请参考 Windows NT 文档。

注意 - 不能远程完成此步骤。必须在服务器上执行此步骤。

1. 选择 Start （开始） → Programs （程序） → Administrative Tools （管理工具） → 
Disk Administrator （磁盘管理器）。

2. 在每个 Disk Administrator （磁盘管理器） 消息框中选择 Yes （确定）。

3. 将光标移动到水平条，然后单击鼠标左键，选择逻辑驱动器。

4. 选择 Disk Administrator Partition （磁盘管理器分区） → Create （创建）。

显示提示窗口，询问是否要创建默认容量为整个逻辑驱动器容量的分区。
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5. 如果想要在逻辑驱动器上创建多个分区，应输入需要的分区大小。

重复该步骤直到使用了所有逻辑驱动器容量为止。

6. 选择 Disk Administrator Partition （磁盘管理器分区） → Commit Changes Now
（提交变更）。

此功能用于格式化并使用逻辑驱动器，而无需重新启动 Windows NT 操作系统。

7. 选择新创建的逻辑驱动器分区。

8. 选择 Disk Administrator Tools （磁盘管理工具） → Format （格式）。选择 NTFS
（NT 文件系统）格式。

重复步骤 7 和 8 格式化每一个在逻辑驱动器上建立的分区。

9. 在格式化完成后，关闭 Disk Administrator （磁盘管理器）。

▼ 在 Windows 2000 操作系统中在服务器上创建分区

下面列出的步骤是一般性准则；要获得详细信息，请参考 Windows 2000 文档。

1. 选择 Settings （设置） → Control Panel （控制面板） → Administrative Tools （管
理工具） → Computer Management （计算机管理） → Disk Management （磁盘管
理）。

确保在 “Disk Management”（磁盘管理）下能够看到由磁盘图标  所标记的新驱动
器。

2. 右键单击要为其写入签名的磁盘，然后选择 Write Signature （写入签名）。

3. 选择要为其创建分区的磁盘，然后单击 OK （确定）。

4. 右键单击该驱动器 （其中显示了驱动器容量），然后选择 Create Partition （创建分
区）。

右键单击要为其写入

签名的磁盘。

右键单击要为其创建
分区的驱动器。
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5. 对分区向导提示做出相应的响应。 
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下一步骤

现在 Sun StorEdge Configuration Service （控制台和代理）已经安装、设置完毕并可
供使用。请参阅后面的章节，以了解其他任务：

■ 第 91 页的 “监控阵列”，可以获得有关如何使用 Sun StorEdge Configuration 
Service 监控存储设备的信息。

■ 第 127 页的 “维护阵列”，可以获得有关维护阵列的信息。其中包含详细的信息，
说明奇偶校验、调度奇偶校验、重建故障驱动器以及从备份文件恢复配置。

■ 第 141 页的“更新配置”，用于想要更新存储阵列配置时使用。其中还包括了更改控
制器功能、建立或更改备用驱动器以及编辑关于可用服务器的信息。
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第 章7

完全配置

在提供软件前 Sun 在阵列上预先配置了逻辑驱动器。只有在阵列尚未配置，或者想要
完全 删除现有配置而重新开始时才应参阅本章。如果要更改现有配置，请参阅第 141 
页的 “更新配置”。

完全配置包括以下主题：

■ 第 62 页的 “配置逻辑驱动器和逻辑卷”

■ 第 62 页的 “要对 Configure Logical Drives （配置逻辑驱动器） 使用 Standard 
Configuration （标准配置）”

■ 第 65 页的 “用 Custom Configuration 配置逻辑驱动器和逻辑卷”

■ 第 74 页的 “创建和分区逻辑卷”

■ 第 76 页的 “清除配置”

■ 第 76 页的 “从配置级别注销”

■ 第 76 页的 “主机 LUN 分配”

■ 第 77 页的 “添加 （映射）主机 LUN”

■ 第 78 页的 “删除 （取消映射）主机 LUN”

■ 第 79 页的 “配置文件”

■ 第 79 页的 “将配置保存到备份文件”

对于 Sun StorEdge 3310 SCSI 阵列，如果您计划设置群集配置，请参阅第 201 页的
“使用群集配置 （仅限 SCSI）”。

如果诸如奇偶校验等阵列管理进程正在运行，则可能会暂时禁用 Configuration 菜单命
令和工具条图标。当控制台正在刷新服务器上的库存时，菜单命令也被停用。在刷新过
程中，盘式卫星天线图标将附加到服务器图标上。

警告 － 在配置阵列之前将所有现有的数据备份到外部设备。重新配置将覆写所有现有
的逻辑驱动器配置。在覆写现有逻辑驱动器配置时，所有数据都将被彻底删除。
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配置逻辑驱动器和逻辑卷
根据要使用一个还是多个 RAID 级别，可以使用 Standard 或 Custom Configuration 
来配置逻辑驱动器。逻辑卷只能使用 Custom Configuration 进行创建。 

注意 - 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。 

▼ 要对 Configure Logical Drives （配置逻辑驱动
器） 使用 Standard Configuration （标准配置） 

通过 Standard Configuration Options （标准配置选项） 使用一个 RAID 级别快速配
置连接到阵列控制器的所有存储设备。您需要提供 RAID 控制器、优化模式和 RAID 
级别。还需要指定是否需要备用驱动器。然后 Sun StorEdge Configuration Service 自
动为您配置存储设备，根据 RAID 级别和可用的驱动器数创建一个或多个逻辑驱动器。
在默认情况下，回写缓存是选定的。可以在配置完成前查看结果，并选择接受或拒绝。

警告 － 在使用 Standard Configuration （标准配置） 之前，应将所有现有的数据备份
到外围设备。 Standard Configuration （标准配置） 将覆写任何现有的逻辑驱动器配
置。在覆写现有逻辑驱动器配置时，所有数据都将被彻底删除。

1. 以 ssconfig 用户身份登录。

2. 在主窗口中选择所需的 RAID 控制器。

3. 确定逻辑驱动器的优化模式是 Sequential I/O （默认）还是 Random I/O。必须对阵
列中的所有逻辑驱动器应用一种优化模式。您的选择将会影响可包括在阵列中的磁盘的
最大数量。

优化模式是在 Change Controller Parameters （更改控制器参数） 窗口的 Cache 选项
卡中设置的。有关 Sequential I/O （有序 I/O） 和 Random I/O （随机 I/O） 的更多
信息及设置优化模式的步骤，请参阅第 166 页的 “Cache 选项卡”。
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4. 选择 Configuration （配置） → Standard Configure （标准配置）。 

Standard Configuration （标准配置） 警告消息显示。单击 OK （确定） 继续。

Standard Configuration Options （标准配置选项） 窗口显示。如果当前还没有作为 
ssconfig 登录，将显示登录对话框。 

根据可用的驱动器数以及服务器上的系统运行的是 Solaris 操作环境还是 Windows NT 
操作系统，窗口中的选项可能被禁用。

NT Cluster 选项将创建一个仲裁 RAID 5 逻辑驱动器 (100 MB)，然后在两个大的 
RAID 5 逻辑驱动器上分配剩余的容量。要获得该选项，需要三个或更多物理驱动器。

5. 验证显示在窗口顶部的服务器和控制器 ID 是否正确。

如果显示在窗口顶部的服务器和控制器不正确，应单击 “Cancel”（取消）退出配置窗
口并返回到主窗口。选择相应的设备，并再次选择该窗口。

6. 指示是否要使用其中一个驱动器作为备用驱动器。

如果选择了 “Use a standby drive”（使用备用驱动器），则程序将停用不使用备用驱
动器的 RAID 级别。（例如， RAID 0 没有容错功能，因此备用驱动器没有益处。）
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7. 从可用的 RAID 级别中，为要配置的逻辑驱动器选择适合的 RAID 级别。

有关 RAID 级别的定义，请参阅第 179 页的 “RAID 基本知识”。

如果选择了 RAID 3 或 5，则 Standard Configuration （标准配置） 通常会配置一个大
逻辑驱动器。但是，如果阵列中的物理驱动器数量多于 31 个，将创建一个以上的逻辑
驱动器。另外，最少需要 3 个驱动器才能使用 RAID 3 或 5。

如果选择 RAID 1，则每个逻辑驱动器需要至少两个物理驱动器。如果选择四个或更多
驱动器，则会创建一个 RAID 1+0 逻辑驱动器。

如果选择 RAID 0 而且阵列中的驱动器数量多于 36 个，将创建多于一个的逻辑驱动器。

8. （限于 Solaris 操作环境）。如果希望自动为新逻辑驱动器指定卷标 （卷标使操作环境
能够使用该驱动器），请单击 “Write a new label to the new LD”（为新 LD 写上新
卷标）。

9. 选择 RAID 级别之后，单击 OK。

Confirm Configuration Operation （确认配置操作） 窗口显示，其中显示了新的配
置。 

10. 单击“OK”（确定）按照指示接受配置；否则单击“Cancel”（取消）返回到控制台。
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▼ 用 Custom Configuration 配置逻辑驱动器和逻辑卷

Custom Configuration 让您能够使用不同的 RAID 级别和其他 RAID 参数获得配置或
重新配置逻辑驱动器的多种选择。它还提供了可以将新创建的逻辑驱动器添加到逻辑卷
中的选项。

1. 以 ssconfig 用户身份登录。 

2. 在主窗口中选择所需的 RAID 控制器。

3. 选择 Configuration （配置） → Custom Configure （定制配置）。 

Custom Configuration Options （定制配置选项） 窗口显示。

■ New Configuration（新配置） - 使用不同的 RAID 级别和其他 RAID 参数配置新的
逻辑驱动器，并使您可以将新的逻辑驱动器添加到逻辑卷中。 New Configuration 
命令将删除阵列控制器上先前的配置。

■ Add LDs/LVs to the Current Configuration （向当前配置中添加 LD/LV） - 将新
的逻辑驱动器 / 逻辑卷添加到现有配置中。此命令不会删除已经在控制器上配置的
其他逻辑驱动器。
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■ Dynamically Grow and/or Reconfigure LDs/LVs （动态增加和 / 或重新配置 
LD/LV） - 使您可以扩展逻辑驱动器和逻辑卷的容量，将 SCSI 驱动器添加到现有逻
辑驱动器和逻辑卷中，复制并使用更高容量的驱动器替换所有成员驱动器。

■ Make or Change Standby Drives （制作或更改备用驱动器） - 添加一个或多个新的
备用驱动器，使其与阵列控制器相关联。

■ Change Host LUN Assignments（更改主机 LUN 分配）- 使您可以将逻辑驱动器、
逻辑卷和分区分配给主机通道。

■ Change Controller Parameters （更改控制器参数） - 使您可以修改控制器参数。 

■ Manage Existing LDs/LVs and Partitions （管理现有的 LD/LV 和分区） - 使您可
以删除个别逻辑驱动器和逻辑卷，并在现有逻辑驱动器和逻辑卷中创建 / 删除分区。

■ Configure Web Server （配置 Web 服务器）（需要 Sun StorEdge Enterprise 
Storage Manager Topology Reporter 软件）- 使您可以配置 Web 服务器以便您能够
通过 Web 浏览器管理 / 监控阵列。 

本章详细说明了 New Configuration （新配置） 选项。有关 Configure Web Server
（配置 Web 服务器） 的内容在第 123 页的“通过 Web 管理存储设备”中加以说明。剩
余选项在 第 141 页的 “更新配置”中加以说明。 

New Configuration （新配置） 选项

New Configuration 选项用于定制逻辑驱动器配置以满足您的环境的特定需要。可以使
用不同的 RAID 级别对一个或多个逻辑驱动器进行配置和分区。可以将 2 个或更多
（未分区的）逻辑驱动器添加到逻辑卷中，并将逻辑卷分为最多 32 个分区 （对于 
SCSI）或 128 个分区 （对于光纤通道）。

注意 - 在运行 Solaris 操作环境的系统上，如果控制台在使用过程中锁死，您可以获得
进程号，然后关闭并重新打开窗口，如第 35 页的 “如果 Console 在使用过程中锁死”
中所述。
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使用 New Configuration 之前

在首次使用 New Configuration 创建逻辑驱动器或逻辑卷之前，熟悉下列步骤中包含
的信息很有用。提前了解这些信息有助于创建逻辑驱动器或卷的过程顺利进行。 

1. 确定逻辑驱动器的优化模式是 Sequential I/O （默认）还是 Random I/O。必须对阵
列中的所有逻辑驱动器应用一种优化模式。您的选择将会影响可包括在阵列中的最大数
量的磁盘。

优化模式是在 Change Controller Parameters 窗口的 Cache 选项卡中设置的。有关 
Sequential I/O 和 Random I/O 的更多信息及设置优化模式的步骤，请参阅第 166 页
的 “Cache 选项卡”。

2. 根据所选择的优化模式，确定要包括在逻辑驱动器中的物理磁盘总数。

如果数据的安全性很重要，请将其余磁盘用作备用驱动器。

有关随机优化模式和按顺序优化模式的磁盘的最大数量及每个逻辑驱动器的最大可用容
量的信息，请参阅第 167 页的 “随机和顺序优化的磁盘最大数量和最大可用容量”。

注意 - 如果逻辑驱动器的容量将超过 253 GB，请参阅第 68 页的 “准备容量超过 253 
GB 的逻辑驱动器”。

3. 确定是否将某些备用驱动器作为本地备用驱动器，还是作为全局备用驱动器。

备用驱动器是一个标为备用的驱动器，用于在与逻辑驱动器相关的物理驱动器发生故障
后支持自动重建数据。对于要替换其他驱动器的备用驱动器，其大小必须至少与故障驱
动器的大小相等。另外，故障驱动器本身也必须来自 RAID 1、 3 或 5。 

本地备用驱动器是分配用于指定的逻辑驱动器的备用驱动器。当指定逻辑驱动器的某一
成员驱动器发生故障时，本地备用驱动器将成为成员驱动器并自动开始重建。

全局备用驱动器不单只为一个指定的逻辑驱动器服务。当任一逻辑驱动器中的成员驱动
器发生故障时，全局备用驱动器将加入该逻辑驱动器，并自动开始重建。

4. 确定 RAID 级别；程序会自动计算可以在该 RAID 级别创建的逻辑驱动器的最大大小。

5. 确定是否要对逻辑驱动器进行分区。

分区 是对逻辑驱动器 （或逻辑卷）的逻辑划分。分区可以创建用于文件管理、多用户
或其他目的独立逻辑驱动器 （或逻辑卷）。

注意 - 可以在初始配置时或在创建逻辑驱动器后建立分区。

注意 - 已经分区的逻辑驱动器不能添加到逻辑卷中。
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6. 理解 New Configuration 窗口中显示的磁盘容量。

■ Max Drive Size (MB)（最大驱动器大小 (MB)） - 显示所选的每个物理磁盘的最大驱
动器大小 （每个磁盘的总容量）。 

通过减小该值可以创建较小的逻辑驱动器。日后可以通过扩展驱动器来使用剩余部
分 （如第 151 页的 “扩展逻辑驱动器或逻辑卷的容量”中所示）。

■ Available Size (MB) （可用大小 (MB)） - 显示所有磁盘的总容量，它是逻辑驱动器
或逻辑卷的总的大小。

注意 - 逻辑驱动器的最大可用容量等于最小物理磁盘大小。例如，如果添加了一个 18 
GB 的磁盘然后又添加了一个 70 GB 的磁盘作为逻辑驱动器的一部分，则每个驱动器的
最大可用容量为 18 GB。

7. 确定逻辑驱动器是否为逻辑卷的一部分。 

注意 - 已经分区的逻辑驱动器不能添加到逻辑卷中。

8. 确定是否要对逻辑卷进行分区。

注意 - 可以在初始配置时或在创建逻辑卷后建立分区。

9. 确定背景率。背景率是分配给阵列管理活动 （如重建驱动器、检查奇偶校验、初始化）
的可用阵列控制器 CPU 时间的百分比。 

如果 background rate 设置为 100%，阵列管理活动比其他系统活动具有更高的优先
级。如果为 0%，则只有在阵列控制器上没有其他活动时才会进行阵列管理活动。

▼ 准备容量超过 253 GB 的逻辑驱动器
Solaris 操作环境需要用于各种操作的驱动器几何体系，例如 newfs。为了在 Solaris 操
作环境中提供合适的驱动器几何体系以用于容量超过 253 GB 的逻辑驱动器，必须使用
固件应用程序来配置 Host Cylinder/Head/Sector Mapping Configuration。有关访问
固件应用程序的信息，请参考适用于您的阵列的 Sun StorEdge 3000 Family RAID 
Firmware User's Guide。

1. 在固件应用程序中，选择主菜单上的 view and edit Configuration parameters。

2. 选择 Host-Side SCSI Parameters。

3. 选择 Host Cylinder/Head/Sector Mapping Configuration。

4. 选择 Sector Ranges 并指定 255。

5. 选择 Head Ranges 并指定 64。

6. 选择 Cylinder Ranges 并指定 <65536。
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▼ 使用 New Configuration 创建逻辑驱动器并对其进行分区

在首次使用 New Configuration 创建逻辑驱动器和对其进行分区之前，应回顾一下第 
67 页的 “使用 New Configuration 之前”中所述的步骤。

下列步骤提供了为新的逻辑驱动器创建新配置的一个工作示例。选定了 3 个逻辑驱动器
并将它们配置到一个 RAID 5 逻辑驱动器。然后一个小逻辑驱动器被创建和分区。

警告 － 在使用 New Configuration 命令之前将所有现有的数据备份到外围设备。Sun 
StorEdge Configuration Service 会自动对在阵列控制器上定义的新逻辑驱动器进行初
始化。

1. 以 ssconfig 用户身份登录。 

2. 在主窗口中选择所需的 RAID 控制器。

3. 选择 Configuration （配置） → Custom Configure （定制配置）。 

4. 单击 New Configuration （新配置）。 

显示 New Configuration Warning （新配置警告） 消息框。

5. 单击 OK （是）。 

6. 验证显示在窗口顶部的 Server （服务器） 和 Controller （控制器） 是否正确。

如果显示的服务器和控制器不正确，应单击 “Cancel”（取消）退出 “New 
Configuration”（新配置）窗口并返回到主窗口。选择相应的磁盘控制器并重新选择 
New Configuration。

7. 如果需要，为控制器设置 Background Rate （背景率）。 

8. 在 Select disks for Logical Drive 列表框中，选择第一个磁盘并单击 Add Disk （添
加磁盘）。 

再添加 2 个磁盘，此时在下方的列表框中将显示 3 个磁盘。 

如果操作错误或改变了决定，可以在驱动器列表中选择驱动器并单击 Remove Disk
（删除磁盘）。
第 7 章 完全配置 69



注意 - 因为逻辑驱动器尚未进行分区，所以 Part Size （部件大小） (MB) 与 Available 
Size （可用大小） (MB) 的值相等。一个逻辑驱动器被视为一个单独的分区。

9. 选择 RAID Level。对于此示例，选择 RAID Level 5。

这适用于逻辑驱动器中的所有磁盘。 

在此示例中，新的逻辑驱动器由三个物理磁盘组成，总容量为 103428 MB，如 
Available Size (MB) 字段所示。

对于 2U 阵列，各 RAID 级别的每个逻辑驱动器的磁盘最大数量是：

■ RAID 0 -36
■ RAID 1 - 2
■ RAID 1+ 0 - 36
■ RAID 3 或 5 - 31

对于 RAID 1，请注意如果选择四个或更多驱动器，则会创建一个 RAID 1+0 逻辑驱动
器。

“Max Drive Size”（最大驱动器
每个磁盘的 disk

“Available Size”（可用大小）- 显
所有磁盘的总容量，即

逻辑驱动器的总容量
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10. 设置 Max Drive Size （最大驱动器大小）。

Max Drive Size （最大驱动器大小） 显示每个磁盘的总容量。通过减小该值可以创建较
小的逻辑驱动器。

注意 - 如果不更改 “Max Drive Size”（最大驱动器大小），但更改 “Partition Size”
（分区大小），则会按照指定分区大小创建新的分区。剩余的逻辑驱动器大小的容量移
到最后一个分区。在以后可以通过扩展驱动器利用剩余容量 （如第 151 页的 “扩展逻
辑驱动器或逻辑卷的容量”所示）。在创建分区后，不能再编辑驱动器容量。

11. 从 Channel 和 SCSI ID 列表框中选择要将新逻辑驱动器映射到其上的主机通道和 
SCSI ID。

注意 - 如果此时不想映射逻辑驱动器，请从 Channel 列表框中选择 Do Not Map。

注意 - 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。

12. 这一步骤取决于您的下一步操作：

■ 如果要创建另一个逻辑驱动器，请单击 New LD 并重复步骤 1 到 11。 

■ 要将此逻辑驱动器添加到一个逻辑卷中，请单击 Add to LV 并参阅第 74 页的 “创
建和分区逻辑卷”。

■ 对此逻辑驱动器进行分区，请继续以下步骤。在此示例中，一个小逻辑驱动器被创
建和分区。 

13. 要创建一个小逻辑驱动器，请在 Max Drive Size 字段中键入 2000。 

注意 - 逻辑驱动器的大小显示为 4000 MB，而不是 6000 MB，因为这是 RAID 5 级别，
您丢失了等同于一个驱动器的容量 (2000 MB) 用于奇偶校验。
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14. 要创建分区，请在 Part Size 字段中键入 1000 并单击 Add Partition。

注意 - 如果您要将逻辑驱动器添加到逻辑卷中，请不要对该逻辑驱动器进行分区。一旦
对逻辑驱动器进行分区，它就不能被添加到逻辑卷中。

要创建相同大小的多个分区，请多次单击 Add Partition （添加分区），单击的次数与
您希望创建的分区数相同。还可以在 Part Size （部件大小） 字段中键入分区大小，然
后将它与您要创建的分区数相乘 (*)（例如 100*128）。剩余的 MB 大小将添加到最后一
个分区。

在添加分区时，显示在 Available Size （可用大小） (MB) 中的剩余容量将减去分区的
大小。

如下例所示，在最初的 4000 MB 中，有 1000 MB 被分配给 Partition 0。然后其余 3000 
MB 自动移到 Partition 1。余下的可用容量显示在 Available Size (MB) 字段中。
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15. （限于 Solaris 操作环境）。如果希望自动为新逻辑驱动器指定卷标 （卷标使操作环境
能够使用该驱动器），请单击 “Write a new label to the new LD”（为新 LD 写上新
卷标）。

16. 单击 Commit 结束对该逻辑驱动器的配置，或者单击 New LD 继续配置其他逻辑驱动
器。 

如果单击 “New LD”（新 LD），将显示所有尚未使用的可用磁盘。

对此阵列的逻辑驱动器配置完成后，单击 Commit， 然后单击 OK。显示已完成的配置。 

注意 - 您单击 OK 后就不能更改逻辑驱动器的配置。 

注意 - 在初始化期间， LD/LV 的大小显示为 0 MB。
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▼ 创建和分区逻辑卷 
一个逻辑卷由 2 个或更多逻辑驱动器组成，最多可以划分为 32 个分区 （对于 SCSI）
或 128 个分区 （对于光纤通道）。操作期间，主机将未分区的逻辑卷或逻辑卷的分区作
为单个物理驱动器对待。 

1. 按照第 69 页的“使用 New Configuration 创建逻辑驱动器并对其进行分区”中步骤 1 
至 11 所述创建逻辑驱动器。

注意 - 不要对要添加到逻辑卷中的逻辑驱动器进行分区。已经分区的逻辑驱动器不能添
加到逻辑卷中。

2. 要将逻辑驱动器添加到逻辑卷，请在单击 Commit 之前，单击 Add to LV。

该逻辑驱动器便被添加到 LV Definition 框中。该逻辑卷的总大小显示在 Available 
Size (MB) 字段中。 

注意 - 因为逻辑卷尚未进行分区，所以 Part Size (MB) 与 Available Size (MB) 是相等
的。逻辑卷被视为一个单个的分区。
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3. 要创建另一个逻辑驱动器以添加到该逻辑卷中，请单击 New LD。

4. 创建逻辑驱动器，并单击 Add to LV 将它添加到逻辑卷中。

为要添加到逻辑卷中的每个逻辑驱动器重复此步骤。

5. 要创建分区，请在 Part Size 字段中键入分区大小并单击 Add Partition。

要创建相同大小的多个分区，请多次单击 Add Partition，单击的次数与您希望创建的
分区数相同。您还可以在 Part Size 字段键入分区大小，并乘以 (*) 要创建的分区数
（例如 100*128）。

在添加分区时，显示在 Available Size (MB) 中的剩余容量将减去分区的大小。

6. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其它逻辑卷或者创建单个逻辑驱动器，
请单击 “Commit LV”（提交 LV）。

在创建完逻辑卷之后，如不想创建个别逻辑驱动器，请单击 Commit。

注意 - 在创建了逻辑卷之后要退出 “New Configuration”（新配置）窗口时，如果意
外地单击了 “Commit LV”（提交 LV）而不是 “Commit”（提交），则您将创建另一
个逻辑驱动器；否则，您必须单击 “Cancel”（取消）然后再次配置逻辑卷。

当逻辑驱动器被
添加到逻辑卷中以后，
这些逻辑驱动器将显示在
“LV Definition”（LV 定义）框中

“Available Size”（可用大小）- 
显示所有磁盘的
总容量，即
逻辑卷的总容量
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要添加或删除逻辑卷，或者对现有配置中的逻辑卷进行分区，请参阅第 141 页的 “更
新配置”。

▼ 清除配置

在配置过程中的任何时候如果对 New Configuration 窗口中的配置不满意，可以将其
清除。

1. 单击 Clear 从显示内容中删除所有物理驱动器和逻辑驱动器。 

2. 可以单击 New LD 定义新的逻辑驱动器，或单击 Commit。

3. 在单击 Commit 时，将显示警告提示；可以单击 OK。 

Sun StorEdge Configuration Service 在选定的阵列控制器上初始化整个配置。

注意 - 在逻辑驱动器完成初始过程后，将自动映射主机 LUN。

▼ 从配置级别注销

完成配置活动时，应登录回程序的监控级别。 

1. 选择 File → Logout。

2. 选择 Logout to monitoring mode 然后单击 OK。

主机 LUN 分配
要使服务器识别逻辑驱动器 / 逻辑卷，该逻辑驱动器 / 逻辑卷必须首先映射到一个主
机通道 /ID。当某个逻辑驱动器 / 逻辑卷映射到一个主机通道 /ID 时，该逻辑驱动器
/ 逻辑卷即成为一个 LUN。下面一节说明了如何将逻辑驱动器 / 逻辑卷映射到主机通
道以及如何将其删除。

注意 - 当首次创建逻辑驱动器 / 逻辑卷时，除非选择了 Do Not Map，否则在逻辑驱动
器 / 逻辑卷完成初始化过程之后，将自动映射主机 LUN。
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注意 - 在 Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 32 个分区。最多可以分配 128 个 LUN。逻辑卷最多可以划分为 32 
个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑
驱动器最多可以有 128 个分区。最多可以分配 1024 个 LUN（最多可以为每个主机 ID 
分配 32 个 LUN）。逻辑卷最多可以划分为 128 个分区。

▼ 添加 （映射）主机 LUN
1. 选择 Configuration → Custom Configure。

2. 从 Custom Configuration Options 菜单，选择 Change Host LUN Assignments。 

Change Host LUN Assignments 窗口显示。

3. 使用 Select Host Channel 和 SCSI ID 列表框，选择要为其分配 LUN 的通道和 ID。

在 Partitions 下方将显示所有可用 LUN。仅供参考，Used LUNs 显示用于指定通道的
LUN 的列表，Partition Assignment 显示已为其分配分区的通道、ID 和 LUN 的列表。 
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注意 - 当添加或创建逻辑驱动器 / 逻辑卷时，它将被分配为主要的或辅助的 （控制器
分配）。然后将初始化逻辑驱动器 / 逻辑卷并将其映射到主要或辅助通道 ID。如果取
消对逻辑驱动器 / 逻辑卷的映射，并将其重新映射到具有不同控制器分配的其他主机通
道 ID，您必须重置控制器。如果取消对逻辑驱动器 / 逻辑卷的映射，并将其重新映射
到具有相同 控制器分配的其他主机通道 ID，则无需重置控制器。如果逻辑驱动器 / 逻
辑卷仍然拥有已经映射的分区，则只能将未映射的分区映射到具有相同控制器分配的主
机通道 ID。

4. 从 LDs/LVs 字段中选择所需的分区，然后单击 Assign Host LUN 以接受更改。 

要映射多个分区 （最多 32 个），可选择第一个分区，滚动到最后一个分区，然后在按
住 Shift 键的同时单击，可选中两次单击位置之间的全部分区。然后单击 Assign Host 
LUN。

因此， Delete Host LUN 变为活动的。

5. 在完成时，单击 OK 以保存更改并返回到主菜单。

注意 - 当映射主机通道时如果发生了显示错误消息的事件，应重复步骤 1 到 5。

▼ 删除 （取消映射）主机 LUN
1. 在显示 Change Host LUN Assignments 窗口时，从 Host LUN Assignments 字段中

选择要删除的 LUN。

2. 单击 Delete Host LUN。

3. 在完成时，单击 OK 以保存更改并返回到主菜单。
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配置文件
在软盘或阵列之外的外围设备上保存当前配置的备份副本。即便配置信息存储在阵列控
制器或连接到它们的物理驱动器上，还可能发生火灾或洪水等情况，这些情况都会造成
控制器和驱动器的损坏。配置的备份副本用于将配置恢复到新控制器，而不必完全重新
配置存储阵列。 

无论何时发生下列情况，应随时将阵列控制器配置保存到文件：

■ 安装新的存储系统机箱或更改现有机箱中控制器的 SCSI ID

■ 更换阵列控制器

■ 重新配置或将逻辑驱动器添加到阵列控制器

■ 从故障驱动器将数据重建到备用驱动器

▼ 将配置保存到备份文件

1. 选择带有要保存其配置的控制器。

2. 选择 Configuration （配置） → Save Configuration （保存配置）。

Save Configuration （保存配置）窗口显示。

3. 如有必要，可以导航到保存配置文件的驱动器和文件夹。 

将文件保存到软盘或阵列以外的驱动器。
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4. 指定配置文件名称，然后单击 Save （保存）。

Save Configuration （保存配置）窗口显示。

5. 键入要保存的配置的说明。

6. 单击 OK （确定）。 

控制器配置信息保存到 .cfg 文件中。

装入配置

如果驱动器或控制器损坏并且需要替换，请参阅第 134 页的 “恢复逻辑驱动器配置”，
其中说明了如何装入配置文件，以及如何恢复逻辑驱动器配置。
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第 章8

LUN 过滤 （仅用于光纤通道） 

本章介绍如何为 Sun StorEdge 3510 光纤通道阵列创建 LUN 筛选器，以维护共享公共
存储设备的大型光纤通道网络。本章包含以下主题：

■ 第 81 页的 “概述”
■ 第 83 页的 “分配 LUN 过滤器”

■ 第 83 页的 “访问 LUN Filter 视图”
■ 第 84 页的 “手动添加 HBA 设备”
■ 第 86 页的 “删除标准主机映射”
■ 第 87 页的 “将逻辑驱动器映射到主机”
■ 第 89 页的 “删除 LUN 过滤器”

概述
有效维护存储基础结构的一个重要方面在于维护数据在任意时刻的可访问性和安全性。
在 LUN 筛选功能的支持下， Sun StorEdge Configuration Service 提供了用于对存储
设备访问进行安全的集中管理的实用程序。 

对于与同一阵列相连的多台服务器， LUN 过滤功能提供了从服务器到逻辑驱动器的独
占路径，从根本上隐藏或排除了其他连接的服务器，使它们不能看到或访问同一逻辑驱
动器。也就是说， LUN 过滤器将组织从主机设备访问和查看阵列设备的方式，而且通
常仅将阵列设备映射到一台主机，这样其他主机就不能访问和使用同一阵列设备。
LUN 过滤功能还可以使多个逻辑驱动器或分区映射到同一 LUN 编号，以允许不同的
服务器拥有各自的 LUN 0 用于启动（如果需要）。LUN 过滤功能还有助于使映射更加
清晰，当每个 HBA 能看到两倍于通过集线器查看到的逻辑驱动器时，这点尤其有用。

每个光纤通道设备都分配了一个唯一的标识符，叫作全球广域名称 (WWN)。WWN 由 
IEEE 进行分配，与 IP 中的 MAC 地址或 Internet 上的 URL 类似。这些 WWN 随设备
保留，直到设备寿命到期。 LUN 过滤功能使用 WWN 指定哪台服务器独占使用特定的
逻辑驱动器。可以使用简单的拖放式方法将每个逻辑驱动器映射到主机的光纤通道 
HBA 卡，后者用 WWN 进行标识。 
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如下面的示例所示，当您将 LUN 01 映射到主机通道 0 并选择 WWN1 时，服务器 A 
对该逻辑驱动器拥有专有路径。只要没有为 LUN 02 和 LUN 03 创建过滤器，所有服务
器便都可以继续看到和访问 LUN 02 和 LUN 03。

图 8-1 LUN 筛选示例

LUN 过滤的一个好处是允许更多主机 （如 Windows NT）通过公共光纤通道端口连接
到阵列，同时可以维护 LUN 的安全性。

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B02DE2F

(3) 210000E08B22DE2F

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A B C

01
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分配 LUN 过滤器
分配 LUN 过滤器包括以下步骤：

■ 访问 LUN Filter 窗口

■ 手动添加 HBA 设备 （如果看不到所需的 HBA）

■ 删除标准映射

■ 将逻辑驱动器映射到主机

▼ 访问 LUN Filter 视图

1. 通过单击 Filter View 选项卡访问 LUN Filter View。 

2. 单击容器符号 以展开设备树，可在视图的左侧查看服务器详细资料，在视图右侧查
看阵列设备详细资料。 
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▼ 手动添加 HBA 设备

如果在 Hosts 下显示的项目中看不到所需的 HBA 设备，可通过 Configure 
Host/WWN 窗口手动添加 HBA 设备。

1. 选择 Configuration → Configure Host/WWN。

2. 在 Available Hosts 列表中，选择拥有要添加的 HBA 设备的主机，然后单击 Edit。

如果该主机位于 Connected Hosts 列表下，请选择它然后单击 Remove，将其置于 
Available Hosts 列表下。

3. 在 Add/Edit Host 框中，单击 Add。
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4. 在下一个 Add/Edit HBA 框中，输入新的 Adapter Name 和相应的 WWN，然后单击 
OK。

要获得有关确定 WWN 的详细信息，请参阅第 207 页的 “确定主机全球广域名称 （仅
限光纤通道）”。

5. 在 Configure Host/WWN 窗口中，选择编辑好的主机，然后单击 Add 将该主机移到 
Connected Hosts 列表中，单击 OK。 

转到 “LUN Filter”（LUN 筛选器）视图时，新的 HBA 设备显示为灰色并可用于 
LUN 筛选。 
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▼ 删除标准主机映射

标准映射允许所有主机看到所有的标准映射逻辑驱动器。 LUN 过滤功能可以将映射限
制到特定的主机。分配 LUN 过滤器之前，必须从阵列中删除标准主机映射 （由 M 卷
标指定 ）。 

1. 单击各  All Hosts 项目，并将其拖放到 Storage Pools。

2. 出现以下消息时单击 OK： 

系统将显示一条消息，确认标准主机 LUN 映射已成功删除。

3. 如果该主机不是阵列的主代理，要将设备映射到该主机，请选择该设备，然后选择 
Configuration → Configure Host/WWN。

4. 从 “Available Hosts”（可用主机）列表中选择所需主机，然后单击 “Add”（添
加），将其添加到 “Connected Hosts”（已连接主机）列表中。 

系统将显示消息以确认添加该主机服务器。 

5. 单击 Close 以保存配置信息并退出窗口。

6. 如果要将多台主机映射到一个阵列，请选择 Configuration → LUN Filter Properties，
然后从下拉菜单中选择该阵列。 

7. 选中 Hardware Filter 和 Map to Multiple Hosts 复选框并单击 OK。 

注意 - 如果取消选择 “Hardware Filter”（硬件筛选器）复选框，将不能创建筛选器
映射；只能创建标准映射。

操作将删除逻辑驱动器 X 分区 X 的全部标准映射。 是否继续？
86 Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



▼ 将逻辑驱动器映射到主机

1. 确保处于 LUN Filter 视图；如果不是，请单击 Filter View 选项卡。

2. 从 Storage Pools 中选择一个逻辑驱动器，并将其拖放到 Hosts 下相应的 HBA 卡。 

如果不知道与该阵列相连的 HBA 卡，请将逻辑驱动器拖放至该主机。 

程序将提示您为主机中的每块 HBA 卡过滤阵列 （这表示阵列对与其相连的 HBA 卡可
见，但对其他 HBA 卡不可见）。

3. 显示确认映射的提示时，单击 OK。

Specify Map Information 窗口显示。注意，如果存在一块以上的 HBA 卡，程序自动
将逻辑驱动器映射到主机中列出的第一块 HBA 卡。

4. 将逻辑驱动器分配给主控制器或辅助控制器，并选择所需的通道和 LUN ID 编号，然
后单击 OK。 

将主控制器或辅助控制器分配给 HBA 卡是为初始 LUN 过滤器分配而选择的，因此只
有删除 LUN 过滤器分配并重新开始，才能进行更改。 
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要将 LUN 过滤器应用到同一阵列的其他主机，请重复执行第 84 页的“手动添加 HBA 
设备”下的步骤 6 到第 87 页的 “将逻辑驱动器映射到主机”下的步骤 3。 

系统将显示警告提示，提醒您两个用户同时访问同一逻辑驱动器可能导致数据破坏；单
击 OK 将添加该附加主机。 

在下面的示例中， Sun StorEdge 3510 光纤通道设备拥有到两个独立主机的 LUN 过滤
器 （注意字母 F 代表 filter）。
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▼ 删除 LUN 过滤器

1. 选择相关联的 WWN。

2. 将其拖放到 Storage Pools 中。 

3. 显示确认删除映射的提示时，单击 OK。 

4. 显示第二条确认信息时，单击 OK。 
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第 章9

监控阵列 

本章介绍如何用 Sun StorEdge Configuration Service 来监控阵列。其中描述了主窗口
以及在主窗口中双击图标时出现的组件视图窗口。还介绍了 “Event Log ”（事件日
志）如何工作以及如何使用报告功能。本章组织为下列各节：

■ 第 91 页的 “主窗口”
■ 第 98 页的 “查看详细设备信息”
■ 第 111 页的 “事件日志”
■ 第 115 页的 “Save Report”
■ 第 118 页的 “View Report”
■ 第 118 页的 “带外存储管理”
■ 第 123 页的 “通过 Web 管理存储设备”

主窗口
主窗口提供了所有阵列设备的基本状态。它显示与控制台监控的服务器相连的设备和逻
辑驱动器的状态。设备包括阵列控制器、磁盘存储机箱、物理磁盘驱动器和其他 SCSI 
设备。

该窗口的树状结构提供了连接到每台服务器的所有设备的详细信息。树视图左侧的  
或  容器符号代表设备的显示是展开的还是折叠的。  容器符号表示可以单击以显示
更多设备。  容器符号表示已经显示本级别和本级别以下的所有设备。
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下图显示了展开的主窗口视图示例。 

 

注意 - SN# 代表阵列的唯一 ID。

下图显示了折叠视图的示例。

 

要获得详细信息，可以双击图标打开组件视图窗口。将在本章的后续各节中说明组件视
图。
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主窗口的另一个特点是设备状况使用颜色编码和符号编码，从而能够容易地识别出处于
需要引起注意的状态的设备。该状态通过设备树传送，使您可以沿设备级别跟踪查找故
障。查看表 9-1 可以获得设备状态的详细信息。

联机帮助

要访问联机帮助，应选择 Help （帮助） → Contents （内容）。联机帮助为 HTML 格
式，可以通过 Internet Explorer 或 Netscape 运行。其中包括有关程序主要功能的信
息。

产品配置的树视图

对于每台服务器 （或服务器组），树视图中的设备都是按照层级结构排布的，服务器
（或组）位于顶端，然后是阵列控制器。剩余设备 （逻辑驱动器、物理设备和机箱）的
显示方式会根据所显示的阵列和控制器的不同而略有差别。本节提供了可以在树视图中
描述的窗口视图。

表 9-1 设备状态状况

颜色 符号 状况

紫色 无 组、服务器或设备处于联机状态。 

白色 无 用户还没有登录到此服务器。

黄色 本组或服务器中的一个或多个组件工作不正常，但是阵列
仍在工作。例如，其中一个物理驱动器发生故障的逻辑驱

动器在低性能状况下运行。

红色 本组或服务器的一个或多个组件不工作。逻辑驱动器具有

两个故障磁盘驱动器或一个机箱有三个故障风扇都会处于
危险状态。

灰色 组、服务器或设备没有响应。

?
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组

组 是设备树中服务器的逻辑集合。这一新的数据对象允许多台服务器包含在单一类别
下。 

组对象的外观 和行为类似于所有树对象。它具有一个图标化表示，用来代表服务
器的状态。下表显示了扩展为显示从属或底层服务器对象的组图标。

组是一个新数据对象，它允许多台服务器包含在单一类别下。组的概念类似于域。它们
使您可以对服务器进行组织。您可以将所有受管服务器组织成集或组，而不一定是线性
的树结构。

组的颜色和符号编码与服务器相似。使用该方案，带有对应颜色的状况具有如下优先
级： 

■ 危险 - 红色 （最高级别）
■ 不响应 - 灰色
■ 低性能 - 黄色
■ 良好 - 紫色
■ 未登录 - 白色

服务器图标具有任何存储系统的最高状况的颜色。相似地，组图标具有其任何服务器的
最高状况，但在存在不响应或未登录服务器的情况下，有以下例外。

如果组图标禁用 （非活动），这表示所有连接到该组的服务器都不响应，如果不是组中
所有的服务器都不响应，则组图标显示为红色，这表示危险状况。例如，如果组中有四
台服务器，三台或少于三台服务器不响应，则组图标为红色颜色编码。
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如果某个组图标的颜色编码为白色 （未登录），这表示该组中的一台或多台服务器未完
全配置，或者表示处于状态变化过程中。表 9-2 提供了一个双服务器组的不同颜色编码
示例。 

组不是必需的。例如，可以将程序配置为无组而有 15 台服务器，或者配置为有一个
组，其中下层包含 10 台服务器，顶层另有 5 台服务器。该程序允许进行任意组合。

许可的组数和组内服务器的数量仅受到可用系统内存的限制。如果服务器是一个组的成
员而用户从组列表框删除了该组，该组内的服务器会重新分配给无组类。树结构会在主
窗口中重新映射。

表 9-2 双服务器组颜色

服务器 1
 图标颜色

服务器 2
 图标颜色 组图标颜色

灰色
灰色

灰色
黄色、红色、紫色或白色

灰色 （不响应）
红色 （危险）

白色 白色 白色 （未登录）

白色 黄色 黄色 （低性能）

白色 红色 红色 （危险）

白色

红色

紫色

任何颜色

紫色 （良好）

红色 （危险）

黄色

紫色

黄色或紫色

紫色

黄色 （低性能）

紫色 （良好）
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监控过程 
控制台通过与服务器上的代理进行通信来监控网络上的存储设备。

如果在配置服务器时指定了 “Auto Discovery”（自动发现），则在启动程序时，控制
台软件通过与每台被管理服务器上的代理建立联系开始。如果没有指定 Auto 
Discovery，则必须双击每台服务器并提供密码，这样才能启动服务器发现进程。

在每台服务器上的控制台和代理之间建立 TCP/IP 连接并回收库存信息可能会花费几分
钟的时间，这取决于网络的复杂程度。执行这些操作时，主窗口中的服务器图标右侧会显
示一个盘式卫星天线图标。刷新库存后，盘式卫星天线符号将被活动服务器符号取代。

每台服务器上的代理定期扫描 其库存，检查是否发生了变化。如果发生变化，代理将一
个事件发送到控制台。根据事件的不同，控制台可能请求该服务器上次扫描的库存，用于
更新主窗口中显示的服务器。在该过程中，盘式卫星天线图标附加到了服务器图标上，只
有在刷新过程完成并且控制台主窗口更新后，才能进行配置和执行阵列活动命令。

如果程序正在运行，并且服务器代理和控制台已连接，则代理会定期向控制台发送 
ping 测试信号以验证服务器的状态。如果控制台没有从代理接收到特定数量的连续响
应 （握手），则控制台将服务器标记为离线并从服务器断开。服务器图标停止活动，并
且旁边出现一个问号。

如果非活动服务器最初是通过 “Auto Discovery”（自动发现）功能激活的，控制台会
定期尝试重新建立服务器通信。

您有时可能想在两次定期状态扫描之间执行库存检查。要执行该操作，可以双击服务器
图标显示 “Server View ”（服务器视图）窗口，然后单击该窗口中的 “Rescan”（重
新扫描）。
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Auto Discovery 选项

如果选择了 “Auto Discovery”（自动发现）选项 （在将服务器添加到 “Managed 
Servers”（受管服务器）列表的过程中，请参阅第 41 页的“选择或取消选择服务器的 
Automatic Discovery （自动发现）：”），该程序会自动在这些服务器上进行扫描并执
行库存检查。您不必提供监控口令就可以检索该程序提供的信息。根据网络的复杂程度
和服务器数目的不同，完成发现进程可能需要几分钟时间。

但是，如果选择在启动时不使用 “Auto Discovery”（自动发现）选项，则服务器的图
标为白色，表示当前没有这些服务器的信息。在这种情况下，需要双击每个服务器图标
并指定相应的监控密码。 

还可以选择 File → Login。为服务器指定口令以后，发现进程将启动，对选定服务器执
行库存检查。 

注意 - 如果需要一个即使对服务器库存数据进行访问都要受到限制的非常安全的环境，
则应为 Auto Discovery 选择 No （请参阅第 41 页的 “选择或取消选择服务器的 
Automatic Discovery （自动发现）：”）。
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查看详细设备信息 
Sun StorEdge Configuration Service 提供关于每个代理或服务器的详细信息，以及关
于连接到该服务器的阵列设备的详细信息。根据磁盘控制器功能的不同，每个视图上的
字段有所不同。

除了 Save Report 和 View Report （位于 File 菜单下）以外，本节说明的命令和窗口
可通过 View 菜单来访问。

■ View Group
■ View Server
■ 查看控制器配置
■ View Logical Drive 
■ 查看物理驱动器 
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ Save Report
■ View Report
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View Group 
View Group 显示组成在 
主窗口种选定的组的服务器。

要访问 “View Group”（查看组），请双击主窗口中的组图标  或选择组图标并选
择 “View”（查看） → “View Group”（查看组）。

Server List 显示附加到指定组的所有服务器。 

 

要查看有关列出服务器的详细信息，可以在列表中选择相应的状态记录并单击 View，
或双击状态记录。显示描述相应服务器的窗口。
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View Server 
“View Server”（查看服务器）显示主窗口中选定服务器的属性。

要访问 “View Server”（查看服务器），请双击主窗口中的服务器图标  ，或选择
服务器图标并选择 “View”（查看） → “View Server”（查看服务器）。

 

注意 - 将作为独立条目显示双端口 HBA，因为它们具有供设备连接的单独通道。

作为 TCP/IP 网络的一部分，套接字端口在服务器和客户机之间建立连接。

■ Rescan （重新扫描） - 向选定的服务器发送命令以重新扫描现有的库存并刷新控制
台。通常，每个受管服务器对其库存执行定期扫描，如果发生变化则更新控制台。
如果想要对所有分配的设备执行诊断，单击 Rescan ；选择该按钮将完全阻止状态的
定期和自动更新。

■ Probe （探测） - 向选定的服务器发送命令以探测新的库存 （例如， RAID 控制器、
JBOD 和扩展单元）。无论何时添加了新设备或更改了设备名称，想要让它立即显示
在主窗口树视图中，请单击 “Probe”（探测）。

■ Card List（卡列表） - 显示安装在或连接到指定服务器的主机适配器和阵列控制器。
要查看有关任何主机适配器或列出阵列控制器的详细信息，可以在列表中选择相应
的记录并单击 View，或双击选定的状态记录。将显示一个描述相应主机适配器或阵
列控制器的窗口。
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查看控制器配置

View Controller Configuration 显示组成阵列的组件。 

要访问 “View Controller Configuration”（查看控制器配置），请双击主窗口中的阵
列图标 ，或选择该图标并选择 “View”（查看） → “View Controller”（查看
控制器）。
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如果电池发生故障，阵列将在主窗口中显示黄色 （低性能）设备状态符号，并在
“Battery”（电池）字段中显示 “Bad”（损坏）。 

窗口底部的选项卡提供了关于 RAID 控制器的 LUN、与之连接的物理驱动器、控制器
所在的附件以及外围设备配置的详细信息。要获得有关视图内其他选项卡的信息，可单
击选项卡。

Controllers 选项卡

要访问该窗口，请双击主窗口中的阵列图标 ，或选择该图标并选择 “View”（查
看） → “View Controller”（查看控制器）。然后单击 Controller 选项卡。 

Controller 选项卡列出了两个控制器。要查看有关这两个控制器中任意一个的更多信
息，双击该控制器，或者选择该控制器然后单击 View。 View Primary 或 View 
Secondary Controller Configuration 窗口出现，具体取决于控制器是主控制器，还是
辅助控制器。请参阅第 105 页的 “View Primary/Secondary Controller 
Configuration （查看主 / 辅助控制器配置）”。
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Physical Drives 选项卡

要访问该窗口，请双击主窗口中的阵列图标 ，或选择该图标并选择 “View”（查
看） → “View Controller”（查看控制器）。然后单击 Physical Drives 选项卡。 

下图显示的是带有 Physical Drives 选项卡的 View Controller Configuration。

Physical Drives 选项卡列出了与阵列相关的物理驱动器。要查看关于任何列出物理驱
动器的详细信息，双击该驱动器或选择驱动器并单击 View。View Physical Drive 窗口
显示。

有关 View Physical Drive 的详细信息，请参阅第 108 页的 “查看物理驱动器”。
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Enclosure Info 选项卡

要访问该窗口，请双击主窗口中的 “Enclosure”（附件）图标 ，或选择阵列图标 
 然后选择 “View”（查看） → “View Controller”（查看控制器）。选择 

Enclosure Info 选项卡。选择机箱并单击 View。

Enclosure Info 选项卡包括电源、风扇和机箱温度的状态信息。有关 “View 
Enclosure”（查看附件）的详细信息，请参阅第 109 页的 “View Enclosure”。

View FRU

仅对于 Sun StorEdge 3310 SCSI 阵列，要显示该阵列的现场可替换单元标识 (FRU ID) 
信息，请单击 “View FRU”（查看 FRU）。要获得示例 FRU ID 信息，请参阅 第 110 
页的 “View FRU”。

View Controller Parameters

单击 View Controller Parameters 查看有关 Channels、RS 232、Cache、Disk Array、
Drive I/F、 Host I/F 和 Redundancy 的详细信息。要查看信息，单击与要查看项目对
应的选项卡。要更改控制器参数，请参阅第 162 页的 “更改控制器参数”。
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View Primary/Secondary Controller Configuration （查看主
/ 辅助控制器配置）

“View Primary Controller Configuration”（查看主控制器配置）和 “View 
Secondary Controller Configuration”（查看辅助控制器配置）窗口显示在主窗口中选
择的 RAID 控制器的属性。要显示主控制器属性，请从主窗口中选择主控制器并选择
“View”（查看） → “View Controller”（查看控制器），或双击主控制器。

下列两个示例显示主控制器。

下列两个示例显示辅助控制器。

“View FRU”
（查看 FRU）不用于显示
Sun StorEdge 3510
光纤通道。
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“View FRU”
（查看 FRU）不用于显示
Sun StorEdge 3510
光纤通道。
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Logical Drives 选项卡

要访问该查看窗口，请双击主窗口中的主或辅助 RAID 控制器图标 ，或选择控制
器图标并选择 “View”（查看） → “Controller”（控制器）。

单击 “View Controller Params”（查看控制器参数）可以在 “RAID Controller 
Parameters”（RAID 控制器参数）窗口中获得可编辑组件参数。

要查看逻辑驱动器，从 Logical Drives 选项卡选择并双击驱动器，或选择驱动器并单击 
View。

View Logical Drive
“View Logical Drive”（查看逻辑驱动器）显示主窗口中选定逻辑驱动器的特性。 

要访问该查看窗口，可以使用下列方法之一。 

■ 在主窗口中双击逻辑驱动器图标 。 

■ 选择逻辑驱动器图标并选择 View → View Logical Drive。 

■ 双击 RAID 控制器图标 ，选择列表框中的逻辑驱动器，然后单击 View。 

要获得有关列出的任何磁盘驱动器的详细信息，可以双击驱动器状态记录，或选择驱动
器并单击 “View”（查看）。 View Physical Drive 窗口显示。 
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查看物理驱动器 
View → View Physical Drive 显示所选物理设备的各种特性。根据选择设备的不同，
显示的查看窗口也会不同。

■ 对于磁盘驱动器 ，其名称为 View Physical Drive 窗口。
■ 对于磁带驱动器 ，其名称为 View Tape 窗口。
■ 对于 CD-ROM ，其名称为 View CD-ROM 窗口。 

要访问其中一个窗口，可以双击主窗口中的物理设备，或选择该设备并选择 “View”
（查看） → “View Physical Drive”（查看物理驱动器）。

■ Associated Partitions － 只在选定的设备与一个或多个逻辑驱动器分区相关时才会
出现。

■ View - 存在相关的逻辑驱动器时才是活动的。

前一图显示了 View Physical Drive 窗口的示例，在该窗口中选定的物理驱动器与单
一分区相关。 

■ Remaining Size（剩余大小） - 磁盘驱动器的部分容量已经用于一个或多个逻辑驱动
器时剩余的尚未使用的容量。

■ RPM - 物理驱动器的每分钟转数。

■ SMART Drive - 表示驱动器是否具有故障预测能力。
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要可以选择物理驱动器，然后选择  View。 View Logical Drive 窗口显示出来，其中没
有表格。

View Tape 和 View CD-ROM 窗口类似于前一图中显示的窗口，但是类别稍有不同。 

View Enclosure
“View Enclosure”（查看附件）窗口显示在主窗口中选择的阵列附件的组件和警报特
性。（对于 SCSI，EMU 由名称 Sun StorEdge 3310 A 进行标识； Id 通常是 14 或 15。
对于光纤通道， SES 由名称 Sun StorEdge 3510 A 进行标识； Id 通常是包含 SES 的机
箱的最后 Id。）

1. 选择 EMU (SCSI) 或 SES （光纤通道）图标 。

2. 选择 View → View Enclosure。

窗口上部的两个部分识别机箱并提供相关的信息。注意，如果有一个具有多机箱的阵
列，则可以使用 Enclosure Number 列表框 （位于窗口的右上角）来反映连接到同一
阵列控制器的另一个机箱。

要显示阵列中所有 FRU 的 FRU ID 和信息，单击 View FRU。
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只有在阵列具有 SCSI Accessed Fault-Tolerant Enclosure (SAF-TE)（用于 SCSI 阵列）
或 SCSI Enclosure Services (SES) （用于光纤通道阵列）卡的情况下，窗口的 Alarm 
State 部分才适用。

■ 如果 Alarm State 字段显示 Alarm! 并且 Reset 按钮显示为可用，则意味着存在驱
动器、风扇、电源或电池故障造成的，或者机箱中的温度异常造成的警报状况。框
中的音频警报响起。

■ 为使该程序在警报条件启动后继续进行监控，必须单击该窗口中的 “Reset”（重
置），或者可以按下阵列附件上的 “Reset”（重置）按钮。 

■ 只有拥有配置安全性特权的用户才能通过该程序来重置警报。更换故障组件，或者
机箱内部温度异常的情况下，对机箱进行检查。

窗口的下部提供窗口中各个组件的状态。在插槽中有设备时，它由一个带有颜色的驱动
器图标和一个代表其设备状况的符号代表。

View FRU
FRU 是一个现场可替换单元。它是可用于组装新系统或维修现场系统的设备。 Sun 
FRU ID （现场可替换单元标识）程序是一个 Sun 解决方案，用于获取、传送并分析 
FRU 专用的 FRU 配置、诊断和故障信息。 

选择 View → View FRU 以显示阵列中所有 FRU 的 FRU ID 和信息，包括 Serial 
Number、 Model、 Description、 Vendor ID、 Time （对 FRU 进行编程的时间） 和 
Location。
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注意 - 还可以查看特定控制器的 FRU，方法是单击 View Controller Configuration 窗
口、 View Primary Controller Configuration 窗口和 View Secondary Controller 
Configuration 窗口上的 View FRU。

Array Administration Progress
Array Admin Progress 显示新逻辑驱动器的初始化过程。要访问该命令，选择 View 
→ Array Admin Progress。

Agent Options Management
“Agent Options”（代理选项）允许您定制代理选项，其中包括轮询时间、定期设备发
现时间和 SMART 监控。

要访问 Agent Options，选择 View → Agent Options Management。要获得详细信
息，请参阅第 50 页的 “配置代理参数 （可选）”。

事件日志
控制台接收、记录并显示受管服务器和控制台本身生成的事件。

大部分事件是由受管服务器上的代理在发生下列情况时生成的：

■ 因为设备故障、功能异常或断开连接，受管服务器上的任何设备状态都在变化，其
中也包括服务器自身的变化

■ 库存变化 （设备的增加或减少）

■ 配置变化 （初始配置设置和后续配置更改）

■ 服务器上运行的阵列进程 （初始化、奇偶校验、重建）

虽然阵列进程是由控制台启动的，但是操作通知事件是由服务器代理在这些进程从服务
器上启动后生成的。

控制台生成的事件的数量要少得多。例如，如果它没有从受管服务器接收到特定数目的
连续脉冲信号，将生成一个事件。
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控制台接收到任何事件时，都会将其记录到事件日志文件 eventlog.txt 中，并将其
显示在 “Event Log”（事件日志）窗口中。另外，如果事件发生在服务器上，事件通
知会被发送到服务器的操作环境 / 系统事件日志。在 NT 服务器上，它进入 NT 事件日
志中。另外，如果事件发生在服务器上并且服务器设置为将陷阱发送到诸如 HP 
OpenView 等 SNMP 企业管理控制台，则服务器代理还将陷阱消息发送到该计算机。

根据接收的事件，控制台可能会启动刷新进程，从服务器上次所进行的周期性扫描请求
库存，从而使得控制台能够更新主窗口中的服务器库存。 

在刷新进程中，盘式卫星天线图标将连接到服务器图标上，在刷新过程完成并且控制台
主窗口更新之前，无法进行任何配置，也无法执行阵列活动命令。

事件日志文件

“Event Log”（事件日志）窗口一次最多可以显示 500 个事件。如果事件超过了 500 
个，则 “Event Log”（事件日志）窗口中只显示最新的 500 个；但在记录的事件超过 
10,000 个之前，该程序不会从事件日志文件 eventlog.txt 中删除任何事件。

■ 在记录达到 10,000 个事件后，该程序会将事件日志文件删减到剩下最新的 500 个事
件，然后开始积累事件，直到再次达到 10,000 条的限制。

■ 事件记录的每个字段由分号分隔，因此可以很容易地导入到数据库中。

■ eventlog.txt 位于安装控制台程序文件的目录中。

注意 - 如果事件日志没有包括来自受控阵列的所有事件，则关闭控制台，然后重新打
开。

即使控制台不在运行，来自代理的事件也会被记录到安装了代理的主机的系统日志中。
在 Solaris 操作环境中，事件被记录到 /var/adm/messages 并显示在控制台上。在 
Linux 操作环境中，事件被记录到 /var/log/messages。在 Windows NT 和 2000 
中，事件被记录到系统的应用程序日志，可使用 Event Viewer 查看该日志。也可以从
文件 /opt/SUNWsscs/sscsconsole/eventlog.txt 直接读取事件日志。
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Event Log 窗口

要访问 Event Log，选择 View → Event Log。单击 Close 可以隐藏此窗口，并可以在
不丢失任何内容的情况下重新打开 （从 View 菜单）。

控制台在运行时开始接收事件，与 “Event Log”（事件日志）窗口是否打开无关。

1. 要删除日志文件，单击 Delete Logfile。 

Confirmation 窗口显示，提示您保存日志文件。

2. 选择下列某一选项：

■ 在得到提示时选择 yes （是），选择文件夹和文件名，对日志文件进行保存。 

■ 在得到提示时选择 no （否）。

日志文件的内容将被删除。

注意 - 也可以使用工具条上的 Save Event Log 和 Delete Event Log  图标保存和删除 
eventlog.txt 文件的内容。
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每个事件记录都包含下表中显示的字段。

严重级别
■ Critical。该消息要求网络管理员加以干预，例如设备、电源或风扇发生故障。

■ Warning。 警告消息一般用来指示内部程序事件。但是，如果看到大量的此类消息，
可能表示服务器或网络存在故障。

■ 信息。 有关服务器上设备的消息，不需要网络管理员进行干预。

接收为选定级别和任何具有其他更高严重级别转发的警报。因此，如果选择 
Informational，则会得到有关所有警报条件的通知。但是，如果选择 Critical，则只接
收 Critical 警报。

要获得有关这些消息的详细信息，请参阅第 223 页的 “故障检修”。 

表 9-3 事件记录字段

Date 事件发生时服务器的日期。

Time 事件发生时服务器的时间。

Server 服务器的 IP 地址和服务器名称。

Card 如果适用，是事件的卡名称。

Severity
三个严重级别之一：Critical、 Warning  或 Informational。（在下面的子
节中说明了这些状况。）

Error Code 由破折号分隔的基本错误代码和扩展错误代码。

Text Message 描述事件的文本消息。
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Save Report 
“Save Report”（保存报告）选项可以创建一个文本文件，里面包含关于特定阵列的可
供该程序使用的所有信息。

1. 选择 File → Save Report。 

显示用于确认服务器 ID 的 “Report”（报告）对话框。“Exportable to 
spreadsheets”（可导出到电子表格）选项使您可以用分隔符 （逗号、分号、制表符、
冒号和竖线）来保存报告，使之能够导出到电子表格。

2. 选择 Save report。 

Save Report File 窗口显示。
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3. 键入一个文件名以识别该文件，然后单击 Save。 

该程序会记录关于选定服务器及其设备的库存和状态的报告。 

报告文件的默认保存位置是安装目录，默认文件扩展名是 .xml。最好创建一个保存报
告的子目录，因为这样可以避免安装目录出现混乱。

报告包含以下信息：

■ 常规的阵列详细信息
■ 阵列名称、状态、厂商、型号
■ 固件版本
■ 引导记录版本
■ MAC、 IP、网络掩码和网关的地址
■ 控制器的序列号

■ 阵列配置的常规概述
■ 逻辑驱动器、逻辑卷以及分区的总数

■ 控制器参数
■ 主机和驱动器通道设置和 ID

■ 每个逻辑驱动器的详细列表
■ RAID 级别
■ 逻辑驱动器中物理驱动器的数量和大小
■ 每个逻辑驱动器的分区数量和分区大小以及它们的映射

■ SAF-TE/SES 信息
■ FRU 列表
■ 物理 （硬盘）驱动器的详细信息
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下面节选了 Sun StorEdge 3510 光纤通道阵列的报告示例，格式为 .xml，可以输入到另
外的程序。 .

代码示例 9-1 Sun StorEdge 3510 光纤通道阵列报告节选

<raidbaseview>
    <raidsystem>
        <name> SUN StorEdge 3510 A-A Array SN#000198 </name>
                        <status>Good</status>
                            <manufacturer>SUN</manufacturer>
                            <model>StorEdge 3510</model>
                            <firmware_version>3.27K</firmware_version>
                            <bootrecord_version>1.31H</bootrecord_version>
                            <mac_address>00:C0:FF:00:01:98</mac_address>
                        <ip>206.235.238.198</ip>
                        <netmask>255.255.255.0</netmask>
                        <gateway>206.235.238.1</gateway>
                        <primary_sn>3341275</primary_sn>
                        <secondary_sn>3341258</secondary_sn>
                        <controller_name>198</controller_name>
                        <unique_id>198</unique_id>
                        <id_of_nvram_defaults>327K 3510 v2.39</id_of_nvram_defaults>
                        <total_logical_drives>8</total_logical_drives>
                        <total_logical_volumes>0</total_logical_volumes>
                        <total_partitions>278</total_partitions>
                        <total_physical_drives>24</total_physical_drives>
                        <total_safte_ses_devices>1</total_safte_ses_devices>
                        <cache_size>1024MB ECC SDRAM</cache_size>
                        <cpu>PPC750</cpu>
                        <battery>Good</battery>
                        <node_name>206000C0FF000198</node_name>
        <fru>
            <idx>0</idx>
            <item></item>
            <serial_number></serial_number>
            <revision></revision>
            <vendor_jedec_id></vendor_jedec_id>
            <manufacturing_date></manufacturing_date>
            <manufacturing_location></manufacturing_location>
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View Report 
使用 “View Report ”（查看报告）选项可以检查所创建的报告。

1. 选择 File → View Report。 

显示用于选择报告的 Open 对话框。

2. 选择要查看的报告，然后单击 Open。

带外存储管理 
带外存储管理功能让您能在使用 TCP/IP 的网络上监控并管理阵列。带外存储管理和带
内存储管理 （标准的存储管理方法）的不同之处在于，带内存储管理要求代理在直接
连接存储器的服务器上运行，而带外存储管理不要求在直接连接存储器的服务器上运
行。在带外存储管理的情况下，如果连接到存储器的服务器关闭，监控和维护操作不受
影响。
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下列各图举例说明各种带内和带外存储管理配置。

图 9-1 带内管理

图 9-2 带外管理

 控制台

1.1.1.1

SCSI/FC SCSI/FC

Array

1.1.1.3 1.1.1.4Agent 1.1.1.2

Console 通过
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1.1.1.1 上的代理进行通信。
代理通过 SCSI/FC 连接
与阵列进行通信。

1.1.1.1

SCSI/FC RJ45

Array

1.1.1.2 1.1.1.3

1.1.1.4

1.1.1.0

代理

SCSI/FC

控制台和

控制台与安装在服务器 

 
 

1.1.1.4 上的代理进行通信。
代理通过以太网与阵列
直接通信。
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▼ 使用带外管理

注意 - 无法通过带外管理升级控制器、 SAF-TE 和驱动器固件。

1. 确保已经为阵列设置了静态或动态 IP 地址。

如果该程序已经配置好，能够对阵列进行带内管理，您可以通过 “Change Controller 
Parameters”（更改控制器参数）设置 IP 地址。 要设置 IP 地址，请参阅第 174 页的
“Network 选项卡”。如果尚未配置该程序，可以通过 RS-232 终端设置 IP 地址。请参
考适用于您的阵列的 Sun StorEdge 3000 系列安装、操作和维护手册。

2. 设置完 IP 地址后，重置控制器。 

选择 “Array Administration”（阵列管理） → “Controller Maintenance”（控制器
维护），然后单击 “Issue Reset to the Controller”（发出控制器重置命令）。

3. 选择服务器。

4. 选择 View → Agent Options Management。 

5. 在 Agent Options Management 窗口中，单击 Out-Of-Band Agent preferred over 
In-Band。 

注意 - 选择该选项后，带外成为存储管理的首选方法。如果删除了带外配置，在启动或
重新启动服务后，该程序将返回到带内存储和监控。

6. 在 IP Address 字段中键入阵列的 IP 地址，然后单击 Add。

7. 如果已经为阵列创建了口令，请在 “Password”（口令）字段中键入口令，然后在
“Verify Password”（验证口令）字段中重新键入。

注意 - 默认情况下，该阵列没有设置密码。有关创建或更改该口令的详细信息，请参考
适用于您的阵列的 Sun StorEdge 3000 Family RAID Firmware User's Guide。
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8. 为让该程序识别带外阵列并在主窗口中进行显示，应选择该服务器。

9. 选择 View → View Server。

10. 单击 Probe。
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11. 如果尚未配置该程序对阵列进行管理，则需要指定服务器对控制器进行管理。

选择 “Array Administration”（阵列管理） → “Controller Assignment”（控制器
管理）。从“Server to manage this controller”（管理此控制器的服务器）列表中选择
一个服务器，然后单击 “Apply”（应用）。

主窗口中即可显示一个带外 HBA。

注意 - 如果窗口中没有出现带外 HBA，则重置控制器。

▼ 通过带外管理删除阵列

1. 选择服务器。

2. 选择 View → Agent Options Management。

3. 选择要从  Managed Primary Agent 列表中删除的阵列，然后单击 Remove。

HBA 仍显示在主窗口中，要将其删除，需要停止 / 重新启动服务。
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通过 Web 管理存储设备 
基于 Web 的存储管理功能使您能够方便地通过 Web 管理阵列，而不必装入整个 Sun 
StorEdge Configuration Service 软件包。下列步骤说明如何设置阵列以实现基于 Web 
的管理，以及如何通过 Web 浏览器对其进行访问。 

注意 - 此功能要求在 Solaris 主机上安装 Sun StorEdge Enterprise Storage Manager 
Topology Reporter （包含在 Sun StorEdge Enterprise Storage Manager 软件中）。有
关的详细信息，请参考适用于您的阵列的 Sun StorEdge 3000 系列发行说明 中“支持的
其它软件”部分。

注意 - Linux 不支持此项功能；也就是说，如果代理安装在运行 Linux 操作环境的系
统上， Custom Configure 窗口上的  Configure Web Server 选项将不可用。可以使用 
Linux Web 浏览器装入控制台，但代理必须安装在运行 Solaris 操作环境的系统上。

Web 浏览器要求 
Sun StorEdge Enterprise Storage Manager Topology Reporter 可以在任何连接到同一
网络 （您必须有 Solaris 操作环境的帐户）的计算机上通过一个 URL 进行查看。

Solaris/Linux 操作环境
■ Netscape 4.79
■ Java Plug-in 1.2.2_02
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Windows NT/2000 操作系统
■ Internet Explorer 5.0 或更高版本
■ Java Plug-in 1.2.2_02

或者

■ Netscape 4.76
■ Java Plug-in 1.2.2_02

设置阵列

尽管无需将整个 Sun StorEdge Configuration Service 软件包装入到将用于从 Web 访
问阵列的计算机上，但某些程序文件是必需的；因此必须将整个 Sun StorEdge 
Configuration Service 软件包安装到另一台服务器上，这样可以从该服务器向阵列传输
文件。以下步骤介绍如何方便地传输必要的文件以设置 Web 管理。

1. 确保拥有从网络到阵列的以太网连接，并且已经为阵列设置了 IP 地址。

2. 在安装有整个 Sun StorEdge Configuration Service 软件包的服务器上，选择
“Configuration”（配置） → “Custom Configure”（定制配置）。

3. 选择 Configure Web Server。

4. 验证管理代理的 IP 地址，该代理运行在直接连接到存储设备的服务器上。

5. 输入文件将被传输到的阵列的 IP 地址并单击 OK。

注意 - 默认情况下，该阵列没有设置密码。如果已经使用固件应用程序创建了密码，则
必须输入该密码。有关创建或更改该口令的详细信息，请参考适用于您的阵列的 Sun 
StorEdge 3000 Family RAID Firmware User's Guide。
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文件成功传输之后，将显示确认消息，现在便可以通过 Web 访问控制台了。

▼ 通过 Web 浏览器访问控制台

1. 打开 Web 浏览器。

2. 键入以下 URL 地址：

3. 按本指南中相应章节所示继续监控、维护和更新存储设备。

http:// ip address of workstation/esm.html
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第 章10

维护阵列 

本章说明如何使用 Array Administration （阵列管理） 来维护阵列的完整性。本章包
含下列主题：

■ 第 127 页的 “Array Administration Activities （阵列管理活动）”
■ 第 128 页的 “进行奇偶校验”
■ 第 129 页的 “进行奇偶校验调度”

■ 第 131 页的 “故障驱动器”
■ 第 131 页的 “使用备用驱动器自动重建驱动器”
■ 第 132 页的 “在没有备用驱动器的情况下进行设备重建”
■ 第 132 页的 “检查重建过程的进度”
■ 第 132 页的 “手动重建故障驱动器”
■ 第 134 页的 “恢复逻辑驱动器配置”
■ 第 136 页的 “重置控制器”
■ 第 137 页的 “将控制器蜂鸣器静音”
■ 第 137 页的 “让故障控制器恢复联机”
■ 第 139 页的 “显示 Performance Statistics”

Array Administration Activities （阵列
管理活动）
Array administration （阵列管理） 活动 （例如初始化、驱动器重建和奇偶校验）可能
会花费一定的时间，这取决于相关的逻辑驱动器或物理驱动器的大小。

其中一个过程开始后，将显示 Controller Array Progress （控制器阵列进度） 窗口。如
果关闭了该窗口，要查看进度，单击 Progress Indicator （进度指示器） 图标 或选
择 View （查看） → Array Admin Progress （阵列管理进度）。 
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▼ 进行奇偶校验    
奇偶校验是检查容错逻辑驱动器或 LUN （RAID 3 和 5）上冗余数据完整性的过程。

1. 选择要在其上运行奇偶校验的逻辑驱动器。

2. 选择 Array Administration （阵列管理） → Parity Check （奇偶校验）。

注意 - 需要作为 ssadmin 或 ssconfig 登录才能访问菜单上的选项。

3. 当 Logical Drive Parity Check （逻辑驱动器奇偶校验） 窗口显示时，选择想要进行奇
偶校验的逻辑驱动器。
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要对多个驱动器进行奇偶校验，使用 Array Administration → Schedule Parity Check 
命令，安排在近期内 （如三分钟内）进行一次奇偶校验。当调度的奇偶校验运行时，
它将逐个自动执行校验。

4. 单击 Parity Check 按钮，启动奇偶校验过程。

奇偶校验启动后，将自动显示  Progress Indicator。如果该窗口关闭，选择 View → 
Array Admin Progress 或单击 Progress Indicator 图标就可以将其重新打开。窗口出
现，其中显示每个阵列完成进度的百分比。

▼ 进行奇偶校验调度      
选择 Array Administration → Schedule Parity Check，按照调度间隔 （例如在非高峰
时间）对所指定的逻辑驱动器阵列进行校验奇偶。

■ 您可以选择调度在受管服务器上配置的任意数目的逻辑驱动器，但是，在每一阵列
控制器上您只可建立一个调度。

■ 在调度多个逻辑驱动器时，校验按逻辑驱动器编号从低到高的顺序进行。

■ 进行奇偶校验，每 GB 存储平均需要五分钟时间。

■ 通过更改背景率，可以控制分配进行奇偶校验的系统资源量。

■ 奇偶校验开始之后，可以予以停止。此操作不会导致任何数据破坏。

注意 - 需要作为 ssadmin 或 ssconfig 登录才能访问菜单上的选项。

1. 选择要对其调度奇偶校验的控制器。

2. 选择 Array Administration → Schedule Parity Check。

Schedule Parity Check 窗口显示。
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3. 在该窗口的相应字段作出选择。

■ Listed Logical Drives （列出的逻辑驱动器） - 可用的容错逻辑阵列的列表。使用 
Shift 键选择多个驱动器。

■ Background Rate （后台速度） - 分配给阵列管理活动的可用阵列控制器 CPU 时间
的百分比。从 Custom Configuration Options （定制配置选项） 窗口中选择  
Change Controller Parameters （更改控制器参数） 可更改 background rate （后台
速度）。

■ How Often （频率） - 指定要进行奇偶校验的频率。

■ Starting Day （启动星期时间） - 指定该规划启动的每星期时间。

■ Starting Time （启动时间） - 指定该规划开始的启动日时间。

■ Existing Schedule （现有规划） - 当前的奇偶校验规划：逻辑驱动器、频率、开始日
和时间。

■ Next Parity Check （下一次奇偶校验） - 下一次奇偶校验启动的日期和时间。

4. 对调度满意之后，请单击 OK （确定）。
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故障驱动器 
此节提供使用 （或不使用）备用驱动器从驱动器故障进行恢复的过程。如果因为某些
原因无法启动重建过程，还提供了在驱动器发生故障后，手动重建驱动器的指令。

警告 － 须在发生故障之前预先为每个逻辑驱动器阵列安装和配置本地或全局备用驱动
器。根据使用的 RAID 级别类型以及归档实现过程的不同，在一个或多个驱动器发生故
障时，可能丢失大量数据。另外，应在现场准备好经过测试的备用驱动器，以在发生故
障时立即替代。 

▼ 使用备用驱动器自动重建驱动器

当与容错逻辑驱动器相关联的驱动器发生故障，且备用驱动器已预先安装并配置为全局
或者本地备用驱动器时，故障驱动器将被自动替换，并且使用指定的备用驱动器重建其
数据。为使该过程正确完成，备用驱动器的容量必须总是 等于或大于被替代的故障驱
动器。 

重建进程通常在一到两分钟内启动。该程序在后台运行，在控制器上没有其它活动的情
况下，每 GB 大约需要 8 分钟时间。

在自动重建过程中，正常活动可以继续，但是性能会降低。性能降低的程度取决于控制
器设置的背景率。

要显示重建进程的过程，选择 View → Array Admin Progress。

1. 根据您的阵列的 Sun StorEdge 3000 系列安装、操作和维护手册 中的指示来更换故障驱
动器，以便重新建立自动重建功能。

2. 在取下故障驱动器后插入另一个新的驱动器之前，应至少等待 60 秒。 

确保替换用驱动器至少等于机箱中最大驱动器的容量。将替代驱动器插入故障驱动器的
同一个插槽中 （驱动器托架），替代驱动器就可成为新的备用驱动器。

3. 重建过程完成，并且逻辑驱动器再次联机后，应将阵列控制器配置备份到外部驱动器或
软盘上的文件中。

参阅第 55 页的 “保存逻辑驱动器配置”。
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▼ 在没有备用驱动器的情况下进行设备重建

如果在阵列中没有备用驱动器，在故障重建程序启动前，需要替代故障驱动器。

1. 如果没有备用驱动器，要恢复驱动器故障，应根据适用于您的阵列的 Sun StorEdge 
3000 系列安装、操作和维护手册 中的指示更换故障驱动器。 

2. 在取下故障驱动器后插入另一个新的驱动器之前，应至少等待 60 秒。 

确保替代驱动器的容量至少等于故障驱动器的容量。将替代驱动器安装于故障驱动器相
同的地址 （驱动器托架）。

3. 当在同一插槽中更换故障驱动器之后，需要对其进行扫描。

要获得在驱动器中扫描的详细指示，请参阅第 156 页的 “扫描新硬盘驱动器”。

4. 扫描驱动器后，必须通过选择 Array Administration → Rebuild 来手动对其进行重
建。

▼ 检查重建过程的进度

1. 选择 View → Array Admin Progress 或单击窗口右上角的 Progress Indicator 图标 
。 

Controller Array Progress 窗口出现，其中显示重建完成的百分比。但是，如果在多个
控制器上有阵列活动（如初始化，重建或奇偶校验）发生，首先显示 Select Controller 
Progress 窗口。 

2. 选择要查看其进度的控制器，并单击  OK。 

Controller Array Progress 窗口出现，其中显示选定控制器的阵列进度。请参阅第 127 
页的 “Array Administration Activities （阵列管理活动）”。

▼ 手动重建故障驱动器

大多数情况下，不必使用手动重建过程，因为替代驱动器将被自动重建。 

如果备用驱动器在故障发生时不可用，或由于某些原因，驱动器无法重建，可以使用 
Rebuild 手动启动重建程序。另外，若重建程序因重新设置而中断，使用 Rebuild 重新
启动重建程序。

1. 根据适用于您的阵列的 Sun StorEdge 3000 系列安装、操作和维护手册 中的指示来更换
故障驱动器。

2. 在取下故障驱动器后插入另一个新的驱动器之前，应至少等待 60 秒。 

确保替换用驱动器的容量至少等于机箱内最大驱动器的容量。 
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3. 选择 Array Administration → Rebuild。 

Rebuild 窗口显示。 

       

4. 选择替代驱动器的状态记录。

5. 单击 OK 以启动重建过程。

重建过程是在后台执行的，在阵列控制器上没有其他活动时，每 GB 数据大约需要处理 
8 分钟。在重建期间，虽然性能会下降，但是常规活动仍可以继续。性能降低的程度取
决于控制器设置的背景率。

6. 要检查重建过程的进度，选择 View → Array Admin Progress 或单击窗口右上角的 
Progress Indicator 图标。

Controller Array Progress 窗口出现，其中显示重建完成的百分比。

如果在多个控制器上有阵列活动（如初始化，重建或奇偶校验）发生，首先显示 Select 
Controller Progress 窗口。

7. 选择要查看其进度的控制器，并单击  OK。 

Controller Array Progress 窗口出现，显示该控制器的阵列重建状态。 
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▼ 恢复逻辑驱动器配置 
本节说明了如何从备份文件中恢复阵列配置信息。必须已经使用 Save 命令保存过备份
文件（如 第 79 页的“配置文件” 所示）。如果阵列控制器及其驱动器损坏，可以将阵
列配置恢复到新控制器，而不必完全重新配置存储阵列。

警告 － 只有当配置文件是当前的，才从文件中恢复阵列配置。恢复过时的或不正确的
配置会导致数据丢失。

如果确定备份文件包含正确的阵列配置信息，继续下列过程恢复配置。

1. 为相应的阵列选择控制器。

2. 选择 Configuration → Load Configuration。 

Select Configuration File 窗口显示。 

3. 指定备份配置文件的名称和位置，并单击 Open。
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Load Configuration 窗口显示。要查看配置树视图表示，单击 Configuration View 选
项卡。

Saveset Description 选项卡显示创建配置文件时指定的文件说明。
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4. （限于 Solaris 操作环境）。如果希望自动为逻辑驱动器指定卷标 （卷标使操作环境能
够使用该驱动器），请单击 “Write a new label to the new LD”（为新 LD 写上新卷
标）。

5. 要装入已保存的配置，选择 OK。

Load Configuration Confirmation 窗口显示。

在做出是否继续的决定前，应仔细检查 Load Configuration Confirmation 窗口中显示
的信息。

6. 单击 Apply  以装入此配置，或单击 Cancel 以终止此功能。

单击 Apply  将继续配置操作，并显示进度窗口。

注意 -  不要 在恢复阵列配置备份文件内容后初始化 LUN。

7. 如果正在运行 Windows NT，应关闭并重新启动操作系统。

需要重新初始化操作系统以使逻辑驱动器配置被 Windows NT 识别。

▼ 重置控制器

无论何时对控制器参数做出更改，都将询问是否要重置控制器以使更改生效。如果做出
多个更改，可能不想在每次更改后便停止并重置控制器。使用 Issue Reset to the 
Controller 选项在做出多个参数更改后手动重置控制器。

1. 在主窗口中选择任意存储设备图标。 

2. 选择 Array Administration → Controller Maintenance。
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3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Issue Reset to the Controller。

注意 - 重置 Sun StorEdge 3310 SCSI 阵列上的控制器会导致主机端显示错误消息，如
奇偶校验错误和同步错误消息。在这种情况下不需要采取任何操作；控制器重新初始化
完成后，该情况会自动更正。

▼ 将控制器蜂鸣器静音

当引起控制器发出蜂鸣声的事件发生时 （例如逻辑驱动器故障、重建期间或者添加 
SCSI 驱动器时），您可以将控制器蜂鸣器静音。可以使用以下两个方法中的一个。

1. 在主窗口选择控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为  ssconfig 登录，会显示密码提示；键入 ssconfig  密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Mute Controller Beeper。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Mute Beeper。

▼ 让故障控制器恢复联机

如果控制器发生故障，通过下面两个方法中的一个使其恢复联机。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为  ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。
第 10 章 维护阵列 137



4. 单击 Deassert Failed Redundant Controller。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Redundancy 选项卡。

5. 在 Set Controller Config 字段中，选择 Redundant Deassert Reset。

▼ 将双控制器阵列转换为单控制器阵列

如果双阵列控制器配置中有一个控制器发生故障，您可能想使单控制器延长运行一段时
间，以使该阵列不会在控制台中显示为降级阵列。

1. 确保您知道要被删除的控制器的序列号。

您可以查看事件日志，获得发生故障的控制器的序列号，或者查看控制台并记下主控制
器的序列号。

2. 将余下的控制器的冗余设置改为禁用。

必须使用固件应用程序来禁用控制器的冗余。有关访问固件应用程序的信息，请参考适
用于您的阵列的 Sun StorEdge 3000 Family RAID Firmware User's Guide，然后继续执行
下面的操作步骤。

a. 从主菜单上选择 view and edit Peripheral devices，然后按 Return。

b. 选择 Set Peripheral Device Entry，然后按 Return。

c. 选择 Redundant Controller - Primary，然后按 Return。

d. 选择 Disable redundant controller，然后按 Return。

3. 按照适用于您的操作环境 / 系统的安装章节中的说明停止 Agent。

4. 转到 /var/opt/SUNWsscs/ssagent 并编辑 sscontlr.txt 文件。

该文件的最后一行包含两个控制器的序列号。从该行中删除发生故障的控制器的序列
号。

5. 按照适用于您的操作环境 / 系统的安装章节中的说明启动代理。

6. 如果控制台在此过程中处于打开状态，则重新扫描该控制台。

# RAID_CONTROLLER=Enable:3197861:3179746
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▼ 显示 Performance Statistics
使用 Performance Statistics 可以确定数据传输速率，也就是阵列运行的速度。

1. 选择 Array Administration → Controller Maintenance。

2. 如果还没有作为  ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

3. 单击 Performance Statistics。

Performance Statistics 窗口显示。
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第 章11

更新配置

当希望更改当前配置或添加内容时，请参阅本章。本章说明了下列任务：

■ 第 142 页的 “添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷”

■ 第 146 页的 “删除逻辑驱动器或逻辑卷”

■ 第 148 页的 “创建分区”

■ 第 150 页的 “删除分区”

■ 第 151 页的 “扩展逻辑驱动器或逻辑卷的容量”

■ 第 153 页的 “将 SCSI 驱动器添加到现有逻辑驱动器”

■ 第 154 页的 “复制并替换成员驱动器”

■ 第 156 页的 “扫描新硬盘驱动器”

■ 第 157 页的 “下载 RAID 控制器固件”

■ 第 159 页的 “升级固件和引导记录”

■ 第 160 页的 “升级硬盘驱动器上的固件”

■ 第 161 页的 “升级 SAF-TE/SES 设备的固件”

■ 第 162 页的 “更改控制器参数”

■ 第 163 页的 “保存已更改值”

■ 第 175 页的 “将控制器蜂鸣器静音”

■ 第 176 页的 “指定或更改备用驱动器”

■ 第 177 页的 “编辑服务器条目”

如果诸如奇偶校验等阵列管理进程正在运行，则可能会暂时禁用 Configuration （配
置） 菜单命令和工具图标。在控制台刷新服务器上的库存时，菜单命令也显示为被停
用。在刷新过程中，盘式卫星天线图标将被附加到服务器图标 。

要使用 Configuration （配置） 选项，必须使用 ssconfig 密码登录到软件的 
ssconfig 安全级别。完成配置活动时，应登录回程序的监控级别。
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▼ 添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷

使用该选项可以向 RAID 集的现有配置添加一个或多个逻辑驱动器，或者从新的 逻辑
驱动器添加逻辑卷。要从现有的 逻辑驱动器添加逻辑卷，请参阅第 144 页的 “将现有
的逻辑驱动器添加到逻辑卷”。

注 － 如果逻辑驱动器的容量将超过 253 GB，请参阅第 68 页的 “准备容量超过 253 
GB 的逻辑驱动器”。

1. 选择相应的阵列。

2. 选择 Configuration （配置） → Custom Configure （定制配置）。

注 － 该选项是不活动的，除非已选择了带有可用物理驱动器的阵列。

3. 从 Custom Configuration Options （定制配置选项） 窗口选择 Add LDs/LVs to the 
Current Configuration （将 LDs/LVs 添加到当前配置）。

4. 验证显示在窗口的顶部的服务器和控制器是否正确。

5. 选择要包括在新逻辑卷中的磁盘并单击 Add Disk （添加磁盘）。

如果操作错误或您改变了决定，选择驱动器并单击 Remove Disk。

6. 选择一个  RAID Level （RAID 级别）。 

有关 RAID 级别的定义，请参阅第 179 页的 “RAID 基本知识”。 

7. 从 Channel 和 SCSI ID 列表框中选择要将新逻辑驱动器映射到其上的主机通道和 
SCSI ID。

8. 设置 Max Drive Size （最大驱动器大小）。 

Max Drive Size 显示每个磁盘的总容量。通过减小该值可以创建较小的逻辑驱动器。   

注 － 如果不更改 “Max Drive Size”（最大驱动器大小），但更改 “Partition Size”
（分区大小），则会按照指定的分区大小创建新的分区。剩余的逻辑驱动器大小的容量
移到最后一个分区。在以后可以通过扩展驱动器利用剩余容量 （如第 151 页的 “扩展
逻辑驱动器或逻辑卷的容量”所示）。在创建分区后，不能再编辑驱动器容量。

注 － 如果您想在同一个控制器上另创建一个逻辑驱动器，单击 New LD。系统会创建
您刚定义的逻辑驱动器，并返回到窗口的顶部，这样您可以创建其它的逻辑驱动器。在 
Sun StorEdge 3310 SCSI 阵列上，最多可以创建 8 个逻辑驱动器，每个逻辑驱动器最多
可以有 32 个分区。在 Sun StorEdge 3510 FC 阵列上，最多可以创建 8 个逻辑驱动器，
每个逻辑驱动器最多可以有 128 个分区。 
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9. 将此逻辑驱动器添加到逻辑卷，请单击  New LD  并参阅第 143 页的 “将逻辑驱动器
添加到逻辑卷”。

10. 若对该窗口的选择满意，不需要定义另一个逻辑驱动器，单击 Commit （提交）。 

新的配置显示在确认窗口中。单击 “OK”（确定）以接受配置。

11. 选择 “Cancel”（取消）返回到控制台。

这提供了额外的容错。可以根据需要随时将驱动器的状况改回可用。

注 － 您单击 OK 后就不能更改逻辑驱动器的配置。

注 － 在初始化期间， LD/LV 的大小显示为 0 MB。

▼ 将逻辑驱动器添加到逻辑卷 

逻辑卷由 2 个或 2 个以上逻辑驱动器组成，最多可以划分为 32 个分区。操作期间，主
机将未分区的逻辑卷或逻辑卷的分区作为单个物理驱动器对待。 

1. 根据第 142 页的 “添加逻辑驱动器或从新的逻辑驱动器添加逻辑卷”中步骤 1 到 8 所
述创建逻辑驱动器。

注 － 不要对要添加到逻辑卷中的逻辑驱动器进行分区。已经分区的逻辑驱动器不能添
加到逻辑卷中。
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2. 要将逻辑驱动器添加到逻辑卷，请在单击 Commit 之前，单击 Add to LV。

该逻辑驱动器便被添加到 LV Definition 框中。该逻辑卷的总大小显示在 Available 
Size (MB) 字段中。 

注 － 因为逻辑卷尚未进行分区，所以 Part Size (MB) 与 Available Size (MB) 是相等
的。逻辑卷被视为一个单个的分区。

3. 要创建另一个逻辑驱动器以添加到该逻辑卷中，请单击 New LD。

4. 创建逻辑驱动器，并单击 Add to LV 将它添加到逻辑卷中。

为要添加到逻辑卷中的每个逻辑驱动器重复此步骤。

5. 要创建分区，请参阅第 148 页的 “创建分区”。

6. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其它逻辑卷或者创建单个逻辑驱动器，
请单击 “Commit LV”（提交 LV）。

在创建完逻辑卷之后，如不想创建个别逻辑驱动器，请单击 Commit。

注 － 创建完逻辑卷后，如想退出 New Configuration 窗口，如果意外地单击了 
Commit LV 而不是 Commit，则您将创建另一个逻辑驱动器；否则，您必须单击 
Cancel 然后再次配置逻辑卷。

▼ 将现有的逻辑驱动器添加到逻辑卷

注 － 在从现有的逻辑驱动器添加逻辑卷之前，必须首先取消对该逻辑驱动器的映射。

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

注 － 该选项是不活动的，除非已选择了带有可用物理驱动器的阵列。

3. 从 Custom Configuration Options 窗口选择 Add LDs/LVs to the Current 
Configuration。

4. 验证显示在窗口的顶部的服务器和控制器是否正确。

5. 选择 Use existing LDs to create LVs。

如果在 Select a Logical Drive 下未列出任何逻辑驱动器，说明逻辑驱动器尚未被取消
映射，因此无法选择。必须先取消逻辑驱动器的映射。
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6. 选择逻辑驱动器并单击 Add to LV。

7. 向逻辑卷中添加完逻辑驱动器以后，如果要创建其它逻辑卷或者创建单个逻辑驱动器，
请单击 “Commit LV”（提交 LV）。

在创建完逻辑卷之后，如不想创建单个的逻辑驱动器，请单击 “Commit”（提交）。

注 － 创建完逻辑卷后，如想退出 New Configuration 窗口，如果意外地单击了 
Commit LV 而不是 Commit，则您将创建另一个逻辑驱动器；否则，您必须单击 
Cancel 然后再次配置逻辑卷。

如果选择 Use existing LDs 
to create LVs 之后，没有
列出任何逻辑驱动器，则
说明逻辑驱动器还没有
取消映射。您必须首先
取消对逻辑驱动器的
映射。
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▼ 删除逻辑驱动器或逻辑卷

使用该选项可以从 RAID 集合的现有配置中删除一个或多个逻辑驱动器或逻辑卷。

注 － 在删除逻辑驱动器或逻辑卷之前，必须取消对所有已分配的 LUN 的映射。

1. 选择相应的阵列。

2. 查看要删除的逻辑驱动器或逻辑卷。

3. 只要任何逻辑驱动器或逻辑卷拥有主机 LUN 分配，执行步骤 4 ；如果没有，执行步骤 
8。

4. 选择 Configuration → Custom Configure。

5. 选择 Change Host LUN Assignments。

6. 选择连接到要取消映射的逻辑驱动器或逻辑卷的主机 LUN，并单击 Unmap Host 
LUN。

7. 单击 OK，然后单击 Close。

8. 选择 Configuration → Custom Configure。

9. 从 Custom Configuration Options 窗口选择 Manage Existing LDs/LVs and 
Partitions。

10. 选择 LDs/LVs 选项卡。

11. 选择要删除的逻辑驱动器或逻辑卷，然后单击 Delete 并单击 OK。

删除逻辑卷时，单击 Delete 后，逻辑卷即被删除，但仍然显示组成该逻辑卷的逻辑驱
动器。
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12. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。

逻辑驱动器 / 逻辑卷号码

与每个逻辑驱动器相关的逻辑驱动器 / 逻辑卷号码是动态的；当创建 / 删除逻辑驱动器
时，号码会发生变化。该号码显示在多个窗口的逻辑驱动器 (LDs/LVs) 字段中，这些窗
口包括“Dynamically Grow and/or Reconfigure LDs/LVs”（动态增加和 / 或重新配
置 LD/LV）、“Change Host LUN Assignments”（更改主机 LUN 分配）、“Manage
Existing LDs/LVs and Partitions”（管理现有的 LD/LV 和分区）和主窗口。

该号码严格用作占位符，以便能够在视觉上 跟踪逻辑驱动器和逻辑卷，因而对控制器
没有意义。也就是说，控制器并不依据该号码对逻辑驱动器或逻辑卷进行报告。例如，
如果存在四个逻辑驱动器， LD2 被删除，则现有的 LD3 动态变为 LD2，而 LD4 变为 
LD3。只有 LD/LV 号码发生变化；逻辑驱动器上的所有 LUN 映射和数据保持不变。 

控制器报告逻辑驱动器的总数目 （这里是三个），因此显示在 LD/LV 字段中的实际 
LD/LV 号码是不相关的。在本例中，如果创建了新的逻辑驱动器，则占用已删除的逻
辑驱动器的 LD 号码，控制器报告总共有四个逻辑驱动器。所有现有的逻辑驱动器回到
原先的主 / 辅助指定。 

注 － 如下面的示例所示，固件终端菜单选项 View and Edit Logical Drives 上的 LG 
号码在视觉上不是 动态的。删除逻辑驱动器后，您将看到空的占位符。在从控制台或
终端创建逻辑驱动器时，这一空的占位符填充为新的逻辑驱动器。
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▼ 创建分区

注 － 创建分区前，需要取消映射所有指定的 LUN。

1. 选择相应的阵列。

2. 查看要创建分区的一个或多个逻辑驱动器。

3. 只要任何逻辑驱动器拥有主机 LUN 分配，执行步骤 4 ；如果没有，执行步骤 8。

4. 选择 Configuration → Custom Configure。

5. 选择 Change Host LUN Assignments。

6. 选择连接到要分区的一个或多个逻辑驱动器的主机 LUN，并单击  Delete Host LUN。

7. 单击 OK，然后单击 Close。

8. 选择 Configuration → Custom Configure。

9. 从 Custom Configuration Options 窗口选择 Manage Existing LDs/LVs and 
Partitions。

10. 选择 Partitions 选项卡。

“Manage Existing LDs/LVs and Partitions”（管理现有的 LD/LV 和分区）窗口（右侧）中的“LD”
字段是动态的；当创建 / 删除逻辑驱动器时，该字段发生变化。在本示例中，LD2 被删除并且 LD4 

驱动器）（左侧）中，“LG”字段不是动态的；空的插槽表示已删除 LD2。
变成 LD3，而 LD 2 变成 LD1。在终端菜单选项“View and Edit Logical Drives”（查看和编辑逻辑
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11. 选择要进行分区的逻辑驱动器或逻辑卷。

12. 以 MB 为单位指定 Partition Size 并单击 Create。

要创建相同大小的多个分区，请多次单击 Add Partition，单击的次数与您希望创建的
分区数相同。还可以在 Part Size 字段中键入分区大小，然后将它与您要创建的分区数
相乘 (*) （例如 100*128）。剩余的 MB 大小将添加到最后一个分区。

在添加分区时，显示在 Available Size (MB) 中的剩余容量将减去分区的大小。

13. 要更改已创建分区的大小，选择逻辑驱动器或逻辑卷，并单击 Modify Size。 

14. 在 Partition Size 字段中指定新的大小 （以 MB 为单位），然后单击 OK。

15. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。

对逻辑驱动器或逻辑卷进行分区后，如果在主窗口中打开逻辑驱动器或逻辑卷，将显示
分区 。
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逻辑驱动器 / 逻辑卷号码

要获得有关在 Manage Existing LDs/LVs and Partitions 窗口的 LDs/LVs  字段中显示
的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 147 页的 “逻辑驱动器 / 逻辑卷号
码”。

▼ 删除分区

注 － 要删除逻辑驱动器或逻辑卷上的分区，需要取消映射所有分配的 LUN。

1. 选择相应的阵列。

2. 查看要在其上删除分区的逻辑驱动器或逻辑卷。 

只要驱动器上的任何分区已映射了 LUN，执行步骤 3 ；如果没有，执行步骤 7。

3. 选择 Configuration → Custom Configure。

4. 选择 Change Host LUN Assignments。

5. 选择已映射到要删除的逻辑驱动器或逻辑卷的分区的 LUN，然后单击 “Unmap Host 
LUN”（取消映射 LUN）。

6. 单击 OK，然后单击 Close。

7. 选择 Configuration → Custom Configure。

8. 从 Custom Configuration Options 窗口选择 Manage Existing LDs/LVs and 
Partitions。

9. 选择 Partitions 选项卡。

10. 从逻辑驱动器或逻辑卷中的最后一个分区开始选择要修改或删除的分区。

11. 单击 Delete，然后单击 OK。
150 Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



12. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。

▼ 扩展逻辑驱动器或逻辑卷的容量

使用该选项可以扩展现有逻辑驱动器或逻辑卷的容量。例如，您可能当初拥有一个容量
为 18 GB 的驱动器，但只选择了 9 GB 的空间来建立逻辑驱动器。要利用剩余的 9 GB，
需要扩展逻辑驱动器。 

注 － 要扩展逻辑卷，您必须首先扩展组成逻辑卷的逻辑驱动器。

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要扩展的逻辑驱动器或逻辑卷。

5. 选择 Expand LD/LV 选项卡。
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6. 在 Maximum Drive Expand Capacity 字段中以 MB 为单位指定要在逻辑驱动器或逻
辑卷上扩展的容量，然后单击 OK。 

Maximum Drive Expand Capacity 不能超过 Maximum Available Drive Free 
Capacity。

7. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。

逻辑驱动器 / 逻辑卷号码

要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 147 页的 “逻辑驱动器 / 逻
辑卷号码”。

如果创建逻辑驱动器时
使用了其全部容量，
将显示 0 ；表示没有空
间用于扩展除非再添加

一个逻辑驱动器。
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▼ 将 SCSI 驱动器添加到现有逻辑驱动器 
1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要添加 SCSI 驱动器的逻辑驱动器。

5. 选择 Add SCSI Drives 选项卡。

6. 从 Available disks 列表，选择要添加到逻辑驱动器的驱动器。

7. 单击 Add Disk。 

该驱动器被移到 Add disk(s) to LD 列表。

如果您操作错误或改变了决定，从 Add disk(s) to LD 列表中选择磁盘并单击 
Remove。

8. 在添加完 SCSI 驱动器后，单击 OK。

9. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。
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逻辑驱动器 / 逻辑卷号码
要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 147 页的 “逻辑驱动器 / 逻
辑卷号码”。

▼ 复制并替换成员驱动器 
您可以用具有更高容量的驱动器复制和取代现有的成员驱动器。例如，逻辑驱动器原来
由三个成员驱动器组成，每一个成员具有 18 GB 的容量，如下图所示该逻辑驱动器可
由具有 36 GB 容量的新驱动器取代。

图 11-1 复制并替换成员驱动器

1. 选择相应的阵列。

2. 选择 Configuration → Custom Configure。

3. 从 Custom Configuration Options 窗口选择 Dynamically Grow and/or 
Reconfigure LDs/LVs。

4. 选择要进行复制和替换操作的逻辑驱动器。

5. 在 Dynamically Grow and/or Reconfigure LDs/LVs  窗口中选择 Copy and Replace 
Drive 选项卡。

6. 从 Drive to Copy Data From 列表选择新的硬盘驱动器。

18 GB18 GB18 GB
新驱动器

36 GB

36 (GB)36 (GB) 36 (GB)

RAID5 (4 GB)

使用中

未使用

新驱动器
36 GB

新驱动器
36 GB

RAID5 (4 GB)
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7. 从 Drive to Copy Data To 列表选择要替换的硬盘驱动器，然后单击 OK。

要利用新驱动器所提供的更多容量，遵照执行第 151 页的 “扩展逻辑驱动器或逻辑卷
的容量”中的操作指示。

8. 单击 Confirm Configuration Operation 窗口中的 OK，以完成该操作，然后单击 
Close。

9. 当完成操作后，关闭进度窗口。

逻辑驱动器 / 逻辑卷号码

要获得有关在 Dynamically Grow and/or Reconfigure LDs/LVs 窗口的 LD/LV 字段
中显示的逻辑驱动器 / 逻辑卷号码的重要信息，请参阅第 147 页的 “逻辑驱动器 / 逻
辑卷号码”。
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▼ 扫描新硬盘驱动器             
可扫描到硬盘，并且不必关闭阵列即可使用。

1. 双击相应的阵列。

2. View Controller Configuration 窗口显示。

3. 选择 Physical Drives 选项卡，然后单击 Scan SCSI Drive。

4. 选择驱动器的正确的输入 Channel （通道）和 ID。

如果扫描成功，会正确地显示驱动器并可用。
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▼ 下载 RAID 控制器固件

可以使用以下过程为单个或冗余控制器配置升级控制器固件。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

 

4. 如果仅更新固件 （而不更新引导记录），选择 Download Firmware 选项。 

Select Firmware File 窗口显示。
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5. 选择要下载的固件，并单击 Open。

Confirmation Dialog 提示显示。

6. 单击 Yes。 

将固件下载到 RAID 控制器会显示一个进度条。

7. 当进度条达到 100% 时，单击 OK。 
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8. 下载固件后，检查设置，以确保配置正确。

▼ 升级固件和引导记录

1. 转到 Array Administration → Controller Maintenance。

2. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

3. 选择 Download Firmware with Boot Record。

Select Boot Record File 窗口显示。

4. 选择引导记录并单击 Open。 

5. 选择相应的固件文件。 

Select Firmware File 显示。

6. 单击 Open。 

Confirmation Dialog 窗口显示。

7. 重复前面小节的步骤 6 到 8。
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下载用于设备的固件
该选项允许升级硬盘驱动器和 SAF-TE/SES 设备上的固件。

▼ 升级硬盘驱动器上的固件

1. 选择相应的阵列。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for Disks 选项卡。

4. 选择 To All disks under Controller，并从菜单选择一个阵列；或者选择 To All disks 
under LD，并从菜单选择逻辑驱动器。

■ 如果有不想下载新固件的驱动器，就从 Selected Disks 将其选中，然后单击 
Remove。

■ 如果有要添加的逻辑驱动器，从 Available Disks 选择它们并单击 Add。

■ 如果有多个驱动器有不同的产品 ID，则一定要从 Product ID 列表框选择想要为其下
载固件的驱动器的产品 ID。

5. 单击 Browse 并找到下载固件文件。 

选择 Open。
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6. 选择要下载的固件文件，单击 Open，然后单击 OK。

开始下载固件。

7. 当下载进程显示为 100% 时，单击 OK。

8. 要验证固件是否已成功下载，选择 View → View Physical Drive，确保在 Product 
Revision 字段中的固件版本已更改。

▼ 升级 SAF-TE/SES 设备的固件 

注 － SAF-TE 设备由 SCSI 阵列使用， SES 设备由光纤通道阵列使用。

1. 选择阵列。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for SAFTE/SES Devices 选项卡。

■ 要添加设备，可以从 Available SAF-TE Devices 中选择设备，并单击 Add。
■ 要删除设备，可以从 Selected SAF-TE Devices 中选择设备，并单击 Remove。

4. 单击 Browse 并找到下载固件文件。 

5. 选择要下载的固件文件，单击 Open，然后单击 OK。

开始下载固件。

6. 当下载进程显示为 100% 时，单击 OK。
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7. 要验证固件是否已成功下载，选择 View → View Enclosure，确保在 Firmware Rev  
字段中的固件版本已更改。

▼ 更改控制器参数

1. 从主菜单中选择相应的阵列控制器。

2. 选择 Configuration → Custom Configure。 

如有必要，使用 ssconfig 口令登录到程序的配置级别。 Custom Configuration 
Options 窗口显示。

3. 从 Custom Configuration Options 窗口，选择 Change Controller Parameters。 

显示 “Change Controller Parameters”（更改控制器参数）窗口，其中 “Channel”
（通道）选项卡已被选中。

注 － 对于 Sun StorEdge 3510 FC 阵列， CurClk 为 2.0GHz。

■ Controller Name （控制器名称） - 如果需要设置控制器名称，选择 “Controller 
Name”（控制器名称）并键入想要的名称。单击 OK 保存更改。

■ Controller Unique ID （控制器唯一 ID） - 系统自动设置此 ID。
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▼ 保存已更改值

“Change Controller Parameters”（更改控制器参数）窗口中某些选项需要重置控制器
才能使更改生效。如果某项更改要求重置控制器，则窗口的左下侧会显示以下消息：

[需要复位控制器，更改才能生效。

要重置控制器并保存更改的值，可以在进行更改时选择 “Issue Controller Reset”（发
出控制器重置命令）复选框，或在稍后通过 “Controller Maintenance”（控制器维
护）窗口重置控制器 （请参阅第 136 页的 “重置控制器”。）。如果做出多个更改，可
能不想在每次更改后便停止并重置控制器。如果没有选择 “Issue Controller Reset”
（发出控制器重置命令）复选框，并且更改要求进行重置，则当单击 “OK”（确定）
时，系统会显示警告消息：

1. 选择 “Issue Controller Reset”（发出控制器重置命令）复选框。

2. 进行更改，然后单击 “OK”（确定）。

或者

1. 不选择 “Issue Controller Reset”（发出控制器重置命令）复选框。

2. 进行更改，然后单击 “OK”（确定）。

3. 稍后按照第 136 页的 “重置控制器”中的说明重置控制器

Channel 选项卡

1. 从  Channel Settings 选项卡，选择要编辑的通道。

2. 单击 Change Settings。

Change Channel Settings 窗口显示。对于要识别阵列的服务器，主通道必须拥有一个
已指定给逻辑驱动器的 ID 和映射至该主通道和 ID 的逻辑驱动器。该窗口使您可以配
置主机 / 驱动器通道。
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3. 从 Channel Mode 列表框中选择 Host 或 Drive。 

Drive 通道是驱动器要连接的对象（内部或外部）。Host 通道是连接到服务器的对象。

注 － 根据控制器配置的不同，可能需要按照以下步骤说明选择主通道 ID 和辅助通道 
ID。

4. 从 Available SCSI IDs 列表框，首先选择主通道 ID，其标识为 PID。然后单击 Add 
PID。

5. 如果您安装有两个控制器，则从 Available SCSI IDs  列表框选择辅助通道 ID，然后
单击 Add SID。

6. 要使更改生效，请重置控制器。
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在 Fibre 配置中更改主机 ID

1. 如果希望 ID 高于 15，单击 Select SCSI ID Range 并选择需要的范围。 

注 － 每个通道的 ID 必须在同一范围内。

2. 单击 Remove 以删除 PID 或 SID。

3. 做出选择后，单击 OK 以重新显示上一个窗口。

RS 232 选项卡

1. 完成所有通道的设置后，从 Change Controller Parameters 窗口选择 RS 232 选项卡。

2. 选择所需的端口，单击  Change Settings。 

Change RS232 Port Settings 窗口显示。
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3. 选择包括 9600 默认设置在内的任一所需波特率，然后单击 OK，以回到上一个窗口。 

Cache 选项卡

优化

在 Cache 选项卡上，您可以选择逻辑驱动器的优化模式，该模式指定在阵列中的每个
驱动器上写入的数据量。Sequential I/O 表示大数据块 (128 KB)。Random I/O 表示小
数据块 (32 KB)。 

阵列使用的应用程序类型决定是使用 Random 还是 Sequential I/O。视频 / 图像处理
应用程序 I/O 大小可以是 128、 256、 512 KB，或最大为 1 MB，因此应用程序像读取
和写入大的顺序文件那样在驱动器上读取和写入数据。数据库 / 事务处理应用程序像在
小的随机访问的文件上那样在驱动器上读取和写入数据。

优化模式有两种限制：

■ 必须对阵列中的所有逻辑驱动器应用一种优化模式。

■ 在选择了优化模式并将数据写入逻辑驱动器之后，更改优化模式的唯一方法是将数
据备份到其他位置，删除驱动器的所有逻辑配置，用新的优化模式重新配置逻辑驱
动器，然后重新引导阵列。

注 － 优化用于 Sequential I/O 的逻辑驱动器所允许的最大大小是 2 TB。优化用于 
Random I/O 的逻辑驱动器所允许的最大大小是 512 GB。如果创建超过这些限制的逻
辑驱动器，系统将会显示错误消息。
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随机和顺序优化的磁盘最大数量和最大可用容量

您对随机优化或顺序优化的选择将会影响可包括在阵列中的磁盘的最大数量及逻辑驱动
器的最大可用容量。下表包括每个逻辑驱动器的磁盘的最大数量及逻辑驱动器的最大可
用容量。

注 － 如果使用一个阵列和两个扩展单元，最多可以有 8 个逻辑驱动器和 36 个磁盘。

注 － 如果使用 36 146 GB 的磁盘，则可能无法将所有磁盘用于数据。剩余的磁盘可被
用作备用磁盘。

表 11-1 对于 2U 阵列，每个逻辑驱动器的磁盘最大数量

磁盘容量 (GB)
RAID 5 
随机

RAID 5 顺
序

RAID 3 
随机

RAID 3 顺
序

RAID 1 
随机

RAID 1 顺
序

RAID 0 
随机

RAID 0 顺
序

36.2 14 31 14 31 28 36 14 36

73.4 7 28 7 28 12 30 6 27

146.8 4 14 4 14 6 26 3 13

表 11-2 对于 2U 阵列，每个逻辑驱动器的最大可用容量 (GB)

磁盘容量 RAID 5 
随机

RAID 5 顺
序

RAID 3 
随机

RAID 3 顺
序

RAID 1 
随机

RAID 1 顺
序

RAID 0 
随机

RAID 0 顺
序

36.2 471 1086 471 1086 507 543 507 1122

73.4 440 1982 440 1982 440 1101 440 1982

146.8 440 1908 440 1908 440 1908 440 1908
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回写高速缓存

回写高速缓存是一项高速缓存写策略，控制器接收将写入磁盘的数据，将数据存储在内
存缓冲区中，并立即向主机操作环境发送信号，表示写操作已完成，不必等待数据实际
写入磁盘驱动器。回写高速缓存提高了写操作的性能和控制器卡的吞吐量。直写是一项
高速缓存写策略，控制器将数据写入磁盘驱动器，然后向主机操作环境发送信号，表示
写操作已完成。直写的写操作性能较低，如果有可能发生电源故障，那么使用直写会更
安全。由于安装了电池模块，对缓存在内存中的数据提供了电量，当电源恢复后，可以
完成缓存的写操作。

1. 从 Change Controller Parameters 窗口，选择 Cache 选项卡。

2. 从列表框选择 “Optimization”（优化）或接受当前的设置。

3. 要指定 Write Back 高速缓存，单击列表框并选择 Enabled。

如果 Write Back 被禁用， Write-Through 是选定的高速缓存写策略。

4. 要使更改生效，请重置控制器。
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Disk Array 选项卡

1. 从 Change Controller Parameters  窗口，选择 Disk Array 选项卡。 

2. 从三个 Write Verify 列表框选择 Disabled 或 Enabled。

通常，当硬盘驱动器写数据时可能会发生错误。要避免写错误，控制器能够强制硬盘驱
动器验证写入的数据。

■ Write Verify on Initialization - 初始化逻辑驱动器时，执行写后验证。

■ Write Verify on Rebuild （重建时进行写验证） - 在重建过程中，执行写后验证。

■ Write Verify on Normal（在常规期间进行写验证） - 在常规 I/O 请求期间，执行写
后验证。

3. 从 Rebuild Priority 列表框中的四个可用选项中进行选择：Low、 Normal、
Improved 或 High。

该 RAID 控制器提供了后台重建能力。这意味着控制器可以在重建逻辑驱动器时实现其
它 I/O 请求。重建驱动器集要求的时间很大程序上取决于要重建的逻辑驱动器的总容
量。另外，重建过程对于主机计算机和操作环境来是完全透明的。

■ Low （低） - 默认值，使用控制器的最小资源完成重建

■ Normal （正常） - 加快重建过程

■ Improved （提高） - 为重建过程分配更多的资源

■ High （高） - 使用控制器的最大资源在最短时间内完成重建过程
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Drive I/F 选项卡

1. 从 Change Controller Parameters 窗口，选择 Drive I/F 选项卡。

2. 从 SCSI Motor Spin Up 字段，选择 Disabled  或 Enabled。

SCSI Motor Spin Up 说明如何启动磁盘阵列中的 SCSI 驱动器。当电源无法向同时通电
启动的硬盘驱动器和控制器提供足够的电流时，将各个硬盘驱动器顺序启动是耗费较低
启动电流的最佳方法之一。在默认情况下，通电时所有硬盘驱动器都起速。 

3. 从 Power Up SCSI Reset 字段，选择 Enabled 或 Disabled。

默认情况下，控制器通电时，会将 SCSI 总线重置命令发送到 SCSI 总线。如果禁用，
在下一次通电时不发送 SCSI 总线重置命令。

在将双主机计算机连接到同一 SCSI 总线时，SCSI 总线重置将中断所有正在执行的读 /
写请求。这可能会造成某些操作环境或主机计算机运行异常。通电时禁用 Power Up 
SCSI Reset 可以避免该情况发生。

4. 设置 Disk Access Latency。

本功能设定了在通电后控制器试图访问硬盘驱动器前的延迟时间。默认值为 15 秒钟。
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5. 设置 Tag Count Per drive。

这是同时可发送到每个驱动器的标记的最大数目。驱动器具有内置高速缓存，用于对发
送给驱动器的所有 I/O 请求 （标记）进行排序，从而让驱动器能够更快地完成这些请
求。

缓存大小和标记的最大数量根据驱动器品牌和型号不同而有所差别。使用默认设置 32。
将最大标记数更改为 Disable 会引起驱动器内部缓存被忽略 （不使用）。

控制器支持标记命令队列，可调整标记计数为 1 到 128。

6. 从 SAF-TE Polling Period (Sec) 字段，选择列表框中显示的可变时间选项，或者选择 
0.0 来禁用该功能，以便从不对所有已安装的事件记录模块 (ERM) 进行轮询。

7. 从 SCSI I/O Timeout (Sec) 字段，选择 0.5 到 10 秒之间的一个值。

SCSI I/O Timeout 是控制器等待驱动器响应的时间间隔。如果控制器试图从驱动器读
取数据或将数据写入驱动器，但驱动器在 SCSI I/O 超时值范围内没有响应，则被认为
是故障驱动器。

“SCSI I/O Timeout”（SCSI I/O 超时）的默认设置为 30 秒 （对于光纤通道）和 15 
秒 （对于 SCSI）。不要更改这个设置如果将超时设置为较低的值，会导致驱动器仍在
重新尝试或无法仲裁 SCSI 总线时，控制器将驱动器判断为发生故障。将超时设置为较
高的值，会导致控制器持续等待某一驱动器，而这有时会引起主机超时。

如果在从驱动器盘片上读取数据时，驱动器检测到介质错误，会再次尝次前一读取操作
或再校准磁头。当驱动器遇到介质上的坏块时，会将坏块重新分配给同一磁盘驱动器上
的另一个空闲块。但是，这些操作都会花费时间。根据驱动器品牌和型号的不同执行这
些操作的时间有所差别。

在 SCSI 总线仲裁期间，具有更高优先级的设备可以先使用总线。当更高优先级的设备
持续使用总线时，较低优先级的设备有时会接收到 SCSI I/O Timeout。

8. 从 Drive Check Period (Sec) 字段，选择 0.5 到 30 秒之间的一个值。

Periodic Drive Check Time 是控制器用来检查 SCSI 总线上驱动器的时间间隔，默认值
为 Disabled，该项意味着如果总线上没有活动，控制器无法知道驱动器是否发生故障
或者已删除。设置一个间隔，使得程序在没有任何阵列活动时探测驱动器故障；但是性
能会因此而降低。
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Host I/F 选项卡

1. 从 Change Controller Parameters 窗口，选择 Host I/F 选项卡。

2. 设置 Max Queued IO Count。 

此功能允许用户从主机计算机以字节为单位配置控制器可接受的 I/O 队列的最大大小。
默认值为 256。预定义范围为 1 至 1024 个字节，也可以选择 Auto Computer （自动配
置）模式。

3. 设置 LUNs Per Host。

此功能用于改变每个主机 SCSI ID 的 LUN 数量。默认设置为 32 个 LUN ；预定义的可
用 LUN 范围为 1 至 32 个。

4. 要使更改生效，请重置控制器。
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Redundancy 选项卡

1. 从 Change Controller Parameters 窗口，选择 Redundancy 选项卡。 

显示三个只读字段：Controller Configuration、Controller Status 和 Secondary Serial 
No。

2. 从 “Set Controller Config”（设置控制器配置）字段选择一个选项。 

■ Redundant Deassert Reset （冗余取消重置） - 如果已经有一个控制器发生故障，想
让其重新联机。

■ Redundant Force Sec Fail － 如果要强制辅助控制器失效。

■ Redundant Force Pri Fail － 如果要强制主控制器失效。
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注 － 须将两个控制器都设置成 Redundant Primary （冗余主要）配置。然后控制器
决定主控制器和辅助控制器。这避免了控制器间的可能发生的冲突。

3. 要使更改生效，请重置控制器。

4. 单击 “Close”（关闭）返回到主窗口。

Network 选项卡

1. 从 Change Controller Parameters 窗口选择 Network  选项卡。

2. 要手动配置 IP 地址、子网掩码或网关地址，单击 Change Settings。

3. 如果已在 DHCP/RARP 服务器环境中安装了阵列，可以选择 Enable Dynamic IP 
Assignment，从而允许阵列自动从网络获得 IP 地址。 
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▼ 将控制器蜂鸣器静音

当引起控制器发出蜂鸣声的事件发生时 （例如逻辑驱动器故障、重建期间或者添加 
SCSI 驱动器），您可以将蜂鸣器静音。可以使用以下两个方法中的一个。

1. 在主窗口选择所需的控制器图标。 

2. 选择 Array Administration → Controller Maintenance。

3. 如果还没有作为 ssconfig 登录，会显示密码提示；键入 ssconfig 密码。 

Controller Maintenance Options 菜单显示。

4. 单击 Mute Controller Beeper。

或者

1. 在主窗口选择所需的控制器图标。 

2. 选择 Configuration → Custom Configure。

3. 选择 Change Controller Parameters。

4. 选择 Mute Beeper。
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▼ 指定或更改备用驱动器

在容错 （非 RAID 0）逻辑驱动器中的物理驱动器发生故障后，备用驱动器可用于支持
自动数据重建。如果备用驱动器要替代另一个驱动器，其大小必须与故障驱动器的大小
至少相等，而且与故障磁盘相关的所有逻辑驱动器都必须是冗余的 (RAID 1,3,5 or 
1+0)。

用户可使用该功能指定一个全局或本地备用驱动器，也可将一个可用驱动器的状态更改
为备用或将一个备用驱动器的状态更改为可用。如现有驱动器成员故障，指定为全局备
用的驱动器将进行重建。可将一个或多个备用驱动器与阵列控制器相关。本地备用驱动
器必须被指定到一个特定逻辑驱动器，且仅用于该逻辑驱动器成员的重建。

1. 在主窗口中，选择所需的阵列控制器。

2. 选择 Configuration → Custom Configure 或者单击 Custom Configuration 工具。

如有必要，使用 ssconfig 密码登录到程序的配置级别。 Custom Configuration 
Options 窗口显示。

3. 从 Custom Configuration Options 窗口选择 Make or Change Standby Drives 。

Make or Change Standby Drives  窗口显示。

4. 检查窗口顶部的服务器和控制器 ID。

如果要选择一个不同的服务器或控制器，请单击 “Cancel”（取消）返回至主窗口，选
择正确的服务器，或从树状视图中选择控制器，重复步骤 2 和 3。

5. 选择要分配或更改的驱动器。

6. 通过选择 “Ready”（可用）、“Global StandBy”（全局备用）或 “StandBy for 
LD#”（备用 LD#）（本地），可更改或指定驱动器状态。
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7. 单击修改。

8. 单击 Apply，然后单击 Close。

9. 无论何时对配置做出更改，将新配置保存到文件。（要获得有关详细信息，请参阅第 79 
页的 “配置文件”。） 

可用服务器
用户有时可能需要从 Server List Setup 窗口的 Available 或 Managed Servers 列表编
辑或删除条目。

▼ 编辑服务器条目

1. 选择 File （文件） → Server List Setup （服务器列表设置）。 Server Setup （服务器
设置）窗口显示。 

如有必要，将服务器名称从 Managed Servers （受管理的服务器） 列表中移到 Server 
List Setup （服务器列表设置） 窗口的 Available Servers （可用服务器）列表中。注
意，仅可以编辑 Available Servers （可用服务器）列表中的服务器条目。

 

2. 在 Available Servers 列表中选择服务器的名称，然后单击 Edit。 

Edit Server 窗口显示。 
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3. 进行必要的更改。单击 OK 对更改进行登记。

要获得窗口中的字段说明，请参阅第 39 页的 “添加服务器”。 Add Server 和 Edit 
Server 窗口包含相同的字段。 

IP Address 快捷方式：如果网络地址已更改，单击 Get IP Addr by Name。如果您键
入了网络使用的名称服务所记录的服务器名称，该程序将搜索并显示正确的 IP 地址。 

如果服务器使用的名称与服务器的网络名称不同，或者命名服务尚未更新，应删除该服
务器后重新添加。

4. 将服务器名称移回 Managed Servers 列表。

5. 单击 OK 以退出 Edit Server 窗口。
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附录 A

RAID 基本知识

本附录提供有关 RAID 的背景信息，其中概述了 RAID 术语和 RAID 级别。包括以下
主题：

■ 第 179 页的 “RAID 术语概述”
■ 第 185 页的 “RAID 级别”
■ 第 191 页的 “本地和全局备用驱动器”

RAID 术语概述
独立磁盘的冗余阵列 (RAID) 是一种用于改进存储系统处理能力的存储技术。这一技术
旨在为磁盘阵列系统提供可靠性，并利用由多磁盘组成的阵列所提供的性能优势，而这
些优势是单磁盘存储器所不具备的。

RAID 的两个主要基本概念是： 

■ 将数据分布在多个硬盘驱动器中可以提高性能。

■ 正确使用多个驱动器可在任一驱动器出现故障时确保不会造成数据丢失或系统停机。

在出现磁盘故障的情况下，磁盘访问可正常进行，而且主机系统不会察觉到这一故障。
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逻辑驱动器

逻辑驱动器是一列独立的物理驱动器。通过创建逻辑驱动器，可用性、容量及性能均得
到提高。逻辑驱动器在主机上的显示与本地硬盘驱动器相同。 

图 A-1 逻辑驱动器包括多个物理驱动器

逻辑卷

逻辑卷由两个或者两个以上的逻辑驱动器组成。逻辑卷最多可划分为 32 个分区（对于 
SCSI）或 128 个分区 （对于光纤通道）。操作期间，主机将未分区的逻辑卷或逻辑卷
上的分区作为单个物理驱动器对待。

本地备用驱动器

本地备用驱动器是分配用于指定的逻辑驱动器的备用驱动器。当指定逻辑驱动器的某一
成员驱动器发生故障时，本地备用驱动器将成为成员驱动器并自动开始重建。

全局备用驱动器

全局备用驱动器不单只为一个指定的逻辑驱动器服务。当任一逻辑驱动器中的一个成员
驱动器发生故障时，全局备用驱动器将加入该逻辑驱动器，并自动开始重建。

SCSI 通道

当 Wide 功能被启用（16 位 SCSI）时， SCSI 通道 （SCSI 总线）最多可连接 15 个设
备 （不包括控制器本身）。在一个环路中，光纤通道最多可连接 125 个设备。每个设备
有一个唯一 SCSI ID。
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图 A-2 阐释了这一概念。如果将文档存放到文件柜中，必须先将文档置于其中一个抽
屉里。从 SCSI 的观点来看， SCSI ID 类似于文件柜，抽屉就是 LUN （逻辑单位）。每
个 SCSI ID 最多允许 32 个 LUN。数据可以存储在 SCSI ID 的一个 LUN 中。大多数 
SCSI 主机适配器将 LUN 看作另一个 SCSI 设备。

图 A-2 SCSI ID/LUN

逻辑驱动器由一组 SCSI 或者光纤通道驱动器组成。在一个逻辑驱动器中的物理驱动器
不必来自同一个 SCSI 通道。同样，每一个逻辑驱动器可配置为不同的 RAID 级别。
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可将驱动器作为本地备用驱动器分配给一个指定的逻辑驱动器，或者作为全局备用驱动
器。备用驱动器不能用于没有数据冗余的逻辑驱动器 (RAID 0)。 

图 A-3 逻辑驱动器配置中的驱动器分配

驱动器通道 0

逻辑驱动器 1

全局备用驱动器 LD1 的本地备用驱动器

逻辑驱动器 0

驱动器通道 1

4
GB

4
GB

2
GB

2
GB

4
GB

4
GB

2
GB

2
GB

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
8 GB

RAID 3
6 GB
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可以将逻辑驱动器或者逻辑卷分为几个分区，或者将整个逻辑驱动器用作一个单独的分
区。

图 A-4 逻辑驱动器配置中的分区

逻辑驱动器 0

RAID 5 (8 GB)

逻辑驱动器 1

RAID 3 (6 GB)

分区 0 2 GB

分区 1 1 GB

分区 2 5 GB

分区 0 2.5 GB

分区 1 1.5 GB

分区 2 2 GB
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每一个分区映射到主机 SCSI ID 下或者主机通道 ID 上的 LUN。每个 SCSI ID/LUN 对
于主机来说，相当于一个独立的硬盘驱动器。

图 A-5 将分区映射到主机 ID/LUN

图 A-6 将分区映射到 ID 下的 LUN

ID 0 ID 1

LUN 0 LUN 0

LUN 1 LUN 1

LUN 2 LUN 2

逻辑驱动器 1
分区 0

逻辑驱动器 0
分区 1

逻辑驱动器 1
分区 2

逻辑驱动器 0
分区 2

逻辑驱动器 1
分区 1

逻辑驱动器 0
分区 0

2.5 GB

1 GB

5 GB

1.5 GB

2 GB

2.5 GB

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

逻辑驱动器 0 逻辑驱动器 1

主机 SCSI 通道

逻辑驱动器 1

逻辑驱动器 1
分区 0

逻辑驱动器 0
分区 2

逻辑驱动器 0
分区 0

分区 1分区 1 分区 2

4.5 GB 5 GB 2 GB

1 GB 1.5 GB 2 GB
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RAID 级别
通过镜像、带区化、双工和奇偶校验技术的组合，可以使用几种不同的方法实现 RAID 
阵列。这些不同的技术被称为 RAID 级别。每个级别提供不同的性能、可靠性和成本的
组合。每个级别使用不同的算法实现容错功能。

有以下几种 RAID 级别可供选择：RAID 0、 1、 3、 5、 1+0、 3+0 (30) 和 5+0 (50)。
RAID 级别 1、 3 和 5 是最常用的级别。

下表简要概述了 RAID 级别。 

容量 指可用于数据存储的物理驱动器的总数 (N)。例如，如果容量是 N-1，而逻辑驱动
器中共有 6 个 36 MB 的磁盘驱动器，则可用于存储的磁盘空间等于 5 个磁盘驱动器的
容量 （5 x 36 MB 或 180 MB）。 -1 指的是在 6 个驱动器上进行带区化的数量，带区化
提供了数据冗余，等于其中一个磁盘驱动器的大小。 

对于 RAID 3+0 (30) 和 5+0 (50)，容量 是在物理驱动器总数 (N) 的基础上，针对卷中每
个逻辑驱动器中减去一个物理驱动器 (#)。例如，如果逻辑驱动器中共有 20 个 36 MB 
的磁盘驱动器，并且逻辑驱动器的总数为 2，则可用于存储的磁盘空间为 18 个磁盘驱
动器的容量 ó 18 x 36 MB (648 MB)。

表 A-1 RAID 级别概述

RAID 撰梗 说明 支持的驱动器的数量 容量 冗余

0 带区化 2ñ36 N 否

1 镜像 2 N/2 是

1+0 镜像和带区化 4-36 （只能为偶数） N/2 是

3 带有专用奇偶校验

的带区化

3ñ31 N-1 是

5 带有分布式奇偶校

验的带区化

3ñ31 N-1 是

3+0 (30) RAID 3 逻辑驱动器

的带区化

2 至 8 个逻辑驱动器 N-# 个
逻辑驱
动器

是

5+0 (50) RAID 5 逻辑驱动器
的带区化

2 至 8 个逻辑驱动器 N-# 个
逻辑驱

动器

是
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RAID 0
RAID 0 实现数据块带区化，其中数据被分成多个逻辑数据块，并在多个驱动器上进行
带区化。与其他 RAID 级别不同，此级别不提供数据冗余。如果发生磁盘故障，数据将
丢失。

在数据块带区化中，总磁盘容量等于阵列中所有驱动器的容量的总和。这个驱动器组合
将被系统视为单个逻辑驱动器。

RAID 0 提供了最高的性能。由于能够同时向 / 从阵列中的每个磁盘传输数据，RAID 0 
的速度很快。此外，对不同驱动器的读 / 写操作能够同时进行。

图 A-7 RAID 0 配置

RAID 1
RAID 1 实现了磁盘镜像，其中同一数据的副本被记录在两个驱动器上。通过在不同磁
盘上保存数据的两个副本，能够在磁盘故障的情况下保护数据。如果在任意时刻，
RAID 1 阵列中的一个磁盘发生故障，余下的无故障磁盘 （副本）能提供所需的所有数
据，因而不会造成停机。

在磁盘镜像中，总的未用容量等于 RAID 1 阵列中的一个驱动器的容量。因此，将 2 个
容量为 1 GB 的驱动器组合起来就可以创建一个总可用容量为 1 GB 的逻辑驱动器。这
个驱动器组合将被系统视为单个逻辑驱动器。

注 － RAID 1 不允许扩展。 RAID 级别 3 和 5 允许扩展，方法是向现有阵列中添加驱
动器。

逻辑驱动器

物理磁盘

带区化

数据块 1

数据块 2

数据块 3

数据块 5

数据块 7

数据块 1数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 4

数据块 6

数据块 8

数据块 2
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图 A-8 RAID 1 配置

RAID 1 除了提供数据保护以外，这种 RAID 级别还提高了性能。当发生多个并发 I/O 
操作时，这些 I/O 可以分布到磁盘副本中进行，从而减少了总的有效数据访问时间。

逻辑驱动器

物理磁盘

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 2

数据块 3

数据块 4

数据块 1

数据块 2

数据块 3

数据块 4

数据块 1
镜像
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RAID 1+0

RAID 1+0 是 RAID 0 和 RAID 1 的组合，可以提供镜像和磁盘带区化。使用 RAID 
1+0 可以节省大量的时间，只需一步就可以将大量的磁盘配置为相互镜像。这并不是可
供选择的标准 RAID 级别选项；它不会出现在控制器所支持的 RAID 级别选项的列表
中。如果为一个 RAID 1 逻辑驱动器选择四个或更多的磁盘驱动器，系统就会自动执行 
RAID 1+0。

图 A-9 RAID 1+0 配置

物理磁盘

镜像

带区化

镜像

逻辑驱动器

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 2

数据块 3

数据块 4

数据块 1

数据块 2

数据块 3

数据块 4

数据块 1

数据块 6

数据块 7

数据块 8

数据块 5

数据块 6

数据块 7

数据块 8

数据块 5
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RAID 3
RAID 3 实现了带有专用奇偶校验的数据块带区化。此 RAID 级别将数据分成多个逻辑
数据块 （磁盘数据块的大小），然后在多个驱动器上对这些数据块带区化。一个驱动器
专用于奇偶校验。如果磁盘发生故障，可以使用奇偶校验信息和其余磁盘上的信息对原
始数据进行重构。

在 RAID 3 中，磁盘总容量等于组合中所有驱动器容量的总和减去奇偶校验驱动器的容
量。因此，将 4 个容量为 1 GB 的驱动器组合起来就可以创建总可用容量为 3 GB 的逻
辑驱动器。这个组合将被系统视为单个逻辑驱动器。

当以小数据块读取或者按顺序读取数据时， RAID 3 可以提高数据的传输速率。但是，
在没有跨越每个驱动器的写操作中，性能会降低，这是因为在每次写入新数据时，都要
重新计算和写入存储在奇偶校验驱动器中的信息，因此限制了并行的 I/O 操作。

图 A-10 RAID 3 配置

RAID 5
RAID 5 实现了带有分布式奇偶校验的多数据块带区化。此 RAID 级别使用分布在阵列
中所有磁盘上的奇偶校验信息提供冗余。数据及其奇偶校验信息从不存储于同一磁盘
上。如果磁盘发生故障，可以使用奇偶校验信息和其余磁盘上的信息对原始数据进行重
构。

逻辑驱动器

数据块 1

数据块 2

数据块 3

数据块 1
带区化

奇偶校验 (1.2)

奇偶校验 (3.4)

物理磁盘

专用奇偶校验

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 7

数据块 5

数据块 4

数据块 2

数据块 8

数据块 6 奇偶校验 (5.6)

奇偶校验 (7.8)
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图 A-11 RAID 5 配置

RAID 5 可以提高以大数据块或随机方式访问数据时的数据传输率，并减少存在大量并
行 I/O 时的数据访问时间。

高级 RAID 级别

高级 RAID 级别需要使用阵列内置的卷管理器。这些组合 RAID 级别可以提供 RAID 
1、3 或 5 的数据保护优势，同时又能提供 RAID 1 的性能。要使用高级 RAID，首先创
建两个或更多 RAID 1、 3 或 5 阵列，然后将它们组合起来。下表提供了高级 RAID 级
别的说明。

表 A-2 高级 RAID 级别

RAID 撰梗 说明

RAID 3+0 (30) 使用阵列的内置卷管理器连接在一起的 RAID 3 逻辑驱动器。

RAID 5+0 (50) 使用阵列的卷管理器连接在一起的 RAID 5 逻辑驱动器。

逻辑驱动器 物理磁盘

带区化 + 非专用奇偶校验

数据块 1

数据块 2

数据块 3

数据块 4

数据块 5

数据块 6

数据块 7

数据块 8

数据块 4

数据块 1

数据块 7

奇偶校验 (5.6)

奇偶校验 (3.4)

数据块 2

数据块 8

数据块 5

奇偶校验 (3.4)

数据块 3

数据块 6

奇偶校验 (7.8)
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本地和全局备用驱动器
外部 RAID 控制器提供本地备用驱动器和全局备用驱动器功能。本地备用驱动器仅用于
一个指定的驱动器，而全局备用驱动器可以用于阵列上的任何逻辑驱动器。 

本地备用驱动器的优先级始终高于全局备用驱动器。因此，如果某个驱动器出现故障，
而且本地和全局备用驱动器同时都可用，或者替换故障驱动器需要较大的空间，系统就
会使用本地备用驱动器。

如果 RAID 5 逻辑驱动器中有故障驱动器，将用新的驱动器更换故障驱动器，以使逻辑
驱动器继续工作。要确定故障驱动器，请参考适用于您的阵列的 Sun StorEdge 3000 
Family RAID Firmware User's Guide。

警告 － 如果在试图拆卸故障驱动器时错误地卸下了另一个驱动器，则无法继续访问该
逻辑驱动器，因为您已错误地使另一个驱动器发生了故障。

本地备用驱动器是分配用于指定的逻辑驱动器的备用驱动器。当指定的逻辑驱动器的某
一成员驱动器发生故障时，本地备用驱动器成为成员驱动器，自动开始重建。

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

图 A-12 本地 （专用）备用驱动器

全局备用驱动器可用于所有的逻辑驱动器，而不是只用于一个逻辑驱动器 （请参阅
图 A-13）。当任一逻辑驱动器中的成员驱动器发生故障时，全局备用驱动器将加入该逻
辑驱动器工作，自动开始重建。

本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

本地备用驱动器
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图 A-13 全局备用驱动器

同时拥有本地和全局备用驱动器

在图 A-14 中，逻辑驱动器 0 中的成员驱动器是容量为 9 GB 的驱动器，而逻辑驱动器 
1 和 2 中的成员都是容量为 4 GB 的驱动器。 

图 A-14 混合本地和全局备用驱动器

逻辑驱动器 0

全局备用驱动器

逻辑驱动器 1 逻辑驱动器 2

全局备用驱动器

本地备用驱动器 全局备用驱动器

(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

逻辑驱动器 0 逻辑驱动器 1 逻辑驱动器 2

(9GB)
(4GB)

(4GB)(4GB)
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本地备用驱动器始终具有比全局备用驱动器更高的优先级；因此，如果某个驱动器发生
故障时本地备用驱动器和全局备用驱动器同时存在，则将使用本地备用驱动器。 

在图 A-14 中，容量为 4 GB 的全局备用驱动器由于容量不足而不可能加入到逻辑驱动
器 0 中。如果逻辑驱动器 0 中的驱动器发生故障，则容量为 9 GB 的本地备用驱动器可
以提供帮助。如果故障驱动器位于逻辑驱动器 1 或 2 中，则使用容量为 4 GB 的全局备
用驱动器可以立即提供帮助。
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附录 B

监控 JBOD （仅用于 SCSI）

本附录仅说明如何监控以及将固件下载到仅用于 Sun StorEdge 3310 SCSI 阵列的独立 
JBOD。注意， JBOD 并不支持所有的阵列功能。本附录包含以下步骤：

■ 第 195 页的 “启用 JBOD 支持”
■ 第 197 页的 “查看组件和警报特性”
■ 第 198 页的 “升级硬盘驱动器上的固件”
■ 第 199 页的 “升级 SAF-TE 设备的固件”
■ 第 200 页的 “更换故障驱动器”

▼ 启用 JBOD 支持

要对 JBOD 的外围设备状况和事件进行监控，必须首先启用 JBOD 支持。 

1. 选择 View → Agent Options Management。 

Agent Options Management 窗口显示。

2. 选择 Enable JBOD Support 复选框。

3. 要在主窗口中立刻显示 JBOD，必须探测新的库存。选择 View → View Server 并单击 
Probe。

4. 单击 OK。 

JBOD 就会显示在主窗口中。

在单总线配置中， JBOD 的两个端口均连接到服务器上的一个 HBA，如下例所示。
 195



在双总线配置中，每个端口连接到各自的 HBA，如下例所示。

注 － 在双总线配置中，如果每个端口连接到不同的服务器，则该程序只能从连接到端
口 B 的服务器对 JBOD 进行监控。
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▼ 查看组件和警报特性

View Enclosure 窗口显示 JBOD 的组件和警报特性。

1. 选择 EMU (SCSI) 或 SES （光纤通道）图标 。

2. 选择 View → View Enclosure。

要显示 FRU ID 信息，请单击 View FRU。
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下载用于设备的固件
该选项用于升级 JBOD 上的硬盘驱动器和 SAF-TE 设备上的固件。

▼ 升级硬盘驱动器上的固件

1. 选择任一 JBOD 组件。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for Disks 选项卡。

4. 从 Available Disks 选择要从其下载新固件的驱动器，然后单击 Add。

如果有要删除的逻辑驱动器，从 Selected Disks  将其选中并单击 Remove。

5. 单击 Browse 并找到下载固件文件。将其选中，单击 Open，然后单击 OK。

开始下载固件。

6. 当下载进程显示为 100% 时，单击 OK。

7. 要更新该程序，请选择 “View”（查看） → “View Server”（查看服务器）。
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8. 单击 Probe，然后单击 OK。

9. 要验证固件是否已成功下载，选择 View → View Physical Drive，确保在 Product 
Revision 字段中的固件版本已更改。

▼ 升级 SAF-TE 设备的固件

1. 选择任一 JBOD 组件。

2. 选择 Array Administration → Download FW for Devices。

3. 单击 Download FW for SAFTE Devices 选项卡。

4. 要添加设备，可以从 Available SAF-TE Devices 中选择设备，并单击 Add。

要删除设备，可以从 Selected SAF-TE Devices 中选择设备，并单击 Remove。

5. 单击 Browse 并找到下载固件文件。将其选中，单击 Open，然后单击 OK。 

开始下载固件。

大约在进行到 70% 的时候，阵列开始发出蜂鸣声，并且 LED 开始闪烁。

6. 当下载进程显示为 100% 时，单击 OK。

7. 要更新该程序，请选择 “View”（查看） → “View Server”（查看服务器），然后单
击 “Probe”（探测）。
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8. 单击 OK。

9. 要验证固件是否已成功下载，选择 View → View Enclosure，确保在 Firmware Rev  
字段中的固件版本已更改。

▼ 更换故障驱动器

一个红色的设备状态符号指示驱动器故障 。在更换故障驱动器后，执行下列步骤： 

Solaris 操作环境

1. 如果驱动器自动返回联机状态 （即红色设备状态符号消失），则运行命令 

2. 运行命令

3. 如果驱动器没有自动返回联机状态 （即红色设备状态符号没有消失），则通过执行下面
的命令，进行重新配置重新引导：

Windows NT/2000 操作系统

1. 根据 Sun StorEdge 3000 系列安装，操作和维护手册 中的操作说明为阵列安装新的驱动
器。

2. 选择 View → View Server，然后单击 Rescan。

3. 要验证该程序是否识别新驱动器，请在主窗口中选择该驱动器。

4. 选择 View → View Physical Drive，然后验证该信息。

# devfsadm

# format

# reboot -- -r
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附录 C

使用群集配置 （仅限 SCSI）

对于 Sun StorEdge 3310 SCSI 阵列，如果使用 Windows NT， Sun StorEdge 
Configuration Service 可监控共享的 SCSI 存储。本节包含以下主题：

■ 第 201 页的 “规划群集配置”
■ 第 202 页的 “群集配置要求”

■ 第 202 页的 “设置群集配置”
■ 第 202 页的 “设置群集配置”

首先，群集配置必须与适当的硬件一起配置，另外，要求具备 Service Pack 3 或 4 的 
Windows NT Server、 Enterprise Edition 和 Microsoft Cluster Server (MSCS) 软件。

如果准备设置群集配置，请务必阅读本章。

规划群集配置
在设置群集配置前，必须确定所需的配置类型，因为它决定了存储设备的初始配置方式。

有两种主要群集配置类型： 

■ 热备用服务器群集，该处的全部 LUN 都属于群集上两台服务器的其中一台。如果拥
有 LUN 的服务器发生故障，则 LUN 移交至第二台服务器，该服务器在此之前闲
置。该配置要求最少两个 LUN。

■ 负载平衡群集，该处某些 LUN 在一台服务器上维护，某些 LUN 在另一台服务器上
维护。两台服务器同时处理数据，但是它们在不同 LUN 上处理 I/O。 

必须最少定义三个 LUN。这允许建立一个小的 LUN 用于仲裁磁盘使用，建立一个大
的 LUN 以在群集上的每一台服务器上使用。万一服务器发生故障，仲裁磁盘维护恢复
群集必需的配置数据。
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群集配置要求
在安装 MSCS 软件时，识别作为仲载磁盘使用的磁盘，该磁盘维护群集信息。

在群集配置中，该程序同一时间仅在一台服务器上运行，即有仲裁磁盘的服务器。如果
运行 Sun StorEdge Configuration Service 的服务器发生故障，Cluster Administrator 
会自动将第一台服务器的磁盘负载转移到第二台服务器，并在第二台服务器上启动服
务。

在双服务器的群集配置中，群集本身具有自己的 IP 地址，并成为 “Managed Server”
（受管服务器）列表中的受管服务器。设置群集的过程中，最后一步是将群集添加到
“Managed Servers”（受管服务器）列表中。

▼ 设置群集配置

以下是在一个配置有两台主服务器的群集上设置阵列所需的步骤概述。

1. 设置服务器。

a. 设置两台服务器，每一台具有 PCI 总线和一个引导磁盘，而不是共享 SCSI 存储的
一部分。

b. 在每台服务器上安装主机适配器卡 （如 Ultra-Wide、差分主机适配卡）并为共享 
SCSI 总线上的每个主机适配器设置唯一的 SI ID。

c. 在每台服务器上安装两个网络适配卡。

d. 在每台服务器的引导磁盘上安装 Windows NT Server、Enterprise Edition 软件和 
Windows NT Service Pack 3 或者更高版本。

2. 安装双活动 / 活动存储子系统，且将其连接到两个主机适配器。 

参考提供的文档，可以获得安装步骤。

3. 在每台服务器上安装代理。 

a. 请先停止服务器上的这些服务，然后在其它服务器上安装这些服务。 

b. 确保该服务已在服务器上运行，且该服务器可访问已映射到逻辑驱动器 （已分配给
主控制器）的主机 LUN。

c. 查阅有关的安装章节，获得安装代理的具体步骤。 

安装代理后，不需要重新引导。但是，一旦安装了代理，请确保在其中一台服务器
上停止这些服务。
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注 － 以下几个步骤中，将如示例所示只用一台服务器。

4. 安装控制台软件。

可以在其中一台服务器或服务器所在网络的任一计算机上安装控制台。该程序使您可以
远程配置和监控阵列。查阅有关安装章节，可获得具体安装步骤。

5. 将已经启动服务的服务器添加到控制台的 “Managed Servers”（受管服务器）列表中
（请参阅第 39 页的 “添加服务器”）。 

确保选择 Auto Discovery 并添加 ssmon密码。

6. 使用控制台软件验证和配置活动服务器上的存储器，然后重新引导该服务器。

存储阵列可能在双活动 - 活动存储子系统上已预先配置。您需要在树视图中查看配置，
以确定阵列是否已经预先配置。

如果存储未配置或者希望更改配置，可在一台服务器上配置所有 LUN。然后，安装 
MSCS 软件后，可以使用 Cluster Administrator 在两台服务器间分配存储设备。

7. 使用 NT Disk Administrator 在活动服务器上创建分区并格式化 LUN。 

a. 如有必要，重新分配磁盘的驱动器号。 

注意必须以 NTFS 格式化分区。

Windows NT 将双活动 - 活动控制器上的 LUN 看作是在群集中的两台服务器上。可
以只在一台服务器上创建分区和逻辑驱动器。然后，安装 MSCS 后，可以使用 
Cluster Administrator 在两台服务器间分配存储设备。

用于两台服务器的共享 SCSI 存储设备的驱动器号必须相同。如果在两台服务器中只
有一台上有额外的 CD-ROM 或外部硬盘，可能需要为共享存储设备重新指定驱动器
号。完成此步骤后，检查另一台服务器上驱动器号以确保它们是相同的。

b. 写下指定给共享存储设备的驱动器号。

8. 访问第二台服务器，启动 Disk Administrator，确保第二台服务器的驱动器字母与第
一台服务器相同。 

如果驱动器号不相同，应重新分配驱动器号，以使它们在两台服务器上一致。

9. 关闭第二台服务器。

10. 在第一台服务器上安装 MSCS 软件，然后重新启动。 

11. 启动 Cluster Administrator，确保它可以看到群集。

12. 访问第二台服务器，通过将其连接到第一台服务器来安装 MSCS，然后重新启动。

13. 重新引导第二台服务器，在 Cluster Administrator 中验证这两台服务器都包括在群集
中。
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14. 在 Cluster Administrator 中调整磁盘组。 

确保仲裁磁盘和其它磁盘 （如果存在）全部都在最初配置存储设备的第一台服务器下
的一个磁盘组中。有关执行此步骤的详细信息，请参阅 MSCS 文档。

注 － 只要将两个 LUN 置于同一个磁盘组中，就会得到一个可删除的空磁盘组。

15. 将服务添加到第一台服务器上有仲裁磁盘的组。

a. 在两台服务器上，停止所有三个服务：Configuration Service Startup、
Configuration Service Monitor 和 Configuration Service Server，并将它们设置
为手动。

b. 使用 Cluster Administrator 将每个服务作为资源安装到具有仲裁磁盘的组。 

对于每个服务，按照如下的顺序输入它，并按照指定格式 （两个单词在一起）键入
该服务的名称。安装完毕每一服务后，将服务恢复联机以在活动服务器上启动服务。

输入服务，作为通用服务。将要求指出每一资源的相关性。组中的相关性如下：

■ 与仲裁磁盘相关的磁盘
■ 其它磁盘 （如果要添加到该组）
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup 依赖于已在组中的两个磁盘。 Configuration 
ServiceMonitor 依赖于 Configuration Service Startup， Configuration 
ServiceServer 依赖于 Configuration Service Monitor。

16. 要使两个群集服务器在群集 IP 地址下显示为一个图标，可编辑 CLUSTER.TXT。

该文件与控制台文件位于同一个目录下。位于安装控制台的计算机系统磁盘上。如果驱
动器 C 是系统磁盘，路径为：

C:\Program Files\Sun\sscs
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以下文字说明文件的内容：

17. 编辑文件最后一行，插入群集的 IP 地址，然后插入构成群集的两台服务器的 IP 地址。 

a. 删除数字符号 (#)。

18. 启动控制台且将第一台服务器从 “Managed Servers”（受管服务器）列表中删除，然
后将群集作为一台服务器添加到列表。

19. 访问 Server List Setup 功能。参阅第 39 页的 “添加服务器”。

确保选择 Auto Discovery  并添加 ssmon密码。如果键入群集名称，在网络具有 DNS 
的情况下，该程序会提供 IP 地址。

此时，群集已正确配置，能够与该程序一起工作。如果运行这些服务的服务器发生故
障，它的磁盘组会转移到第二台服务器，且 Cluster Administrator 会自动启动该服务
器上的这些服务。

注 － 如果一台服务器发生故障，在 15 分钟内群集图标由紫色改变为灰色，且可能在 
10 分钟后再改变为紫色。

如果希望某些运行在其它服务器上的存储设备具有负载平衡配置，必须使用 Cluster 
Administrator 将一个或多个磁盘组移至相应的服务器。

#编辑本文件，将 NT 群集 IP 地址映射到组成群集的多个
#服务器。
#输入的格式为 :
#<群集 IP 地址 >=<服务器 1 IP 地址 >:<服务器 2 IP 地址 >
#IP 地址的格式必须是以圆点间隔。
#范例：如果群集 IP 地址为 151.239.130.70，
#单个服务器的 IP 地址为 151.239.130.71 和
#151.239.130.72，那么输入即为：
# 151.239.130.70=151.239.130.71:151.239.130.72
#

#重要提示：
#仅使用群集 IP 地址对 Configuration Service 
#控制台上的 NT群集服务器进行配置。
#
#151.239.130.70=151.239.130.71:151.239.130.72
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附录 D

确定主机全球广域名称（仅限光纤通道）

本附录介绍如何确定阵列的主机全球广域名称 (WWN)、全球广域节点名称 (WWNN) 
和全球广域端口名称 (WWPN)。其步骤包括：

■ 第 207 页的 “确定 WWN”
■ 第 209 页的 “确定 WWNN”
■ 第 210 页的 “确定 WWPN”

▼ 确定 WWN
如果在使用 LUN 过滤功能之前，能预先确定 Sun StorEdge 3510 光纤通道阵列与 
HBA 卡之间的连接关系及分配给每块卡的 WWN，则大有裨益。

Solaris 操作环境

1. 如果您的计算机上新装了一个 HBA 设备，请重新启动计算机。

2. 键入以下命令

# luxadm probe
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3. 向下滚动列表，找到光纤通道设备和相关的 WWN。

Linux 和 Windows NT/2000 

1. 启动特定的主机，并注意 BIOS 版本和连接到该主机的 HBA 卡的型号。 

2. 使用正确的命令访问 HBA 卡上的 BIOS （通常使用 alt-q 或 control-a）。 

如果主机有多个 HBA 卡，请选择连接到存储器的那个卡。 

3. 扫描该卡，寻找与它连接的设备 （通常使用 Scan Fibre Devices 或 Fibre Disk Utility 
实用工具）。

节点名称 （或类似标识）即为全球广域名称。

以 Qlogic 卡举例：

ID 厂家  产品 Rev 节点名称 端口 ID

0 Qlogic QLA22xx Adapter B 210000E08B02DE2F 0000EF
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▼ 确定 WWNN
1. 双击 Configuration Service 主窗口中的阵列图标 ，或者选中该图标并选择 View 

→ View Controller。

节点名显示在 View Controller Configuration 窗口的 Node name 字段中。

注 － WWNN 信息也包括在由控制台生成的 xml 报告中。
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▼ 确定 WWPN
1. 双击 Configuration Service 主窗口中的阵列图标 ，或者选中该图标并选择 View 

→ View Controller。

2. 单击 View Controller Parameters。

将显示 RAID Controller Parameters 窗口。在 Channel 选项卡上，一直滚动到右侧，
以显示 WWPN。

注 － WWPN 信息也包括在由控制台生成的 xml 报告中。
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附录 E

电子邮件和 SNMP

Sun StorEdge Configuration Service 具备完整事件监控和电子邮件通知能力。控制台
能够将 SMTP 电子邮件消息发送到指定的电子邮件地址列表。可以对诸如 Microsoft 
Exchange 等电子邮件系统进行配置或编写脚本，以根据事件的不同将传呼发送到管理
人员。某些寻呼服务还可将电子邮件消息发送到寻呼机。

代理会将事件放置在操作环境的错误日志中。代理还可以将关于海量存储事件的 
SNMP 陷阱发送给企业管理控制台 （诸如 HP OpenView 等）。有关使用 SNMP 的监
控软件的列表，请访问 Sun Management Center （Sun 管理中心），网址为 
http://wwws.sun.com/software/solaris/sunmanagementcenter/。

本附录介绍如何设置控制台以便发送电子邮件消息。还说明了如何配置服务器将陷阱发
送到 SNMP 管理控制台，并且描述了陷阱格式，且给出有关 SNMP 的背景信息。另
外，还讨论了在不需要 Sun StorEdge Configuration Service 的情况下发送 SNMP 陷阱
的方法。本章包含以下主题：

■ 第 212 页的 “为每台服务器发送电子邮件消息”
■ 第 212 页的 “为每台服务器发送电子邮件消息”

■ 第 215 页的 “设置服务器发送陷阱”
■ 第 215 页的 “检查社区字符串”
■ 第 216 页的 “指定陷阱接收者”
■ 第 217 页的 “设置 Solaris 操作环境服务器”
■ 第 218 页的 “设置 Linux 操作环境服务器”

■ 第 218 页的 “SNMP 的工作方式”
■ 第 222 页的 “在不使用 Sun StorEdge Configuration Service 的情况下发送 

SNMP 陷阱”
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为每台服务器发送电子邮件消息
通过 Server List Setup 功能配置控制台，以为每个受控服务器发送电子邮件消息。

▼ 为每台服务器发送电子邮件消息

1. 选择 File → Server List Setup。 

Server Setup 窗口显示。 

 

2. 单击 Add。

如果已添加服务器，则需要将服务器移到 Available Servers 列表，然后单击 Edit。

Add Server 窗口或 Edit Server 窗口将显示。两个窗口的字段相同。
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3. 如果尚未添加服务器，则应在  Properties 选项卡中填入信息。  

要获得详细信息，请参阅第 40 页的 “添加服务器：”。

4. 要使用电子邮件发送事件消息，应选择 Mailing Lists 选项卡。 

显示 Add Server 窗口，其中 Mailing Lists 是选中的。

a. 对于每一个用户，将电子邮件地址键入 Mail Address 字段中。

b. 在 Severity 列表框中，翻动列表，选择所需的条目。

c. 单击 Add to List。 

要从列表上删除用户，选择邮件地址并单击 Delete from List。
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d. 指定邮件服务器。单击 Setup Mail Server。 

Mail Server Setup 窗口显示。 

 

键入简单邮件传输协议 (SMTP) 邮件服务器 （该服务器用于将电子邮件消息递交到
预先指定的目的地址）的 IP 地址或名称。

e. 如果对 Mail Server 窗口中的信息满意，则单击 OK。 

Add Server 或 Edit Server 窗口显示。

5. 如果对 Add Server 或 Edit Server 窗口中的信息满意，则单击 OK。 

Server Setup 窗口显示。

6. 如果要添加更多的服务器，为每台服务器重复步骤 2 到 5。

7. 如果需要，将一台或多台希望由该控制台控制的服务器移到 Managed Servers 列表。 

如果正在编辑服务器，必须将其移回 Available Servers  列表。

8. 单击 “OK”（确定）返回主窗口。
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设置服务器发送陷阱
如果网络中有企业管理控制台 （如 HP OpenView 或 IBM NetView），可以配置服务
器，将有关事件的陷阱发送至控制台。本节说明了所需的配置步骤。

注 － 如果要将 SNMP 陷阱发送到其它企业管理控制台时，才需要按照本节中的指导
完成。

警告 － 如果 HP OpenView 安装在设置为发送陷阱的同一服务器上，为避免初始化错
误，需要重新配置系统资源。要获得更多关于重新配置系统资源的指导，请参阅故障检
修条目第 227 页的 “症状：HP OpenView 未安装或者陷阱守护程序未启动。”。

Windows NT 服务器

要配置 Windows NT 服务器，以将 SNMP 陷阱发送至一个或多个企业管理控制台，必
须在服务器上配置每个 SNMP 服务，以确保：

■ 服务器列出企业管理控制台的社区字符串或者社区名称。

■ 服务器列出企业管理控制台，作为陷阱接收者，以接收来自 Windows NT 代理软件
的陷阱。

▼ 检查社区字符串

可以使用默认社区名称或 public 的社区字符串。但是，选择社区名称而不是 public 将
会增加更多的安全性，因为它限制了与具有指定社区字符串的计算机的通讯。

要为 Windows NT 4.0 设置社区字符串，请执行以下操作：

1. 在 Control Panel 窗口中，双击 Network 图标，然后单击 Services 选项卡（如果没有
选中该选项卡）。

在  Network Services 列表，滚动至 SNMP 服务，单击一次将其选中，然后单击 
Properties。 

Microsoft SNMP Properties 窗口显示。

注 － 如果未安装 SNMP 服务，可以通过单击 Network 窗口中的 Add 来安装该服务。
Select Network Service 窗口显示，可以从中选择 SNMP 服务。需要插入 Windows 
NT 4.0 CD，以使计算机能够复制 SNMP 服务所必需的文件。
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2. 在 Microsoft SNMP Properties 窗口中单击 Security 选项卡，以显示 Security 设置。

3. 确保要用于服务器的社区名称或者社区字符串已在  Accepted Community Names 列
表中指定。

如果名称不在列表中，单击 Add 以显示 Service Configuration 窗口。在输入字段中键
入新名称并单击该窗口中的 Add。显示 “Security”（安全性）选项卡，其中新名称出
现在 “Accepted Community Names”（接受的社区名称）列表上。

注 － 社区名称或社区字符串区分大小写。

4. （可选的）如果需要，将 “Accept SNMP Packets from Any Host”（接受来自任何
主机的 SNMP 包）的默认设置更改为 “Only Accept SNMP Packets from These 
Hosts”（只接受来自这些主机的 SNMP 包），并添加企业管理计算机的网络地址，该
计算机接收来自服务器上的代理的陷阱。 

使用该设置可以提供更多的安全性，因为这可以让您指定一台或多台计算机，
Windows NT 代理从其中接收信息。

要将带有 Sun StorEdge Configuration Service 控制台软件的计算机的网络地址添加到
下一列表框，请单击 “Add”（添加）以访问 “Security Configuration”（安全性配
置）窗口。在 “Entry”（条目）框中键入 IP 地址并单击该窗口中的 “Add”（添
加）。“Security”（安全性）选项卡再次出现，显示 Configuration Service 管理控制
台计算机的地址。

5. 单击 OK。 

▼ 指定陷阱接收者

在该过程中，您将列出企业管理控制台，作为接收来自服务器的陷阱的接收器。

注 － 对于该过程，需要接收陷阱的企业管理控制台的 IP 地址。该过程还要求与前面
各节中指定的社区名称相同。

指定企业管理控制台计算机作为代理陷阱接收者的步骤如下。

1. 单击 Microsoft SNMP Properties 窗口中的 Traps 选项卡，显示 Traps 设置。 

2. 确保指定的社区名称与早前在 Security 选项中指示的名称相同。

如果需要更正社区名称，可在 Community Name 字段中键入名称，然后单击 Add。
如果该输入字段中已存在另一个名称，在其上键入名称后将保留该名称。要删除名称，
将其选中并单击 Remove。

3. 在 Trap Destinations 列表中添加企业管理控制台的 IP 地址。
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a. 单击 Add。 

显示 Service Configuration 窗口。 

b. 在 Entry 字段中键入 IP 地址并单击 Add。 

Traps 选项卡出现，其中新的网络地址显示在 Trap Destinations 列表中。

c. 按照下列格式键入每个 IP 地址：AAA.BBB.CCC.DDD

您无须键入前导零。正确地址举例：

192.168.100.1

4. 如果希望将可选陷阱发送至另一个企业管理控制台，请键入该管理工作站的网络地址。

如果拥有多个企业管理控制台，每个控制台的地址都必须在这里显示出来。

5. 单击 OK 以确认设置。

6. 单击 Close 离开 Network 窗口。

7. 退出 Windows NT，并重新启动服务器。

如果计划安装 Sun StorEdge Configuration Service，安装完该软件后才需要重新引导。

▼ 设置 Solaris 操作环境服务器

对于运行 Solaris 操作环境的系统，可以通过与一个叫做 sstrapd 的 SNMP 陷阱守护
程序的接口来生成 SNMP 版本 1 陷阱。在默认情况下，在启动过程期间，该守护程序
不会自动启动。以下步骤说明如何启用陷阱处理。 

1. 使用任意标准文本编辑器创建文件  
/var/opt/SUNWsscs/ssagent/sstrapd.conf。

该文件包含 SNMP 管理员控制台的名称或 IP 地址。如果有多个控制台，分行单独列出
这些地址。

2. 编辑文件 /etc/init.d/ssagent 并从与 SNMP 相关的开始部分删除注释标记。这
些行的行首使用双井号进行标记 （##）。

3. 进行上述编辑后保存该文件。

sstrapd 守护程序在下一次引导时启动，也可以通过运行以下命令立即启动。

这将启动 sstrapd 守护程序以及其它两个守护程序 （如果这些程序当前未在运行）。
无论此前是否有守护程序运行，此时每个守护程序都只有一个实例在运行。

/etc/init.d/ssagent uptrap
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▼ 设置 Linux 操作环境服务器

对于运行 Linux 操作环境的系统，可以通过与一个叫做 sstrapd 的 SNMP 陷阱守护
程序的接口来生成 SNMP 版本 1 陷阱。在默认情况下，在启动过程期间，该守护程序
不会自动启动。以下步骤说明如何启用陷阱处理。

1. 使用任意标准文本编辑器创建文件  /var/opt/SUNWsscs/ssagent/sstrapd.conf。

所创建的文件必须包含一个 SNMP 管理器控制台的系统名称或 IP 地址列表 （每行列
出一个）。该文件可以包含空行和注释行。

2. 编辑文件 /etc/init.d/ssagent 并从与 SNMP 相关的开始部分删除注释标记。

这些行的行首使用双井号进行标记 （##）。

3. 进行上述编辑后保存该文件。

sstrapd 守护程序在下一次引导时启动，也可以通过运行以下命令立即启动。

这将启动 sstrapd 守护程序以及其它两个守护程序 （如果这些程序当前未在运行）。
无论此前是否有守护程序运行，此时每个守护程序都只有一个实例在运行。

SNMP 的工作方式
简单网络管理协议 (SNMP) 是网络管理中使用最广泛的协议之一。顾名思义， SNMP 
以相对简单的方式管理网络设备。 SNMP 是一种简单的、尚未正式认可的无连接协议。

开发 SNMP 的最初目的是在 Internet 协议组的前提下工作，特别是指 TCP/IP （传输
控制协议／ Internet 协议）类的传输协议。自此， SNMP 已被用于在其它常用传输协
议之上工作，例如 Novell 的 IPX/SPX （Internet 数据包交换 / 顺序数据包交换）。

/etc/init.d/ssagent uptrap
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SNMP 陷阱消息

代理使用 SNMP 向企业管理系统发送信息。

一旦服务器被配置为发送陷阱，事件信息就会流向该系统。

陷阱消息包含以下信息：

■ OID （对象标识符） 1.3.6.1.4.1.2294.1.2

■ Event Date （MM, DD, YY，如 01, 22, 98）

■ Event Time(HH:MM:SS，如 15:07:23）

■ Server Address and Name （IP 地址名称，如 192.187.249.187 Administration）

■ 网卡名称

■ Event Severity （信息、警告、危险）

■ 文本消息

显示的信息和格式取决于正在使用的 SNMP 管理控制台。

必须将文件 RST_OID.MIB 加载到企业管理控制台才能接收陷阱。在 Solaris 和 Linux 
操作环境中，该文件位于 /opt/sun/SUNWsscs/ssagent。在 Microsoft Windows 
上，该文件位于
\Program Files\Sun\ssagent。

代理和管理器

SNMP 软件模块由代理和管理器组成。代理是一种软件，能够监视被管理设备中的变
量。代理软件可以嵌入被管理设备，也可以与设备连接的计算机上运行。

管理器或者管理控制台是网络监控软件，使用 SNMP 将有关变量的请求发送至代理。
由于变量的值会变化，管理器将定时轮询代理。 SNMP 管理器通常分析从代理接收的
数据，并将其以图形化的方式提供给用户。数据可以存储在数据库中，用于历史性和趋
势性分析。

除了响应 SNMP 管理器的请求外，代理还可以主动发送通知或将陷阱发送至管理站。
这类似于传统软件的中断信号。

管理控制台能采取多种动作对陷阱作出响应。通常对陷阱进行日志记录，将其中的信息
通过通知计划转发给感兴趣的用户。陷阱也可能导致 SNMP 管理器启动进一步的动
作，如查询代理 （发出更多请求以查找网络实体的当前状态，或者启动应用程序）。
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管理信息库 (MIB)
在网络中，每个配备 SNMP 代理的设备都有一个或多个变量或对象与之相关联。典型
变量的例子是一个跟踪设备名称的变量。在名为 Management Information Base 
(MIB) 的文本文件中对这些变量或对象进行了说明。 MIB 是被管理变量的一个精确的文
本定义。定义 MIB 的过程已经由国际标准化组织 (ISO) 的 Internet 工程任务组 (IETF) 
建立起来。

SNMP 对象

某些用于网络管理的变量对于所有局域网网络设备是通用的。许多变量已标准化，被称
为 MIB-II 变量和 MIB-II 扩展。 IETF 还为标准 MIB-II 范畴之外的 MIB 定义了过程。
这些变量在专用企业 MIB 中列出。

变量在私人企业 MIB 条目的下面列出。例如，对象 ID 1.3.6.1.4.1.2294.1.2 指一个变量
的对象 ID （或 OID），该变量用于跟踪在某个 Configuration Service 的 MIB 中的代
理版本。  

图 E-1 中的图表显示了如何获得 OID。该选择标志指示出 OID 中的节点。在 MIB 中，
特定变量或对象的数据位于其 OID 下。

Sun 的树节点为 2294。每个希望开发识别其设备的代理的私人企业都可以向 IETF 申请
自己的树节点。

SNMP 请求类型

支持访问 MIB 数据的 SNMP 操作包括 Get、 GetNext 和 Set。给定索引值， Get 即
从表格条目字段值检索标量值。GetNext 用于遍历表格条目的实例，每个命令返回感兴
趣的栏 （或字段）中的下一个顺序值。 Set 操作用来创建或更改 MIB 变量值。

SNMP 安全性

设置值增加了安全性问题 SNMP V1 （版本 1）有一套简单的安全方案。每个协议数据
单元 (PDU) 包含一个社区字符串，如同用户名和密码的组合。每个代理可以面向特殊
的社区字符串进行配置。代理不响应发送给它的请求，除非在请求 PDU 中的社区字符
串与它自身配置中的社区字符串相匹配。
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图 E-1 MIB 变量的对象标识符

org (3)

dod (6)

internet (1)

directory (1)

mgmt (2)

mib-II-(1)

system (1)
interfaces (2)
at (3)
ip (4)
icmp (5)
tcp (6)
udp (7)
egp (8)
transmission (10)

experimental (3)

private (4)

enterprises (1)

ART (2294)

RS.mib (1)

agentVersion (2)

对象 ID
1.3.6.1.4.1.2294.1.2

复选标记表示 
OID 中的节点。

snmp (11)

ISO (1)
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▼ 在不使用 Sun StorEdge Configuration Service 的
情况下发送 SNMP 陷阱

以下是发送 SNMP 陷阱的替代方法，此方法不需要使用 Sun StorEdge Configuration 
Service。

阵列能够将关于海量存储事件的 SNMP 陷阱发送给企业管理控制台 （如 HP 
OpenView）。以下配置不要求安装代理就可以发送 SNMP 陷阱。

1. 打开文本编辑器。

2. 键入以下信息，在它们用于网络时替代这些变量。

[SNMP_TRAP]
ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]
ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. 使用以下名称保存该文件：agent.ini。

4. 从你的工作站 FTP 至阵列。

5. 键入 root 用户名，按下 Return

6. 在提示输入密码时，按下 Return。

如果此前已为控制器指定了密码，则需要在提示时键入密码。

7. 一旦登录，转到 /cfg 目录。

8. 将文件从工作站放入 /cfg 目录。

9. 退出 FTP 会话。

10. 通过任何用于管理阵列的方法来重置控制器，例如控制台、 Telnet 或终端会话。
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附录 F

故障检修

本章对以下症状提供了故障检修建议：

■ 第 224 页的“症状：在安装 Sun StorEdge Configuration Service 时，java -version 
返回低于 1.2.2 的 Java 运行时环境版本，但是计算机已经安装了 Java 运行时环境 
1.2.2、 1.3 或 1.4。”

■ 第 224 页的 “症状：服务器不响应，服务器已关机。”

■ 第 225 页的 “症状：当从现有的逻辑驱动器中选择添加逻辑卷时，未列出逻辑驱动
器。”

■ 第 225 页的 “症状：DHCP 环境中的某台服务器的 IP 地址已更改。”

■ 第 226 页的 “症状：无法从服务器接收陷阱。”

■ 第 227 页的 “症状：HP OpenView 未安装或者陷阱守护程序未启动。”

■ 第 228 页的 “症状：当添加或更换硬件时，控制台不显示更改。”

■ 第 228 页的 “症状：运行 Solaris 操作环境的系统上没有逻辑驱动器。”

■ 第 228 页的 “症状：不报告环境警报。”

■ 第 228 页的 “症状：控制台似乎运行缓慢。”

■ 第 229 页的 “症状：Sun StorEdge Diagnostic Reporter 停止工作。”

■ 第 229 页的 “症状：（Solaris 或 Linux）无法显示联机帮助。”
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症状：在安装 Sun StorEdge Configuration Service 时，java -version 返
回低于 1.2.2 的 Java 运行时环境版本，但是计算机已经安装了 Java 运
行时环境 1.2.2、 1.3 或 1.4。 
■ 检查 /usr目录以确认从 Java 到 Java 是最新版本的链接而不是 Java 1.1。

要检查 Java 运行时环境版本，请键入

（Solaris 操作环境）如果链接并非指向所列出的最新的 Java 版本，则键入

其中 xxx 是最新的 Java 运行时环境版本。

症状：服务器不响应，服务器已关机。

确保服务正在该服务器上运行。

1. （Solaris 操作环境）运行以下命令

ssmon 和 ssserver 这两个名称都应在输出中出现。如果未都启动，进到步骤 2，否
则，进到步骤 4。

(Windows NT) 转到 Settings → Control Panel → Services 并确认 SUNWscsd 
Monitor、 SUNWscsd Server 和 SUNWscsd Startup 服务已启动。如果未都启动，进
到步骤 2，否则，进到步骤 4。

(Windows 2000) 转到 Start → Administrative Services → Computer Management。单
击 Services & Applications 并确认 SUNWscsd Monitor、 SUNWscsd Server 和 
SUNWscsd Startup 服务已启动。如果未都启动，进到步骤 2，否则，进到步骤 4。

2. （Solaris 或 Linux 操作环境）如第 12 页的 “启动或停止 Agent”中所示，停止和启
动各个守护程序。

(Windows NT/2000) 通过右键单击要启动或停止的服务，将服务停止然后启动。

3. 如果守护程序或服务没有正常停止或启动，则重新配置后进行重新引导。

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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4. 确保 TCP/IP 协议软件已加载，网卡和网络连接工作正常。

要在命令行中测试 TCP/IP 连接性，请键入

如果未得到回答，则 TCP/IP 协议服务有问题。联系 MIS 部门寻求帮助。

5. 确保指定了正确的服务器名称和密码。

如果名称或者密码不正确，通过编辑条目进行更正。对于 Solaris OE，请参阅第 13 页
的 “管理 （用户）安全级别和准则”。对于 Windows NT/2000，请参阅第 20 页的
“管理员 （用户）安全级别和准则”。对于 Linux OE，请参阅第 30 页的 “管理 （用
户）安全级别和准则”。

口令必须是设置用户时建立的那个口令。

■ 确保已正确设置了用户 （ssmon、 ssadmin、 ssconfig）。确保用户已在 
Windows NT 中设置为 Permissions Act as a part of the operating system 和 Log 
on as a batch job。

■ 如果您正在使用命名服务 （Windows NT domains 和 Solaris OE 中的 NIS 或 
NIS+），确保已将用户正确添加到了命名服务。

■ 如果是在 Windows NT 下的域中输入了用户名，则传播用户名需要一段时间。

症状：当从现有的逻辑驱动器中选择添加逻辑卷时，未列出逻辑驱动
器。

如果在 Select a Logical Drive 下未列出任何逻辑驱动器，说明逻辑驱动器尚未被取消
映射，因此无法选择。必须先取消逻辑驱动器的映射。

症状：DHCP 环境中的某台服务器的 IP 地址已更改。

在 DHCP 环境中，如果服务器脱机超过三天，服务器 IP 地址发生变化的可能性极小。

如果发生这种情况，必须向控制台通知服务器的新 IP 地址，因为控制台与服务器是通
过 IP 地址通信的。

要补救这种状态，需要在控制台软件的 “Edit Server ”（编辑服务器）窗口中输入服
务器的新 IP 地址。

1. 选择 File → Server List Setup。

2. 将服务器名称从 Managed Servers 列表移至 Available Servers 列表。

Edit Server 窗口显示。窗口显示配置时的服务器名称和 IP 地址。

# ping {服务器 IP 地址或服务器名称 }
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3. 从 Available Servers 列表中选择服务器名称，然后单击 Edit。

Edit Server 窗口显示。窗口显示配置时的服务器名称和 IP 地址。

4. 如果网络地址已更改，单击 Get IP Addr by Name。 

如果您提供了网络使用的服务所记录的服务器名称，该程序会搜索并显示正确的 IP 地
址。否则，必须手动键入 IP 地址。

如果服务器使用的名称与服务器的网络名称不一致，或者命名服务尚未更新，则必须手
动键入 IP 地址。

5. 一旦输入了服务器 IP 地址，单击 OK 以指定更改的地址，然后返回 Server List Setup 
窗口。

6. 将服务器名称移回 Managed Servers 列表。

7. 单击 OK 离开 Server List Setup 窗口。

症状：无法从服务器接收陷阱。

要解决为何在 SNMP 管理工作站 （如 HP OpenView）上没有从服务器接收到陷阱，
使用下列步骤：

1. 确保 SNMP 服务已在服务器上启动。

验证 sstrapd 通过运行以下命令已运行。

输出包括名称 sstrapd；如果没有，则请参阅第 12 页的 “启动或停止 Agent”，以
获得有关启动守护程序的指示。

在 Windows NT 下，转到 Control Panel → Services，检查 SNMP 服务是否已列出，
并显示为已启动。如果没有，安装该服务，然后启动服务。请参阅 Windows NT 文
档，以获得详细信息。

2. 检查企业管理控制台的目标地址是否正确以及社区字符串是否在服务器上正确设置。

第 215 页的 “设置服务器发送陷阱”提供了在 Windows NT 服务器上正确设置将陷阱
传送到企业管理控制台的具体步骤。

3. 确保在 SNMP 管理控制台下编译 MIB。

在 Solaris 和 Linux 操作环境中， RST_OID.MIB 文件位于 
/opt/SUNWsscs/ssagent 中。在 Microsoft Windows 上，该文件位于
\Program Files\Sun\ssagent。请参阅 SNMP 管理控制台文档，（如 HP 
OpenView 等）可以有关获得如何编译 MIB 的信息。

# ps -e | grep ss
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4. 在 Windows NT 环境下，检查 Sun StorEdge Configuration Service 的 NT 注册表
项。 

如果不存在注册表项，请在服务器上重新安装代理。

a. 首先，确保 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\ 
Parameters\ExtensionAgents 

包含 SSAGENT 的项。

b. 第二，检查

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration 
Service Agent\SNMP Extension Agent\Current Version

指向带有完整的路径名称的扩展代理程序： 

C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ 

是默认的安装目录。 

如果将该程序安装到了其它目录，请确保指向该目录。

c. 第三，确保

SSAGENT.DLL 

位于 C:\PROGRA~1\Sun\ssagent 目录中。

症状：HP OpenView 未安装或者陷阱守护程序未启动。

如果在准备要发送 SNMP 陷阱的同一台服务器上安装了 HP OpenView，会导致没有
足够的系统资源同时运行陷阱守护程序和 HP OpenView。依照下列步骤中的解释对系
统资源进行重新配置。

1. 将以下行添加到 /etc/system 未端 .

2. 重新启动服务器。

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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症状：当添加或更换硬件时，控制台不显示更改。

如果添加了新设备或更换了故障设备 （诸如磁盘驱动器、磁带机、电源或风扇等），控
制台不会总是显示更新的信息。有时，树视图与之相关的其它视图无法反映设备的实际
状态。

如果在下一个周期性扫描前，希望控制台能够识别新添加的设备，在 Server View 窗口
单击 Rescan。服务器立刻会重新扫描库存，控制台更新其服务器库存，并在树视图中
显示任何更改结果。要确保得到及时库存，可进行手动扫描。

可能必须多次单击 Rescan。当服务器在重新扫描过程中而控制台发送了库存请求时，
服务器只将最近一次更新结果发送到控制台，因为服务器尚未完成当前扫描。

症状：运行 Solaris 操作环境的系统上没有逻辑驱动器。

如果未显示 LG，应确保已为 LG 加卷标且其未被 Sun StorEdge Configuration Service
（如果已安装）排除在外。

症状：不报告环境警报。

具有基于 SCSI 附件监控功能的存储附件 （如 SAF-TE 卡）将环境警报发送到控制台。
警报状况可能是由驱动器、风扇、电源或异常温度故障引起的。

如果发生环境警报，则必须单击 View Enclosure 窗口中的 Reset，以清除警报。必须
要有配置安全性特权才可以在软件中单击 Reset。 

警报产生后，要求用于这些存储机箱的 SAF-TE 监控规范，直到警报重置后，由此引起
的环境警报才会生成。

重置警报后，环境事件再次显示在 Event Log 中。

症状：控制台似乎运行缓慢。

运行于 Windows NT 环境下的控制台要求在控制台工作站上最少有 10 MB 的可用虚拟
内存 （物理内存加上页面文件大小）。可用物理内存越大，控制台程序的可响应程度就
较高，它将操作系统的内存分页从物理内存最小化到页面文件。

当使用的内存总量接近可用虚拟内存总量 （物理内存加页面文件总量）时，超过的分
页内容有可能引起问题，导致工作站上所有应用程序的性能降低。

增大物理内存和页面文件大小以增大整体虚拟内存。要更改页面文件大小，选择 
Control Panel → System，然后在出现的 System Properties 窗口选择 Performance 选
项卡。在 Windows NT 环境中，在 Performance 选项卡窗口的 Virtual Memory 部分
更改页面文件大小。 
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症状：Sun StorEdge Diagnostic Reporter 停止工作。

如果停止从 Sun StorEdge Diagnostic Reporter 接收电子邮件消息，则该程序可能不再
工作，可能需要将其停止并重新启动。

（Solaris 操作环境） Sun StorEdge Diagnostic Reporter 停止工作并且不再报告其状况
的情况有三种。解决方法是停止然后重新启动它。

■ 如果代理出现故障或是停止然后重新启动， Sun StorEdge Diagnostic Reporter 会停
止工作。

■ 如果 Config Tool 正在运行而守护程序停止并重新启动，则会出现 Config Tool 不能
与守护程序通信的情况。

■ 如果代理出现故障或被停止，则守护程序不会检测到这一情况，但是会停止发送电
子邮件消息，并且继续显示绿色状态，表示 Sun StorEdge Diagnostic Reporter 仍然
保持连接。

键入下面的命令，停止并重新启动 Sun StorEdge Diagnostic Reporter

症状：（Solaris 或 Linux）无法显示联机帮助。

请确保指定了将用于显示在线帮助的 Web 浏览器的绝对路径名。

1. 转到 /opt/SUNWsscs/sscsconsole 并键入 

2. 输入 Web 浏览器的绝对路径名。

# /etc/init.d/ssdgrptd stop
# /etc/init.d ssdgrptd start

./config_sscon
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附录 G

错误代码和消息

本附录提供错误代码以及错误和状态消息列表。

错误代码
错误代码是在事件日志中显示和说明的，是一个八个字符长代码，其中包括四个字段，
即每个字段有两个字符构成。一些代码后面可能有一个短划线和另外一个八个字符长的
代码，该代码仅在内部使用。

下列各表说明每个双字符字段中所用的错误代码。四个双字符字段的格式为：

SSMMmmEE

其中：

SS = Severity 字段

MM = Major 字段

mm = Minor 字段

EE = Error 字段

表 G-1 Severity 字段

Severity 字段 说明

01 危险 

02 警告

03 信息
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表 G-2 Major 字段

Major 字段 说明

01 未用

03 传统

04 RAIDCard 卡消息

05 JBOD （简单磁盘捆绑）消息

06 SSMon 监控消息

07 dll/ 共享库消息

08 SSserver 消息

09 HBA （主机总线适配器）消息

0A Server Communications （服务器通信）消息

0B Controller （控制器）消息
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下表中定义 Minor 字段。 Error 字段的定义取决于 Minor 字段的定义，因而需要参照
相应的表。

表 G-3 Minor 字段

Minor 字段 说明

01 未知

02 参阅第 234 页的 “Error 字段：系统驱动器状况”。

03 参阅第 234 页的 “Error 字段：磁盘状况”。

04 参阅第 235 页的 “Error 字段：SAF-TE 状况”。

05 参阅第 235 页的 “Error 字段：磁带状况”。

06 参阅第 236 页的 “Error 字段：冗余状况”。

07 参阅第 237 页的 “Error 字段：内部状况”。

08 参阅第 237 页的 “Error 字段：设备状况”。

09 参阅第 237 页的 “Error 字段：初始化状况”。 

0A 参阅第 238 页的 “Error 字段：客户端参数无效”。

0B 参阅第 238 页的 “Error 字段：打开传输”。

0C 参阅第 239 页的 “Error 字段：关闭传输”。

0D 参阅第 239 页的 “Error 字段：内存分配”。

0E 检测到 RaidCard 故障。

0F 参阅第 239 页的 “Error 字段：传输”。

10 参阅第 240 页的 “Error 字段：命令”。

11 参阅第 240 页的 “Error 字段：命令”。

12 参阅第 240 页的 “Error 字段：主要通信”。

13 参阅第 240 页的 “Error 字段：异步通信”。

14 参阅第 241 页的 “Error 字段：通信安全”。

15 参阅第 241 页的 “Error 字段：超时”。

16 参阅第 241 页的 “Error 字段：管理”。

17 参阅第 242 页的 “Error 字段：固件”。

18 参阅第 242 页的 “Error 字段：系统关闭”。

19 检测到 Dynamic Growth （动态增长）故障。 

1C 参阅第 243 页的 “Error 字段：设置配置”。

1D 参阅第 243 页的 “Error 字段：控制器事件”。

1E 参阅第 244 页的 “Error 字段：驱动器侧事件”。
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Error 字段：系统驱动器状况

Error 字段：磁盘状况

1F 参阅第 245 页的 “Error 字段：主机侧事件”。

20 参阅第 245 页的 “Error 字段：逻辑驱动器事件”。

23 参阅第 246 页的 “服务器管理 / 监控事件错误”。

表 G-4 系统驱动器状况错误

Error 字段

01 脱机

02 退化

03 联机

04 未知

05 奇偶校验

06 重建

07 重新配置

08 动态增长

09 不存在

0A 初始化

表 G-5 磁盘状况错误

Error 字段 说明

01 脱机

02 退化

03 联机

04 未知

05 SMART

06 死亡

表 G-3 Minor 字段 （续）

Minor 字段 说明
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Error 字段：SAF-TE 状况
 

Error 字段：磁带状况

表 G-6 SAF-TE 状况错误

Error 字段 说明

01 电源

02 风扇

03 热度

04 警报

05 已锁定

06 槽

07 未知

08 无法获得 SAF-TE 信息

09 电池 

0A 插槽数目无效

0B 无环境数据可提供

表 G-7 磁带状况错误

Error 字段 说明

01 读

02 写

03 硬性错误

04 介质错误

05 读取失败

06 写入失败

07 介质寿命

08 不可升级

09 写保护

0A 非移动

0B 清洁介质
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Error 字段：冗余状况

0C 不支持的格式

0D 磁带已被扯断

14 立刻清洁

15 周期性清洁

16 清洁介质已过期

1E 硬件 A

1F 硬件 B

20 接口

21 弹出介质

22 下载失败

28 加载器硬件 A

29 加载器托盘磁带

2A 加载器硬件 B

2B 加载器门

C8 查询日志失败

C9 询问磁带失败

表 G-8 冗余状况错误

Error 字段 说明

01 模式正常

02 没有内存可用于协商

03 辅助控制器故障

04 辅助控制器已被卸下

05 检测到辅助控制器卸下

06 检测到辅助控制器插入

07 主控制器故障

08 主控制器已被卸下

09 检测到主控制器卸下

表 G-7 磁带状况错误 （续）

Error 字段 说明
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Error 字段：内部状况
 

Error 字段：设备状况

Error 字段：初始化状况

0A 检测到主控制器插入

0B 未知状况

0C 伙伴失败

0D 伙伴已插入

0E 伙伴已移除

表 G-9 内部状况错误

Error 字段 说明

01 无内存

02 信号

03 线程

04 没有设备

表 G-10 设备状况错误

Error 字段 说明

01 查询

02 未知

表 G-11 初始化状况错误

Error 字段 说明

01 dll 初始化

02 dll 初始化失败

表 G-8 冗余状况错误 （续）

Error 字段 说明
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Error 字段：客户端参数无效

Error 字段：打开传输

表 G-12 客户端参数错误。

Error 字段 说明

01 设定配置 - 配置失配

02 设定配置 - 配置设备无效

03 设定配置 - Enquire 失配

04 设定配置 - Enquire2 失配

05 应用程序长度不正确

06 不支持的命令

07 命令无效

08 设定配置 - 一般性失配

09 无效长度

0A 卡标识符无效

0B 无效的卡名

0C 参数无效

0D 卡类型命令无效

0E 设定配置 - 附加参数无效 

0F 设定配置 - 块重叠

10 设定配置 - 设备信息无效 

表 G-13 打开传输错误

Error 字段 说明

01 打开传输
238  Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



Error 字段：关闭传输

Error 字段：内存分配

Error 字段：传输

表 G-14 关闭传输错误

Error 字段 说明

01 关闭传输

表 G-15 内存分配错误

Error 字段 说明

01 内存不足

02 内存不足，无法进行管理操作

表 G-16 传输字段错误

Error 字段 说明

01 锁定错误

02 内存不足

03 获得锁定错误

04 释放锁定错误

05 命令无效

06 无效长度

07 无效的卡名

08 卡标识无效

09 没有找到卡

0A 找不到设备

0B 打开错误

0C 找不到卡名
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Error 字段：命令

Error 字段：主要通信

Error 字段：通信链路

Error 字段：异步通信

表 G-17 命令代码错误

Error 字段 说明

01 锁定错误

表 G-18 主要通信错误

Error 字段 说明

01 套接字错误

02 报告错误

03 线程错误

04 锁定错误

05 系统错误

表 G-19 通信链路

Error 字段 说明

01 套接字错误

表 G-20 异步通信 （第 1 张，共 2 张）

Error 字段 说明

01 套接字错误
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Error 字段：通信安全

Error 字段：超时

Error 字段：管理

02 线程错误

03 冷链接错误

04 发送事件错误

表 G-21 通信安全

Error 字段 说明

01 安全冲突

表 G-22 超时错误

Error 字段 说明

01 配置更新

02 锁定超时

表 G-23 管理错误

Error 字段 说明

01 设定客户名称错误

02 设定配置已结束

03 初始化

04 初始化已结束

05 重建

06 重建已结束

07 奇偶校验

表 G-20 异步通信 （第 2 张，共 2 张）

Error 字段 说明
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Error 字段：固件

Error 字段：系统关闭

08 奇偶校验已结束

09 设定 SAF-TE 插槽状况

0A 设定 SAF-TE Perform Slot （执行插槽）

0B 设定 SAF-TE Send Global （发送全局）

0E 预定奇偶校验检查

0F 调度奇偶校验已结束

10 设定控制器参数

11 固件下载

12 一致性检查或重建已结束

表 G-24 固件下载错误

Error 字段 说明

01 并非 SAF-TE 设备

02 数据长度无效

03 下载失败

04 校验和失败

表 G-25 关闭系统错误

Error 字段 说明

01 系统关闭失败

表 G-23 管理错误 （续）

Error 字段 说明
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Error 字段：RDP 路径更改

Error 字段：设置配置

Error 字段：控制器事件

表 G-26 RDP 路径更改错误

Error 字段 说明

01 RDP 路径失败

02 RDP 路径已恢复

表 G-27 设置配置错误

Error 字段 说明

01 设定配置线程创建失败

02 获取逻辑驱动器列表命令失败

03 创建配置命令失败

04 初始化完成状态命令失败

05 获取配置命令失败

06 更改卷配置命令失败

07 删除逻辑驱动器命令失败

表 G-28 控制器事件错误

Error 字段 说明

01 控制器复位

02 控制器 DRAM 奇偶效验错误

03 冗余控制器故障

04 控制器电源故障

05 控制器风扇故障

06 控制器温度警示
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Error 字段：驱动器侧事件

07 控制器 UPS 交流电源断电

08 控制器初始化完成

09 控制器电源恢复联机

0A 控制器风扇恢复联机

0B 控制器温度正常

0C 控制器 UPS 交流电源重新供电

表 G-29 驱动器侧事件错误

Error 字段 说明

01 驱动器通道选择超时

02 驱动器通道 SCSI 总线错误

03 驱动器通道意外断开

04 驱动器通道协商错误

05 驱动器通道目标已超时

06 驱动器通道奇偶校验错误

07 驱动器通道数据不足或超限

08 驱动器通道未定义错误

09 驱动器通道 SCSI 总线重置已发出

0A 驱动器通道未就绪错误

0B 驱动器通道目标 HW （硬件）错误

0C 驱动器通道目标介质错误

0D 驱动器通道意外单元强调

0E 驱动器通道意外传感数据

0F 驱动器通道块重新分配失败

10 驱动器通道块重新分配成功

11 驱动器通道 SCSI 已放弃命令

表 G-28 控制器事件错误 （续）

Error 字段 说明
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Error 字段：主机侧事件

Error 字段：逻辑驱动器事件

12 驱动器通道 SCSI 通道故障

13 驱动器通道智能故障

14 驱动器通道扫描 SCSI 驱动器

表 G-30 主机侧事件错误

Error 字段 说明

01 主机通道 SCSI 总线重置

02 主机通道 SCSI 总线设备重置

03 主机通道放弃标记消息

04 主机通道奇偶校验错误

05 主机通道重新选择超时

表 G-31 逻辑驱动器事件错误

Error 字段 说明

01 逻辑驱动器 SCSI 驱动器故障

02 逻辑驱动器初始化失败

03 逻辑驱动器重建失败

04 逻辑驱动器初始化已开始

05 逻辑驱动器初始化已完成

06 逻辑驱动器重建已开始

07 逻辑驱动器重建已完成

表 G-29 驱动器侧事件错误 （续）

Error 字段 说明
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服务器管理 / 监控事件错误

错误和状态消息    
许多错误和状态消息自身已作出解释。表 G-33 说明了消息中使用的术语。表 G-34 列
出了错误 / 状态消息。 

表 G-32 服务器管理 / 监控事件错误 

Error 字段 说明

01 管理 / 监控服务器已更改。

表 G-33 替代值

值 说明

通道 卡的通道号，表示 SCSI 通道。值 1 指第一个通道。

风扇 风扇号。

机箱 机箱号。

LogicalArray 逻辑阵列号。

LogicalDrive 逻辑驱动器号码。

Lun LUN 号码。

名称 文本名称。

电源 电源号。

槽 插槽号。

州 / 省 以文字表示的逻辑阵列、设备或附件的状况。其值为：Critical、
Online、 Offline、 Critical Rebuild、 Non Existent、 Low Battery、
Normal。

目标 目标或 SCSI ID 编号。 

温度 以百分度表示的温度。
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表 G-34  错误 / 状态消息

错误和状态消息

SCSI 驱动器出故障 (Ch:%d,Id:%d)。更换损坏的驱动器。

由于上一个硬件故障，磁带被留在了自动载入器中。请插入空插槽箱以清除故障。如果没有清
除故障，请将自动加载器关闭然后重新开启。如果问题仍存在，请与磁带机供应商帮助热线联

系。

必须创建一个名为 ssconfig 的用户才能对 SUNWsscs Diag Reporter 进行配置。

中止克隆 SCSI 驱动器。

中止初始化。

中止奇偶校验检查。

中止重建。

收到 Abort/Clear-Queue/Abort-Tag 消息 （SCSI 通道 %d， SCSI ID %d，目标 Lun %d）。
I/O 模块、电缆、控制器或 HBA 可能发生了故障。

对一台或多台服务器的访问被拒绝。作为 ssconfig 用户登录，然后再次尝试该操作。

对一台或多台服务器的访问被拒绝。请作为 ssadmin 用户登录，然后再次尝试该操作。

“活动陷阱事件”为空。

添加物理驱动器 %d：%d 已在逻辑驱动器 LogicalDrive 上启动。

在逻辑驱动器 LogicalDrive 上添加物理驱动器已完成。

将 SCSI 驱动器添加到逻辑驱动器信息。

代理名为空。

从服务器获取数据时出现错误。

已存在具有该 WWN 的 HBA 卡。

此程序的另一个实例已经在运行！

正在进行阵列管理。

至少需要配置一个电子邮件地址。

试图装入本驱动器不支持类型的盒式磁带。盒式磁带已自动弹出。试图装入一种不支持的磁带

格式。

试图写入带有写保护的盒式磁带。请去掉写保护或者使用另一盒磁带。

声音警报处于未知状态

已触发音频警报。

声音警报已关闭。

正在进行后台检查或重建操作。
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后台初始化正在进行。

后台奇偶校验检查正在进行。

后台重建操作正在进行。

遇到坏块 (Ch:%d,Id:%d)。扇区号是 %u。信息性消息。

块重新分配失败 (Ch:%d,Id:%d)。驱动器有缺陷。须进行更换。

块重新分配重成功 (Ch:%d,Id:%d)。信息性消息。驱动器可能失败。

无法接受传入连接。

无法分配内存。

无法将 TCP 端口与已打开的 TCP/IP 通讯绑定在一起。

无法连接到传入的连接。

无法为传入连接创建通讯会话。

无法创建主机 LUN 过滤器 ; 没有选择主机 ID。

无法创建标准主机 LUN 映射；没有选择主机 ID。

找不到刚创建的逻辑驱动器。它可能已被中止。

无法从控制器获取配置。操作已取消。

无法在设定配置中获取配置。

无法侦听已打开的 TCP/IP 通讯。

无法锁定资源。

无法打开 TCP/IP 通讯。

无法在 TCP/IP 通讯上执行 IOCTL。

无法查询连接的传入数据状态。

无法从已连接的客户端接收数据。

无法报告状态。

无法将数据发送到已连接的客户端。

更改逻辑驱动器失败。

更改逻辑卷失败。

更改或设置本地 / 全局待机驱动器成功。

只有在检测到所有的逻辑驱动器并重置控制器后，对 Optimization 进行的更改才能生效。

单击 “查看”选择一个文件。

关闭传输在设置配置时失败。

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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收集邮件被用户取消。

已与控制器重新建立通讯。

配置信息保存成功 !

连接与登录命令错误

联系传真号码格式错误。

联系人姓名为空

联系电话号码格式错误。

继续在逻辑驱动器 LogicalDrive 上添加驱动器。

控制器事件，电池 %s %s。信息性消息。

控制器事件，电池 %s %s。可能是由于电池模块出错。如果错误仍然出现，请更换有缺陷的电
池模块。

控制器事件，控制器初始化完成。控制器已重新启动。信息性消息。

控制器事件，控制器重置。信息性消息。

控制器事件， DRAM 奇偶校验错误。很可能是控制器错误。如果错误仍然出现，请更换有缺
陷的控制器。

控制器事件，风扇重新联机。信息性消息。

控制器事件，检测到风扇故障。风扇已集成到电源中。更换电源。检查 LED 指示灯是否指示

电源正常。

控制器事件，电源重新联机。信息性消息。

控制器事件，检测到电源故障。更换电源。检查 LED 指示灯是否指示电源正常。

控制器事件，检测到冗余控制器故障。很可能是控制器错误。如果错误仍然出现，请更换有缺

陷的控制器。

控制器事件， SDRAM 错误。很可能是控制器错误。如果错误仍然出现，请更换有缺陷的控制

器。

控制器事件，温度警报。检查房间温度，以及是否有防碍或限制空气流通的现象。请按照需要
采取相应措施。

控制器事件，温度恢复到标准。信息性消息。

控制器事件， UPS 交流电源重新打开。信息性消息。

控制器事件，检测到 UPS 交流电源断电。请与技术支持人员联系。

控制器已复位。

控制器已回到冗余模式！

控制器已回到冗余模式！

在物理驱动器 %d:%d 上的复制和更换已完成。

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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在物理驱动器 %d:%d to %d:%d 上的复制和更换已开始。

在物理驱动器 %d:%d 上的复制和更换已中止。

创建逻辑驱动器失败。

创建逻辑卷失败。

正在创建主机 LUN 筛选器项；请稍候 ...

正在创建标准主机 LUN 映射；请稍候 ...

用户传真号码格式错误。

用户名为空。

用户电话号码格式错误。

数据处于危险中。该磁带的媒质性能严重降低。须从该磁带复制所有需要的数据。不要再使用
该磁带。请用一盒不同的磁带重新开始操作。

数据不足 / 超限 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。如果是随机驱动器，则
有可能是驱动器环路上有 I/O 模块故障或电缆故障。

解密邮件被用户取消。

删除逻辑驱动器失败。

删除逻辑卷失败。

已成功删除磁盘！

正在删除磁盘；请稍候 ...

正在删除主机 LUN 筛选器项；请稍候 ...

正在删除标准主机 LUN 映射；请稍候 ...

[Channel:Target] （通道 : 目标）处的设备自我可靠性测试失败。

设备信息失败。

添加磁盘标签成功。

门锁处于未知状态。

门已锁上。

门锁已打开。

下载带有引导记录的固件。

正在将固件下载到设备

正在将固件下载到 RAID 控制器。

驱动器 SCSI Ch:%d; Id:%d 可能安装不当或有缺陷。如果是随机驱动器，则有可能是有 I/O 
模块故障或电缆故障。

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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电子邮件地址格式错误。

附件 #Enclosure 状态更改：名称

附件 #Enclosure，温度阈值已经从 State 状态更改为 State 状态。

使用固件；不必进行控制器重置。

写文件时出现错误，请以后再试！

出现错误。请重置配置文件。

扩展 LD/LV 信息。

扩展逻辑卷成功。

逻辑驱动器 LogicalDrive 上的扩展已经完成。

逻辑驱动器 LogicalDrive 上的扩展已经开始。

逻辑驱动器 LogicalDrive 的扩展已中止。

风扇 #Fan 的状态未知。

风扇 #Fan 出现故障。

系统中没有风扇 #Fan。

风扇 #Fan 可以运转。

文件 I/O 错误。无法恢复配置！

下载到 SAF-TE/SES 设备 (Ch:%d,Id:%d) 的固件已失败。

固件已被成功地下载到 SAF-TE/SES 设备 (Ch:%d,Id:%d)。

下载到 SCSI 驱动器 (Ch:%d,Id:%d) 的固件已失败。

固件已被成功地下载到 SCSI 驱动器 (Ch:%d,Id:%d)。

请先选择一个逻辑驱动器！

请先选择一个物理设备。

请先选择一个 RAID 控制器。

对于 RAID1 逻辑驱动器， 'Add Drive'/'Copy and Replace' 功能已被禁用。

转发邮件被用户取消。

通用文件互斥锁定未解除。

获取逻辑驱动器列表失败。

Getting Agent Options （获取代理选项）已失败！

Getting Controller Parameters （获取控制器参数）已失败！

Getting Host LUN Assignments （获取主机 LUN 分配）已失败！请重试。

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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获取配置失败！

检测到总相 / 信号错误 (Ch:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

冗余控制器绑定失败。

组名不能为空

主机 LUN 过滤器项目创建成功！

主机 LUN 过滤器项目删除成功！

主机 LUN 修改成功。

如果在分配给多个主机时没有适当地调整文件访问，可能发生数据损坏和访问争用。

如果最小间隔是 “0”或 “*”，则 “内容”必须是 “事件”

如果固件下载进程被中断，则可能会导致控制器 / 设备不可用。

逻辑驱动器 LogicalDrive 上的初始化已经完成。

逻辑驱动器 LogicalDrive 上的初始化已经开始。

在逻辑驱动器 LogicalDrive 上的初始化已中止。

初始化操作已完成。

正在进行 SCSI 驱动器初始化、重建、扩展或添加活动。请稍后重试。

插入了故障主控制器。

插入了故障辅助控制器。

收到无效的数据。

服务器 IP 地址无效！

IP 地址格式错误 （必须为 xxx.xxx.xxx.xxx 和 0 &amp;lt; xxx &amp;lt;255）！

IP 地址重复！

IP 地址为空。

位置为空。

作为 “ssconfig”用户登录，然后再次尝试该操作。

逻辑阵列 LogicalArray 已经从 state 状态更改为 state 状态。

逻辑驱动器 %d， SCSI 驱动器有故障。请更换有缺陷的驱动器。

逻辑驱动器 ID %d 超过了顺序优化 LD 的 2 TB 的大小限制。

逻辑驱动器 ID %d 超过了随机优化 LD 的 512 GB 的大小限制。

逻辑驱动器 ID %d，重建已中止。信息性消息。

逻辑驱动器 ID %d，重建已完成。指示性信息。请使用新驱动器更换有缺陷的驱动器。

逻辑驱动器 ID LogicalDrive 重建已中止。

表 G-34  错误 / 状态消息 （续）

错误和状态消息
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逻辑驱动器 ID LogicalDrive 重建已完成。

逻辑驱动器 ID LogicalDrive 重建已开始。

逻辑驱动器 ID LogicalDrive，添加驱动器已暂停。信息性消息。

逻辑驱动器 ID LogicalDrive，添加 SCSI 驱动器已中止。信息性消息。

逻辑驱动器 ID LogicalDrive，添加 SCSI 驱动器已完成。信息性消息。

逻辑驱动器 ID LogicalDrive，添加 SCSI 驱动器失败。不可恢复的错误。很可能是驱动器故障

或条带上有不可恢复的错误。在逻辑驱动器上运行奇偶校验检查。请与技术支持人员联系。

逻辑驱动器 ID LogicalDrive，克隆已中止。信息性消息。

逻辑驱动器 ID LogicalDrive，克隆已完成。信息性消息。

逻辑驱动器 ID LogicalDrive，克隆失败。不可恢复的错误。很可能是驱动器故障或条带上有不
可恢复的错误。在逻辑驱动器上运行奇偶校验检查。请与技术支持人员联系。

逻辑驱动器 ID LogicalDrive，扩展已中止。信息性消息。

逻辑驱动器 ID LogicalDrive，扩展已完成。信息性消息。

逻辑驱动器 ID LogicalDrive，扩展失败。不可恢复的错误。很可能是驱动器故障或条带上有不
可恢复的错误。在逻辑驱动器上运行奇偶校验检查。请与技术支持人员联系。

逻辑驱动器 ID LogicalDrive，初始化已中止。信息性消息。

逻辑驱动器 ID LogicalDrive，初始化已完成。信息性消息。

逻辑驱动器 ID LogicalDrive，初始化失败。指示性信息。可能是驱动器或插槽有缺陷。用户可
能中止了操作。

逻辑驱动器 ID LogicalDrive，奇偶校验已被用户中止。奇偶检验应运行完毕，以便验证指定逻
辑驱动器的数据完整性。

逻辑驱动器 ID LogicalDrive，奇偶校验已完成。信息性消息。

逻辑驱动器 ID LogicalDrive，重建失败。指示性信息。可能是驱动器或插槽有缺陷。用户可能

中止了操作。

逻辑驱动器 ID LogicalDrive，开始添加 SCSI 驱动器操作。信息性消息。

逻辑驱动器 ID LogicalDrive，开始克隆。信息性消息。

逻辑驱动器 ID LogicalDrive，开始扩展。信息性消息。

逻辑驱动器 ID LogicalDrive，开始初始化。信息性消息。

逻辑驱动器 ID LogicalDrive，开始奇偶校验。信息性消息。

逻辑驱动器 ID LogicalDrive，开始奇偶校验。信息性消息。

逻辑驱动器 ID LogicalDrive，开始重建。信息性消息。

逻辑驱动器 LogicalDrive 已经从 State 状态更改为 State 状态。

逻辑驱动器 LogicalDrive 已经从 State 状态更改为 State 状态。
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逻辑驱动器 LogicalDrive，奇偶校验失败。不可恢复的错误。很可能是驱动器故障或条带上有
不可恢复的错误。在逻辑驱动器上运行奇偶校验检查。请与技术支持人员联系。 
注意：如果手动中止 Parity Check （奇偶校验），不会有数据破坏的危险。不必与技术支持联
系。

逻辑卷组件列表。该逻辑卷中的总磁盘数 =

登录成功

登录失败

注销命令错误。

邮件信息是空的。

内存分配出错。无法加载守护程序。

电子邮件间的最小间隔必须是下面的格式之一： 
“*”、“0”、“nn”、“nn:mm”

最小间隔无法满足内容值。

最小间隔格式错误。

最小间隔格式为 HH[:MM]。

最小间隔为空。

监视器已停止工作。

不支持多种 IP 分配机制。仅选择一种机制。

使蜂鸣器静音。

将控制器蜂鸣器设为静音失败。

控制器蜂鸣器静音。

互斥锁定未解除。

互斥锁超时。

无法创建互斥锁！

互斥锁更改状态失败！

协商错误 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

新奇偶校验预定已创建。

不存在管理进度。

找不到管理进度。应当完成所有的活动！

没有任何阵列管理活动正在进行！

没有更多要报告的事件。

没有找到新控制器；您不需要重新引导系统。
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没有可用的可重建驱动器。

目标报告尚未准备就绪错误 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。可能是驱动

器插槽有缺陷。

只能删除 LD/LV 的最后一个分区。

打开传输在设置配置时失败。

打开传输，锁定失败，原锁持有者的 IP 地址是 %s。

打开传输， LogIn 失败。

操作已成功完成。

操作失败。

正在执行操作。

在其中一台服务器上的操作失败。

在范围之外！

奇偶校验已中止。

奇偶校验确认。

无法在逻辑驱动器 LogicalDrive 上开始奇偶校验。

已在逻辑驱动器 LogicalDrive 上完成奇偶校验。

已在逻辑驱动器 LogicalDrive 上开始奇偶校验。

逻辑驱动器 LogicalDrive 的奇偶校验已被中止。

奇偶校验预定已删除。

奇偶校验预定已更新。

奇偶校验错误 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。如果是随机驱动器，则有

可能是有 I/O 模块故障或电缆故障。

奇偶校验错误 （SCSI 通道 %d， SCSI ID %d，目标 Lun %d）。 I/O 模块、电缆、控制器或 
HBA 可能发生了故障。

无法删除分区 0。

分区表已满。无法添加新分区。

密码错误！

口令为空。

端口无效 ( 端口必须介于 0 到 65535 之间 )。

端口无效 ( 端口必须介于 1270 到 1273 之间 )。

电源 #Power 状态未知。
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电源 #Power 有故障，已被关闭。

电源 #Power 有故障或已被禁用。

系统中不存在电源 #Power。

电源 #Power 操作正常但已被禁用。

电源 #Power 操作正常。

系统中存在电源 #Power。

主控制器有故障！

Probe Agent （探测代理）命令错误！

进程不可用。

RAID 控制器固件校验和失败 - 固件数据已损坏。

RAID 控制器固件下载失败。

RAID 控制器固件已更新。

RAID 控制器已重新联机。

读取配置文件时出错。

在逻辑驱动器 LogicalDrive 上的重建已中止。

重建或检查操作已完成。

冗余阵列状态更改：控制器故障。

冗余阵列状态更改：控制器回到冗余模式。

已卸下一个故障主控制器。

已卸下一个故障辅助控制器。

重新选择超时 （SCSI 通道 %d， SCSI ID %d，目标 Lun %d）。 I/O 模块、电缆、控制器或 
HBA 可能发生了故障。

正在将配置还原到控制器。

在更新完成后重试配置操作。

SAF-TE/SES 卡 Channel:Target 固件已被更新。

SAF-TE/SES 卡 Channel:Target 全局状态已被更新。

SAF-TE/SES 卡 Channel:Target 插槽性能状态已被更新。

SAF-TE/SES 卡 Channel:Target 插槽状态已被更新。

在服务器上保存副本。

正在保存配置信息；请稍候 ...

已成功扫描 SCSI 驱动器 (%d.%d)。
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扫描 SCSI 驱动器信息。

扫描 SCSI 驱动器成功 (Ch:%d,Id:%d)。信息性消息。

无法在逻辑驱动器 LogicalDrive 上开始调度的奇偶校验。

已在逻辑驱动器 LogicalDrive 上完成调度的奇偶校验。

已在逻辑驱动器 LogicalDrive 上开始调度的奇偶校验。

由于未完成前一个检查，预定奇偶校验检查跳转到下一个预定作业。

SCSI 已中止命令 (Ch:%d,Id:%d)。指示性信息。驱动器可能失败或插槽有缺陷。

SCSI 总线设备重置（SCSI 通道 %d，SCSI ID %d，目标 Lun %d）。I/O 模块、电缆或 HBA 
可能发生了故障。

SCSI 总线重置（SCSI 通道 %d，SCSI ID %d，目标 Lun %d）。I/O 模块、电缆或 HBA 可能
发生了故障。

已发出 SCSI 总线重置 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行
更换。

SCSI 通道故障 - 光纤环路连接。检查驱动器路径失败。可能是电缆或模块故障。

SCSI 通道故障 - 常规。请检查驱动器路径。

SCSI 通道故障 - 冗余环路 / 路径故障。请检查驱动器路径。可能是电缆或模块故障。

SCSI 通道故障 (Ch:%d,Id:%d)。更换有缺陷的 I/O 或驱动器模块。

SCSI 通道已恢复 - 光纤环路连接已恢复。信息性消息。

SCSI 通道已恢复 - 冗余路径已恢复。信息性消息。

辅助控制器有故障！

服务器错误。

由于内存不足，服务器使此操作失败。

服务器名称为空。

服务器未受管理！

设置控制器参数成功。

设置或添加配置失败。

插槽 #Slot 有一个设备 Name。

检测到 SMART 可预测故障 (Ch:%d,Id:%d)。指示性信息。驱动器可能失败。

SMTP 源地址格式错误或为空。

SMTP 源地址格式错误。

SMTP 服务器地址为空。
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指定所需的奇偶校验检查频率。

标准配置选项提供一组基本的默认 RAID 集，其中驱动器大小、数量和分配已经过预先配置。

标准配置将取代现有配置。

标准主机 LUN 映射创建成功！

标准主机 LUN 映射删除成功！

在特定配置中，标准映射可用于所有所连接的主机。

备用重建操作已完成，但有未知错误。

正在进行备用重建操作。

辅助控制器的启动状况。

状态更改互斥锁定未解除。

Sun StorEdge Configuration Service 监视器守护程序已启动。

Sun StorEdge Configuration Service 服务器守护程序已启动。

Sun StorEdge Configuration Service 启动完成。

Sun StorEdge Configuration Service 陷阱守护程序已启动。

系统管理员 (ssconfig) 已启动了不可撤销的系统关闭和重启。请保存所有数据并立即注销。

系统 ID 为空。

磁带操作已停止，因为读取或写入数据时发生错误，驱动器无法纠正该错误。  

TapeAlert 通知。设备 [Channel:Target]。  

报告目标硬件错误 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。可能是驱动器插槽有

缺陷。

报告目标介质错误 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。可能是驱动器插槽有

缺陷。

目标超时 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

温度从 TemperatureC 更改为 TemperatureC。

后台命令已完成。

后台命令已被中止。

转接器机制在与磁带机通讯方面有困难。关闭然后打开自动加载器，重新开始操作。如果问题
仍存在，请与磁带机供应商帮助热线联系。

配置已更新。

配置成功更新。如果创建了新的 LD/LV，则可能需要重新引导服务器。

控制器设备列表已更改。
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控制器参数已得到更新。

当前用户是 ssconfig; 您无法再登录。

守护程序无响应。

设备不属于同一 HBA 卡。该操作无法继续。

无法分配驱动器号 （安装点）。

加密密钥为空。

此固件不支持多种 IP 分配机制。

固件下载失败，因为您尝试使用不适用于该磁带机的固件。请获取正确的固件，然后重试。

主机 LUN 筛选器映射 （StorEdge SN#%d LD %d 分区 %d WWN：）已创建。

主机 LUN 筛选器映射 （StorEdge SN#%d LD %d 分区 %d WWN：）已被删除。

IP 地址不能为空。

磁带机中使用的最后一个清洗磁带已经坏了。扔掉磨损的清洁磁带，等待当前的操作结束，然
后使用新的清洁磁带。

删除逻辑驱动器后 LD# 上移，所以可能与 RS-232 终端窗口上所显示的 LD# 不一致。

加密密钥的长度必须大于 8 个字符。

邮件服务器字段不能为空。

媒质已超过其指定使用寿命。

内存分配失败。

无法将安装点 （驱动器号）写入文件 （注册表）。

在创建了逻辑驱动器后，逻辑驱动器的数量没有增加。（以前：%d，现在：%d)。

操作失败，因为自动载入器的门是打开的。清理自动加载器门旁边的障碍物，弹出介质盒，然

后重新插入。如果没有清除故障，请将自动载入器关闭然后重新开启。

该操作已失败，因为驱动器中的磁带已拍了快照。扔掉旧的磁带。请用一盒不同的磁带重新开

始操作。

Selected Device （选定驱动器）列表是空的！

服务器已经存在！

服务器名不能为空或者只包含任何空格。

您选择的服务器可能已关闭。

设置配置失败，因为与另一个操作发生冲突。

设定配置失败。

该盒式磁带不是数据级的。任何备份到该磁带的数据都处于危险中。驱动器无法读取 MRS 条
带。请用一盒数据级磁带替换这盒磁带。
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磁带机有硬件故障，该故障与读取 / 写入无关。关闭然后打开磁带驱动器，重新开始操作。如
果问题仍存在，请与磁带机供应商帮助热线联系。

磁带机有硬件故障。弹出磁带或介质盒，重置驱动器 （按下卸载按钮，保持 5 秒钟），然后重
新开始操作。

磁带机的 SCSI 接口有问题。请检查电缆和电缆连接，然后重新开始操作。

磁带机到了应该进行定期清洗的时候。等待当前的操作结束，然后使用清洁磁带。

磁带机在读取数据时遇到问题。没有丢失任何数据，但是磁带的容量减少了。

磁带机需要清洗。如果操作已停止，则弹出磁带并清洁驱动器。如果操作尚未停止，则等待操

作结束，然后清洁驱动器。

驱动器中的磁带是用于清洗的盒式磁带。如果希望进行备份或恢复，请插入数据级磁带。

磁带已损坏或驱动器发生故障。驱动器无法再从磁带读取数据。

请打电话给磁带供应商帮助热线。  

该磁带来自一个有故障的批次或者磁带机有故障。请使用好磁带来测试驱动器。如果问题仍存

在，请与磁带机供应商帮助热线联系。

磁带操作失败。弹出然后重新插入磁带或介质盒。

WWN 必须是一个小于 16 个字符的十六进制字符串。

没有可配置的磁盘。

没有要管理的 LD/LV。

没有足够的可用磁盘用于添加新的 LD/LV，或者没有可用的 LD 用于创建 LV。 LD 必须取消
映射并且必须删除分区才能用在 LV 中。

存在一个以上主机的映射，因此无法取消选择 “Map to Multiple Hosts”（映射到多个主机）
属性。在更改此设置前，删除到多个主机的映射。

自动载入器机制有问题。载入器机制已检测到硬件故障。

没有备用或替换驱动器。重建无法继续。

这可能导致数据丢失。

此操作最多要一分钟。

此操作可能需要几秒钟。请稍候 ...

此操作将添加到现有配置。

此操作将会删除所有现有的配置和数据。

无法为阵列查询分配内存。无法监视该阵列。

无法确定本地主机，正在终止！

因为磁带机在使用中，所以无法弹出盒式磁带。请等待，直到操作完成，然后再将盒式磁带弹
出。
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无法查询 RAID 控制器。

无法查询 SAF-TE 设备。对该附件的 SAF-TE 监控已被禁用。

无法查询磁带设备。该设备将被删除。

无法对位于 [Channel:Target] 的设备发出 Self-Reliability Query （自我可靠性查询）。

无法记录事件。

无法打开绑定文件或者不存在绑定。请检查绑定文件。

无法打开 I/O 传输层

无法查询 TapeAlert 日志数据。该设备的 TapeAlert 监视已禁用。

无法读取许可证数据。

无法读取来自 SMTP 服务器的答复。

无法将电子邮件发送到 SMTP 服务器。

无法切换 SAF-TE/SES 受控机箱的扬声器。

无法验证 SMTP 服务器的收件人。

无法写入许可证数据。

未定义错误 (Ch:%d,Id:%d)。请与技术支持人员联系。

意外中断连接 (Ch:%d,Id:%d)。请检查驱动器安装、电缆和 I/O 模块。根据需要进行更换。

从目标接收到意外的传感数据 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。可能是驱

动器插槽有缺陷。

从目标接收到意外单元强调 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。可能是驱动

器插槽有缺陷。

未映射 LUN，对主机不可用

用户名为空。

等待互斥失败。

写入配置文件时出错。

传真号码格式错误。

电话号码格式错误。

必须首先删除索引号较大的分区的主机映射，然后才可以更改该分区。

必须首先删除此 LD/LV 的主机映射，然后才可以删除 LD/LV。

必须首先删除最后一个分区的主机映射，然后才可以添加新的分区。

必须有超级用户 / 管理员特权才能运行此程序。正在退出 ...
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安装和程序提示
表 G-35 包含安装和程序提示列表 . 

表 G-35 安装和程序提示

安装和程序提示

找到了该软件包的一个现有配置。是否要将其进行恢复？

是否确实要继续？

是否确实要删除日志文件？

是否删除陷阱？

是否覆写该文件？

是否确实要重建驱动器？

确实要恢复工厂默认值吗？

在开始使用 SUNWsscsConsole 之前，请运行 
/opt/SUNWsscs/sscsconsole/config_sscon 输入默认 Web 浏
览器的路径名，以便访问 HTML 帮助文件。

开始将固件下载到设备。是否继续？

无法找到 Java 运行时环境 $JRE_MAJOR.$JRE_MINOR 或更高版本！

SUNWsscs Console 需要 JRE 1.2 或更高版本才能运行。控制台将试
图在 /usr/java、 /usr/jre、 /usr/local/java 或 
/usr/local/jre 中找到 JRE。如果是在上述目录以外的某个目录中
安装了 JRE，则须进行链接。

直到重置控制器后，对该设置所做的更改才会生效。在复位控制器之
前，此操作可能不会正常进行。是否重置控制器？

单击 “查看”选择一个文件。

是否将固件下载到控制器？

是否将带有引导记录的固件下载到控制器？

是否保存当前的事件日志文件？

要设置邮件服务器吗？

请输入联系人姓名。

请输入用户名。

请输入位置。

请输入邮件地址。

请输入系统 ID。
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输入有效的网关地址。

输入有效的 IP 地址。

输入有效的网络掩码。

请输入 SMTP 服务器信息。

请输入 SMTP 服务器信息。

请输入登录口令。

请输入 ssconfig 用户口令以登录。

在安装控制台之前须安装 JRE 1.2.2、 1.3 或 1.4。

向控制器发出重置命令吗？

存在已映射的 LUN！创建新 LD/LV 之前必须删除它们。如果继续，
此操作将改写当前配置。这将会导致所有现有的 LD/LV 被删除及所

有数据被丢失！如果要保留当前配置，请使用“Add LDs/LVs to the 
Current Configuration”（向当前配置中添加 LD/LV）选项。是否继

续？

请选择一个 LD/LV！

请选择 CH/ID。

请选择要扫描的通道 /ID。

请在命令行或 ssdgrcli.cfg 中至少指定一个 SSCS 代理。

删除软件包 @PKG_NAME@，然后尝试安装该软件包。

选择一个 LD/LV。

在下载固件之前请选择产品 ID。

选择引导记录文件。

选择配置文件。

选择 AM 或 PM。

选择固件文件。

仅选择一个 LD/LV！

仅选择一行以对其进行编辑。

仅选择一行以将其删除。

选择服务器以映射控制器。

单击 “删除”前请选择代理。

单击 “编辑”前请选择代理项。

请选择要扫描的驱动器的通道 /ID

表 G-35 安装和程序提示 （续）

安装和程序提示
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选择要下载的固件文件

选择逻辑驱动器。

单击 “编辑”前请选择服务器项。

单击 “删除”前请选择服务器项。

选择开始日期。

选择超时 (Ch:%d,Id:%d)。很可能是驱动器放置不当或有缺陷。如果
是随机驱动器，则有可能是有 I/O 模块故障或电缆故障。

指定映射信息。

SUNWsscsConsole 需要 JRE 1.2.2、 1.3 或 1.4 才能运行。控制台将

试图在 /usr/java、 /usr/jre、 /usr/local/java 或 
/usr/local/jre 中找到 JRE。如果是在上述目录以外的某个目录中

安装了 JRE，则须进行链接。

客户端只会在正在运行时接收事件。是否确实要退出？

周期陷阱的内容不能是 “事件”。请选择另一个。

需要重置控制器才能使新固件生效。是否重置控制器？

您输入的密钥在开头或结尾包含多余的空格，这可能会导致加密错

误。是否继续？

这可能导致数据丢失。是否确实要移动？

此操作将改写当前配置。这将会导致所有现有的 LD/LV 被删除及所
有数据被丢失！如果要保留当前配置，请使用“Add LDs/LVs to the 
Current Configuration”（向当前配置中添加 LD/LV）选项。是否继
续？

此操作将改写当前配置。这将会导致所有现有的 LD/LV 被删除及所
有数据被丢失！如果要保留当前配置，请使用“Add LDs/LVs to the 
Current Configuration”（向当前配置中添加 LD/LV）选项。是否继
续？

该操作将导致所有逻辑驱动器上的现有控制器设置和数据丢失。确实
要恢复出厂默认值吗？

该操作将会导致所有已修改分区上的数据丢失。是否继续？

要确定当前安装的 Java 版本，请键入 “java-version”

陷阱信息已被修改。是否保存更改？

您选择了 “Event”（事件）作为陷阱类型 , 因此必须至少选择一个活
动陷阱事件。 

表 G-35 安装和程序提示 （续）

安装和程序提示
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您选择了 “My SMTP server needs authorization”（我的 SMTP 服
务器需要授权），因此，您必须输入口令。

您选择了 “My SMTP server needs authorization”（我的 SMTP 服
务器需要授权），因此，您必须输入用户名。

您选择了 “use encrypt”（使用加密），因此必须输入一个密钥。

表 G-35 安装和程序提示 （续）

安装和程序提示
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词汇表

本附录列出缩略语并定义文档中出现的 RAID 术语。其中还包括对磁盘驱动器、逻辑驱
动器和冗余控制器的操作状况的定义。 

缩略语
ANSI 美国国家标准学会。

CH 通道。

CISPR 国际无线电干扰特别委员会。 

EMU 事件监控单元。

FC-AL 光纤通道仲裁环路 FC-AL 作为环路或光纤实施。环路可包括达 126 个节点，可通
过仅一台或两台服务器访问这些节点。 

FRU 现场可替换单元。

GB 千兆字节 （吉字节）。 10 亿 （1,000,000,000）字节。 

GBIC 千兆位接口转换器可热交换的输入 / 输出设备，能插入千兆位以太网端口或光纤
通道。

HBA 主机总线适配器。

ID 标识号。

IEC 国际电工技术委员会。

JBOD 简单磁盘捆绑 （阵列单元，带驱动器、没有控制器）。

LAN 局域网。

LD 逻辑驱动器。

LUN 逻辑单元号。 SCSI 通道上使用的唯一标识符，使主机能够区分各个设备。
267



LVD 低噪音、低功率、低振幅信令系统，实现支持的服务器和存储设备之间的数据通
信。 LVD 信令技术使用两根电线在铜线上传送一个信号，需要的电缆长度不应超
过 25 米 （82 英尺）。 

MB 兆字节。百万字节 (1,000,000) 或字符的数据。 

NVRAM 非易失性随机存储器。一个配备有电池的存储单元；因此即使在主电源切断后，
数据仍然保持完整无损。

PID 主控制器标识号。

RAID 独立磁盘的冗余阵列。一种配置，其中多个驱动器组合成单个虚拟驱动器以提高
性能和可靠性。

SAN 存储区域网络。存储设备和服务器的高速度、实行开放标准的可缩放网络，提供
对数据的加速访问。

SCSI 小型计算机系统接口。磁盘和磁带设备与工作站连接的行业标准。

SES SCSI 机箱服务驱动程序。与 SCSI Enclosure Services 设备的接口。这些设备能感
知和监控机箱内的物理状况，并且使访问机箱的状态报告和配置特性 （如机箱上
的标示器 LED 指示灯）成为可能。

SID 辅助控制器标识号。

S.M.A.R.T. 自监控分析和报告技术。这是 IDE/ATA 和 SCSI 两种硬盘驱动器的行业标准可靠
性预测标示。带 SMART 标示的硬盘驱动器能提供某些硬盘故障的早期警告，因
此能保护关键性数据。 

SMTP 简单邮件传输协议。在服务器之间或从邮件客户机向邮件服务器发送电子邮件的
协议。然后可以用使用 POP 或 IMAP 的电子邮件客户机检索邮件消息。 

SNMP 简单网络管理协议。管理复杂网络的一组协议。 SNMP 向网络的不同部分发送消
息 （称为协议数据单元，简称 PDU）。符合 SNMP 标准的设备 （称为代理）在
管理信息库 (MIB) 中存储与它们自己有关的数据，然后将数据返回给 SNMP 请求
者。 

WWN 全球广域名称。用以标识阵列系统和使用 Solaris 操作环境的系统中的阵列卷的编
号。

名词术语
channel 在存储设备和存储控制器或 I/O 适配器之间用以传输数据并控制信息的任何通

路。也指磁盘阵列控制器上的一个 SCSI 总线。各个磁盘阵列控制器提供至少一
个通道。

LUN 屏蔽 使管理员能将 HBA 动态地映射到指定 LUN 的特性。这就提供了个别服务器或多
台服务器对个别驱动器或多个驱动器的访问，并能禁止非期望的服务器对同样这
些驱动器的访问。

LUN 映射 改变虚拟 LUN 从存储器呈现给服务器的能力。这样做的益处包括服务器从 SAN 
启动而不需要本地磁盘驱动器。每台服务器需要 LUN 0 来启动。
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N 端口 点对点或光纤连接中的光纤通道端口。

partition 磁盘存储空间的一部分，也称作系统驱动器或 LUN，这在主机看来是单独的物理
驱动器。逻辑驱动器可以位于一个或多个物理驱动器上。

RAID 独立磁盘的冗余阵列。一种配置，即将两个或更多的磁盘驱动器配置为协作以提
供更多的磁盘存储空间、更好的性能以及 / 或者数据冗余备份。这些特性的各种
组合，是通过经过定义的 RAID 级别加以说明的。有关 RAID 级别的详细描述，
请参阅第 179 页的 “RAID 基本知识”。

背景率 背景率是分配给阵列管理活动 （如重建故障驱动器、检查奇偶校验、初始化）的
可用阵列控制器 CPU 时间的百分比。如果 background rate 设置为 100%，阵列
管理活动比其他系统活动具有更高的优先级。如果为 0%，则只有在阵列控制器上
没有其他活动时才会进行阵列管理活动。

备用驱动器 标为备用的驱动器，在与逻辑驱动器相关的物理驱动器发生故障后用以支持自动
重建数据。对于要替换其他驱动器的备用驱动器，其大小必须至少与故障驱动器
的大小相等。另外，故障驱动器本身也必须来自 RAID 1, 3, 5 或 1+0。

重建 重建磁盘是在磁盘故障以前重构磁盘上数据的过程。重建操作只能在具有数据冗
余的阵列上执行。

请参阅第 272 页的 “自动重建”以获得更多有关重建的信息。要获得有关重建率
的信息，请参阅第 269 页的 “背景率”。

带区大小 这是在逻辑驱动器中每个物理驱动器上进行带区化的数据量 （以千字节计）。数
值为 8 千字节的增量，范围从 8 至 64 千字节。一般情况下，大的带区对于具有基
本顺序读取的系统更有效。

要改变现有驱动器上的带区大小，需要对数据备份、重新定义带区大小、重新配
置存储器并重新存储所有数据。

带区化 在逻辑驱动器中所有不同的 SCSI 驱动器上存储顺序进入的数据块。例如，在逻
辑驱动器中有三个 SCSI 驱动器，数据会按以下方式存储：

数据块 1 在 SCSI 驱动器 1

数据块 2 在 SCSI 驱动器 2

数据块 3 在 SCSI 驱动器 3

数据块 4 在 SCSI 驱动器 1

数据块 5 在 SCSI 驱动器 2，等等。

数据的这个写方法能增加磁盘系统的吞吐量，因为多个驱动器同时在工作、检索
并存储。 RAID 0, 3, 5, 1+ 0 全都采用带区化。

带外 指不在数据通路中的连接和设备。
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读策略 读策略说明如下：

如果指定 No Cache 读策略，控制器不在读高速缓冲存储器中存储数据。

Normal 指定当前控制器不对当前驱动器使用预读高速缓存。

将读策略设为 Read Ahead，控制器将自动读取多个相邻的数据块。对于顺序读
取应用，这是最有效的。

高速缓存 允许数据存储在磁盘上预先指定的区域或 RAM （随机存取内存）。高速缓存用
于加快 RAID 系统、磁盘驱动器、计算机和服务器或其他外围设备的操作。

光纤网 在一个或多个交换机上构建的光纤通道网络。

光纤交换机 光纤网络交换机相当于一个路由引擎，它主动引导数据从源头传递到目的地，并
仲裁每个连接。当添加更多节点时，通过光纤交换机每个节点的带宽保持不变，
交换机端口上的节点使用高达 100MBps 的数据路径来发送或接收数据。

光纤通道 部署在各种各样硬件之上物有所值的千兆位通信链接。

故障转移 容错系统的一种操作模式：一个组件发生故障时，其功能由冗余组件承担执行。

回写高速缓存 这是一项高速缓存写策略，阵列控制器接收将写入磁盘的数据，将数据存储在内
存缓冲区中，并立即向主机操作环境发送信号，表示写操作已完成，不必等待数
据实际写入磁盘驱动器。在很短时间内，当控制器不繁忙时，控制器即将数据写
入磁盘驱动器。

回写高速缓存功能提高了写操作的性能和控制器卡的吞吐量。然而，由于在发生
电源故障情况下有丢失数据的危险，使用回写高速缓存的存储系统配备有 UPS 或
电池备用高速缓存。 UPS 提供足够长时间的电源，使高速缓冲存储中的所有数据
能够写入磁盘驱动器。使用电池备用高速缓存，电池能够提供电源让内存数据保
留长达 48 小时。

伙伴组 一对互连的控制器单元。与这对控制器单元互连的扩展单元也可以是伙伴组的一
部分。

活动 - 活动控制器 一对组件，例如在两者正常工作时共享一项或一组任务的容错存储系统中的存储
控制器。当其中一个组件发生故障时，另一个承担起整个负载。双现用控制器连
接同一组设备，提供的 I/O 性能和容错组合能力比单个控制器高。

奇偶校验 检查容错阵列 (RAID 1, 3, 5, and 6 or 1+0) 上冗余数据完整性的过程。逻辑驱动
器上的奇偶校验过程会重新计算每个逻辑驱动器的 RAID 带区集中的数据带区的
奇偶校验，并将其与存储的奇偶校验比较。如果发现差异，则报告错误，新的正
确奇偶校验替代存储的奇偶校验。

镜像 (RAID 1) 写入一个磁盘驱动器的数据同时写入另一个磁盘驱动器。如果一个磁盘发生故
障，可使用另一个磁盘运行系统并重构故障磁盘。磁盘镜像的主要长处在于 100% 
数据冗余。因为镜像了磁盘，如果有一个磁盘出故障就无关紧要。所有时候，两
个磁盘都包含相同的数据，哪一个都可以起操作盘的作用。

磁盘镜像提供 100% 数据冗余，但由于需要复制系统中的每个驱动器，因而代价
昂贵。
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卷 也称为逻辑单元号或 LUN。卷是一个驱动器或能组合成一个数据存储单元的多个
驱动器。

可热交换 （的） 当系统保持通电并可操作时，取出并替换现场可替换单元 (FRU) 的这种能力。

跨越 磁盘跨越利用固件的带区化功能，在两个本来是独立的 RAID 逻辑驱动器上进行
数据带区化。跨越的这两个逻辑驱动器作为一个逻辑驱动器呈现给操作环境。这
样做的长处在于：

支持组合容错逻辑驱动器中两个驱动器同时发生故障 （前提为每个逻辑驱动器中
有一个驱动器故障）。

由于增加了主轴数量而提高了性能。

其缺点在于：由于各个逻辑驱动器分别处理容错而增加了冗余 RAID 级别的 
RAID 总开销。

逻辑驱动器 一个独立物理驱动器阵列，在主机看来就像一个大驱动器。

热备用 （驱动器） RAID 1 或 RAID 5  配置中的驱动器不包含任何数据，在另一个驱动器发生故障
时起备用作用。

容错 处理内部硬件问题而并不中断数据可用性的能力；常用方法是在检测到故障时使
用已联机的备份系统。许多存储系统使用 RAID 架构给予在单个磁盘驱动器故障
时防止丢失数据的保护，从而提供容错。使用 RAID 1 （镜像）、 RAID 3 或 5
（带奇偶校验的带区化）或 RAID 6 或 1+0 （镜像和带区化）技术，阵列控制器
可从故障驱动器重建数据，并将它写入备用或替代驱动器。

容错逻辑驱动器 在单个驱动器发生故障的情况下，通过使用 RAID 1, 3, 5, 或 6 （也称为 RAID 
1+0）提供数据保护的逻辑驱动器。

物理阵列 物理阵列是 Configuration Service 中参与一个或多个逻辑驱动器的一组物理驱动
器。如果一组物理驱动器配置为并不使用物理驱动器总容量的逻辑驱动器，
Configuration Service 要求同一个驱动器物理阵列与在创建使用其余容量的其余
任何逻辑驱动器中一起使用。

当剩余的驱动器容量是在多个物理驱动器上而后者已被用于创建一个逻辑驱动器
时，在 New Configuration 窗口中， Add Disk 按钮更改为 Add Array。鉴于物
理驱动器已被分片，就不得不将其作为一个阵列来选择。无法对其分别进行选
择。

写策略 用以控制系统写操作的高速缓存写策略。写策略选项包括 write-back （回写）和 
write-through （直写）高速缓存。

直写高速缓存 一项高速缓存写策略，阵列控制器在向主机操作环境发送信号表示过程已完成之
前，即将数据写入磁盘驱动器。直写高速缓存的写操作和吞吐量性能比回写高速
缓存低；但是，在发生电源故障情况下丢失数据的危险也极小。

终端器 用于结束 SCSI 总线的部件。终端器通过吸收无线电频率信号来防止能量反射回
电缆线路。
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状况 磁盘驱动器、逻辑驱动器或冗余控制器的当前操作状态。存储系统在其非易失性
内存中存储驱动器、逻辑驱动器和冗余控制器的状况。该信息在系统供电中断时
仍保留。

自动重建 在驱动器发生故障后自动重构数据并写入备用驱动器的过程。手动安装新的驱动
器以替代故障驱动器后，也会进行自动重建。若重建进程因重置而中断，请使用 
Array Administration → Rebuild 来重新启动重建进程。

组 组是新的数据对象，允许在单个类别下包含多台服务器，与域的概念相似，允许
用户在 Configuration Service 内组织服务器。代之于所有受管服务器的线性树，
Configuration Service 操作员可以将服务器组织成相似的集或组。

组不是必需的。例如，可以配置 Configuration Service 为无组而有 15 台服务器，
或者一个组其下有 10 台服务器而顶层另有 5 台服务器。 Configuration Service 
允许任何组合。

许可的组数和组内服务器的数量仅受到可用系统内存的限制。如果服务器是一个
组成员而用户从组列表框删除了该组， Configuration Service 将组内的服务器重
新分配给无组类。 Configuration Service 自动地重新映射主窗口的树。
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索引
A
Add Server 窗口 , 40

Add Server Grouping 选项卡 , 43

Agent Options Management 命令 , 111
Alarm State, 110

重新设置 , 110

Array Admin Progress 窗口 , 111

Array Admin Progress 命令 , 127, 131, 132, 133

Assign Server to Manage RAID Controller 窗口 , 47
Auto Discovery

按钮 , 41
过程 , 96
选项 , 97

Available Servers 列表

编辑 , 177

安装
Linux 操作环境中的 Sun StorEdge Configuration 

Service
安装软件包列表 , 27
默认目录 , 29
在开始这些步骤之前 , 26

Solaris 操作环境中的 Sun StorEdge 
Configuration Service
安装软件包列表 , 7
恢复配置 , 15
默认目录 , 11
在开始这些步骤之前 , 3

Windows 上的 Sun StorEdge Configuration 
Service
可执行文件清单 , 19

默认目录 , 20
在开始这些步骤之前 , 18

B
白色设备状态项目 , 93

保存控制器参数更改 , 163

保存逻辑驱动器配置 , 55, 79

背景率
定义 , 269

备用驱动器 , 269
实现 / 更改 , 176

本地备用驱动器
定义 , 180
与全局备用驱动器比较 , 191

编辑
可用服务器 , 177

标准配置 , 62

C
Cache 选项卡 , 166

Channel 选项卡 , 163

Clear 按钮

配置 , 76

Controller Array Progress 窗口 , 132, 133

Controller Assignment 命令 , 45
273



Controller Maintenance Options 窗口 , 137, 138, 
157, 175

Custom Configuration, 65

Custom Configuration 图标 , 37

菜单栏
概述 , 36

参数
控制器 , 162

成员驱动器
复制并替换 , 154

重建
备用驱动器 （自动） , 131
定义 , 269
故障驱动器 , 131
没有备用驱动器 , 132
手动处理驱动器 , 132

重建优先级 , 169

重新设置
控制器 , 136

词汇表 , 267

磁盘空间
Sun StorEdge Configuration Service Agent, 6, 26
要求

Sun StorEdge Configuration Service 
Console, 6, 25

存储
通过 Web 进行管理 , 123

浏览器要求 , 123

错误代码 , 231
超时错误 , 241
初始化状况错误 , 237
磁带状况错误 , 235
磁盘状况错误 , 234
打开传输错误 , 238
服务器管理 / 监控事件错误 , 246
固件下载错误 , 242
关闭传输错误 , 239
管理错误 , 241
客户端参数错误 , 238
控制器事件错误 , 243
逻辑驱动器事件错误 , 245
命令代码错误 , 240
内部状况错误 , 237
内存分配错误 , 239

驱动器侧事件错误 , 244
RDP 路径更改错误 , 243
冗余状况错误 , 236
SAF-TE 状况错误 , 235
设备状况错误 , 237
通信安全错误 , 241
通信链路错误 , 240
系统关闭错误 , 242
系统驱动器状况 , 234
异步通信错误 , 240
主机侧事件错误 , 245
主要通信错误 , 240
传输字段错误 , 239

错误消息 , 246

D
DHCP 环境 , 225

Disk Access Latency 字段 , 170
Disk Administrator, 58

Disk Array 选项卡 , 169

Display HDD under LD 复选框 , 38

Drive Check Period （Sec）字段 , 171

Drive I/F 选项卡 , 170

代理
Agent Options Management 窗口 , 50, 195
操作 , 96
可配置参数 , 50
平台 , 2
Setting Agent Options 窗口 , 52
SNMP 代理 , 219
Sun StorEdge Configuration Service

安装在 Windows 上 , 19
在 Linux 操作环境上安装 , 27
在 Solaris 操作环境上安装 , 8

Windows 安装 , 19
选项管理 , 111
在 Linux 操作环境上启动 / 停止 , 29
在 Solaris 操作环境上启动 / 停止 , 12
在 Windows 2000 上启动 / 停止 , 20
在 Windows NT 上启动 / 停止 , 20

带区大小
定义 , 269
274  Sun StorEdge 3000 系列 Configuration Service 1.3 用户指南 • 2003 年 6 月



带区化
定义 , 269

带外
存储管理 , 118

导航 , 38

登录 , 44

电池
状态 , 102

电子邮件
Mail Address 条目框 , 213
Mail Server Setup 窗口 , 214
Mailing Lists 高亮显示 , 213
Mailing Lists 选项卡 , 41
Severity 条目框 , 213
SMTP 电子邮件消息 , 211
添加服务器 , 214
消息 , 212
邮件列表 , 213

调度
奇偶校验 , 129

读策略类型 , 270

E
Enclosure Info 选项卡 , 104

F
FC-AL

定义 , 267
FRU

定义 , 110
ID，获取 , 110

分配控制器
通过控制台 , 45

分区 , 78, 150
现有逻辑驱动器 , 148
要求 , 68

蜂鸣器
静音 , 137, 175

复位按钮 , 228

服务器

Add Server 窗口 , 40, 178, 212, 213
Available Servers 列表 , 177, 212
编辑 , 177
Edit Server 窗口 , 177, 178, 212, 225
服务器的 TCP/IP 地址 , 40
服务器列表设置过程 , 39
服务器设置 , 225
更改分配 , 48
管理 , 43
库存 , 96
Managed Servers 列表 , 178, 225, 226
Server List Setup 窗口 , 226
Server List Setup 功能 , 205, 212
Server List Setup 命令 , 177
Server List Setup 图标 , 37
Server Login 窗口 , 44
Server Setup 窗口 , 177, 212, 226
设置以发送陷阱 , 215
使用终端手动删除管理服务器 , 49, 138
添加到 Managed Servers 列表 , 39
添加服务器属性 , 40
通过控制台分配给控制器 , 45
View Server 窗口 , 100
View Server 命令 , 100
组织到组中 , 43

服务器不响应 , 223

服务器分组 , 43

复制
成员驱动器 , 154

G
GBIC

定义 , 267

格式 , 58

更改控制器参数 , 162
Cache 选项卡

优化 , 168

更改设置按钮 , 163

更改通道设置窗口 , 163

更改主机 LUN 分配 , 77

工具条图标 , 36
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固件
升级

控制器 , 157
SAF-TE 设备 , 161
SES 设备 , 161
硬盘驱动器 , 160

故障排除 , 223
Java 版本 , 224
另请参阅 错误代码

另请参阅错误消息

故障驱动器重建 , 131

管理工具组 , 57

H
HBA

双端口
主窗口 , 100

HBA 设备

手动添加 , 84

Host I/F 选项卡 , 172

Host LUN Assignments 框 , 78
HP OpenView, 211, 219

故障排除 , 227
警告 , 215

红色设备状态项目 , 93

忽略了 ssmon 密码 , 41

环境
未报告警报 , 228
状况 , 109

黄色设备状态项目 , 93

恢复
逻辑驱动器配置 , 134

恢复逻辑驱动器配置 , 134

灰色设备状态项目 , 93

回写高速缓存
定义 , 270
启用 , 168

I
IBM NetView, 215

IP 地址

群集配置 , 205
用于陷阱 , 217
在 DHCP 环境中已更改 , 225

Issue Controller Reset 复选框 , 163, 174

J
Java

版本
检查 , 224

JBOD
单总线配置 , 195
更换故障驱动器 , 200
监控 , 195, 201
升级 SAF-TE 设备的固件 , 199
升级硬盘驱动器上的固件 , 198
双总线配置 , 196

简单邮件传输协议 (SMTP), 214

监控过程 , 96

将分区映射到 LUN 的说明 , 184

警告
新建配置 , 69

镜像 (RAID 1), 270

卷标
自动写入 , 73

K
可用 SCSI ID 列表框 , 164

控制器
参数

更改 , 162
从双控制器转换为单控制器 , 138
更改服务器分配 , 48
恢复联机 , 137
静音 , 137
事件错误 , 243
通过控制台分配管理服务器 , 45
选择服务器来管理 , 45
重新设置 , 136, 163

控制器参数
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保存更改 , 163

控制台
电子邮件设置 , 212
平台 , 2
Sun StorEdge Configuration Service

安装在 Windows 上 , 19
在 Linux 操作环境上安装 , 27
在 Solaris 操作环境上安装 , 8

设备未显示 , 227, 228
Windows 安装 , 19
Windows 要求 , 18
运行缓慢 , 228

跨越 , 271

扩展
逻辑驱动器的容量 , 151
partition, 151

L
Linux 操作环境

/etc/init.d/ssagent start/stop, 29, 30
/opt/SUNWsscs/ssconsole 目录 , 32
创建用户 / 密码 , 30
passwd 命令 , 31
ps -e | grep ss 用于获得进程号 , 30
启动 / 停止代理 , 29
service ssagent status, 30
SNMP 陷阱 , 218
sstrapd, 30
使用 rpm 卸装 , 32
停止控制台 , 35
系统要求 , 25
卸装 , 32
用户 / 密码 , 30

LUN, 56
定义 , 181
更改主机 LUN 分配 , 76
Host LUN Assignments 框 , 78
LUN 详细信息 , 102
删除 , 78
添加 , 77

LUN 分配

最多 , 62, 71, 77

LUN 过滤器

访问 LUN Filter 视图 , 83
概述 , 81
将逻辑驱动器映射到主机 , 87
删除标准映射 , 86
手动添加 HBA 设备 , 84

LUN 过滤器属性 , 86

LUNs Per Host 字段 , 172

联机帮助 , 93
为 Linux 指定浏览器 , 28
为 Solaris 指定浏览器 , 11

浏览器要求
通过 Web 管理存储设备 , 123

轮询
设备的状态更改 , 50

逻辑卷
创建 , 74, 143
定义 , 180
列出的逻辑驱动器 , 225

逻辑驱动器
保存配置 , 55
创建分区 , 148
大于 253 Gb, 68
定义 , 180, 271
各 RAID 级别的驱动器最大数量 , 70
恢复配置 , 134
扩展容量 , 151
每个逻辑驱动器的磁盘的最大数量 , 167
每个逻辑驱动器的最大可用容量 , 167
Partitions 框 , 78
驱动器分配 , 182
删除 , 146
删除分区 , 150
添加 , 142
添加 SCSI 驱动器 , 153
View Logical Drive 窗口 , 109
View Logical Drive 命令 , 107
最大数量 , 62

逻辑驱动器号码 , 147

M
Major 字段 , 232
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Managed Servers 列表设置 , 43

Max Queued IO Count 字段 , 172
MIB, 220
Microsoft Cluster Server (MSCS), 201

Minor 字段 , 233

mountall 命令 , 57

密码
Linux 操作环境

创建 , 31
Solaris 操作环境

创建 , 14
Windows

创建 , 21

N
network

DHCP, 174
静态 IP, 174
RAAP, 174

Network 选项卡 , 174

New Configuration 窗口

Add Disk 按钮 , 271

newfs 命令 , 57

NT 群集选项 , 63
NTFS, 203

内存
要求

代理 , 6, 26
Sun StorEdge Configuration Service 

Console, 6, 25
Windows 上的 Sun StorEdge Configuration 

Service Console, 18

O
Out-of-Band Agent preferred over In-Band 复选框

, 120

P
partition

创建 , 148
Solaris, 57
Windows, 57

删除 , 150
performance statistics, 139

Physical Drive Standby State 窗口 , 176
pkgrm, 15

Power Up SCSI Reset 字段 , 170

Product ID 列表框 , 160

配置
保存 , 55, 79
保存逻辑驱动器配置 , 79
标准配置 , 62, 63
Change Host LUN Assignments 窗口 , 77
clear 按钮 , 76
Confirm Configuration Operation 窗口 , 64
Custom Configuration, 65
Custom Configure 命令 , 162, 176
定制配置 , 65
恢复 , 134
加载 , 134
警告 , 61
Load Configuration Confirmation 窗口 , 136
Load Configuration 窗口 , 135
Logical Drive Partitions 框 , 78
逻辑驱动器

保存 , 55
New Configuration 警告 , 69
New Configuration 选项 , 66
NT 群集选项 , 63
清除 , 76
Saveset Description 选项卡 , 135
Security Configuration 窗口 , 216
Security 选项卡 , 216
Standard Configuration 窗口 , 63
设置陷阱 , 216
使用备用驱动器复选框 , 63
新

使用之前 , 67
新建配置 , 69
选择 Configuration File 窗口 , 134
选择 RAID 级别 , 67
验证 , 53
注销 ssconfig, 76
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Q
启动

Sun StorEdge Configuration Service, 34

奇偶校验 , 128, 270
调度 , 129

启用动态 IP 分配 , 174

驱动器
复制并替换 , 154
Physical Drive Standby State 窗口 , 176
扫描新的 , 156
实现 / 更改备用 , 176
重建 , 132

驱动器重建 , 131, 132

取消映射
LUN, 78

全局备用驱动器
定义 , 180
与本地备用驱动器比较 , 191

全球广域端口名称
确定 , 210

全球广域节点名称
确定 , 209

全球广域名称
定义 , 268
确定 Solaris OE, 207
在 Linux 中确定 , 208
在 Windows NT/2000 中确定 , 208

群集配置
CLUSTER.TXT, 204
规划 , 201
IP 地址 , 205
Microsoft Cluster Server 软件 , 202
启动 Sun StorEdge Configuration Service, 202, 

204
设置 , 202
要求 , 202

R
RAID

Enclosure Info 选项卡窗口 , 104
RAID 控制器参数 , 104, 107
View Controller Configuration 命令 , 101

术语概述 , 179

RAID 词汇表 , 267

RAID 级别

定义 , 269
分配给逻辑驱动器 , 64

RAID 撰梗
RAID 0, 186
RAID 1, 186
RAID 1+0, 188
RAID 3, 189
RAID 5, 189
支持的磁盘 / 逻辑驱动器的范围 , 185

Rebuild 窗口 , 133

Redundancy 选项卡 , 173

Redundant Deassert Reset 字段 , 173

Redundant Force Pri Fail 字段 , 173

Redundant Force Sec Fail 字段 , 173

Report 图标 , 37

report 选项 , 115, 118

Reset 按钮

alarm state 框 , 110
rpm, 32

RS 232 选项卡 , 165
RSAGENT.DLL, 227

RST_OID.MIB 文件 , 219, 226

容错 , 271

容量
扩展 , 151

S
SAF-TE 轮询时间长度 （秒）字段 , 171

Save Configuration 窗口 , 56

Save Configuration 功能 , 55, 79

Save Report File 窗口 , 115

Save Report 命令 , 115

Saveset Description 选项卡 , 135

SCSI I/O 超时 （秒）字段 , 171

SCSI Motor Spin Up 字段 , 170

SCSI 驱动器

添加到逻辑驱动器 , 153
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SCSI 通道

定义 , 180

Select Controller Progress 窗口 , 132

Server List Setup 窗口 , 177

Server Setup 窗口 , 178

Service Configuration 窗口 , 216
SES

定义 , 268

Set Controller Config 字段 , 173

Severity 字段 , 231

SMART Drive 字段 , 108

SMART 监控

启用 , 51

SMTP 电子邮件消息 , 211
SN#, 92
SNMP

安全性 , 220
代理和管理器 , 219
服务选项 , 6, 18, 26
工作方式 , 218
管理信息库 , 220
MIB 变量的对象标识符 , 221
请求类型 , 220
软件模型 , 219
V1, 220
协议数据单元 (PDU), 220
识别对象 , 220

SNMP 陷阱

设置 , 215
消息说明 , 218

Solaris
ssserver, 12, 30
Sun StorEdge Configuration Service

安装在 , 8, 27

Solaris 操作环境
/etc/init.d/ssagent start/stop, 12
/kernel/drv/sd.conf, 11
/opt/SUNWsscs/ssconsole 目录 , 14
创建用户 / 密码 , 13
逻辑驱动器不存在 , 228
passwd 命令 , 14
pkgrm 用于卸装 , 15
ps -e | grep ss 用于获得进程号 , 12

启动 / 停止代理 , 12
rstrapd, 226
SNMP 陷阱 , 217
sstrapd, 12
停止控制台 , 35
系统要求 , 5
卸装 , 15
用户 / 密码 , 13
支持的版本 , 2

sscsagt.cfg.tar, 15
sscscon.cfg.tar, 15
ssserver, 12, 30
sstrapd, 12, 30

sstrapd 守护程序 , 217, 218

Standard Configuration 图标 , 37
Sun StorEdge Configuration Service

代理操作 , 96
登录 / 注销 , 44
概述 , 1
监控过程 , 96
控制台 , 91
启动 , 34
树视图 , 93
卸装

Linux 操作环境 , 32
Solaris 操作环境 , 15
Windows, 23

主窗口 , 91
SUNWscsd, 8, 27
SUNWscsu, 8, 27

SuperFlex 存储阵列 , 203

扫描
驱动器 , 156

删除 , 150
逻辑驱动器 , 146
partition, 150

设备
未在控制台显示 , 227, 228
详细视图信息 , 98
重建 , 132
状态 , 93

社区字符串
检查 , 215

升级
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固件
控制器 , 157
SAF-TE 设备 , 161
SES 设备 , 161
硬盘驱动器 , 160

事件日志 , 111
Event Log 窗口 , 112
eventlog.txt, 112
事件记录字段 , 114
事件日志文件 , 112
严重级别 , 114

事件日志 (E)
错误代码 , 231
Event Log 图标 , 37
Save Event Log 图标 , 37

事件消息
严重级别 , 42

使用备用驱动器复选框 , 63

树视图 , 93

顺序 I/O 优化

最大大小 , 166

随机 I/O 优化

最大大小 , 166

T
Tag Count Per drive 字段 , 171
TCP/IP, 17

建立连接 , 96
网络接口

要求 , 5, 25

探测 , 100

提示 , 262

添加
服务器 , 39
逻辑驱动器 , 142
SCSI 驱动器到逻辑驱动器 , 153
新设备

探测 , 100
主机 LUN, 77

添加服务器属性参数 , 40

通道模式列表框 , 164

通过 Web 管理存储设备 , 123

图标
带有盘式卫星天线的服务器 , 53
工具条

保存报告 , 37
保存事件日志 , 37
标准配置 , 37
Custom Configuration, 37
服务器列表设置 , 37
事件日志 (E), 37

状态 , 93

V
View CD-ROM 窗口 , 108, 109

View 菜单，详细信息 , 98

View Enclosure 窗口 , 109, 110

View Enclosure 命令 , 109
View FRU, 110

View FRU 窗口 , 110

View Report 命令 , 118

View Tape 窗口 , 109

W
Windows

2000 分区 , 58
创建 NT 用户 , 22
创建 Win2000 用户 , 22
创建系统用户 / 密码 , 20
代理安装 , 19
代理要求 , 18
控制台安装 , 19
控制台要求 , 18
NT 分区 , 57
Windows NT, 201
系统要求 , 17
卸装

Sun StorEdge Configuration Service, 23
用户 / 密码 , 21

Windows 2000
启动 / 停止代理 , 20

Windows NT
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启动 / 停止代理 , 20

Write a new label to the new LD 复选框 , 73, 136
WWN

定义 , 268

文档
本书的结构 , xvii

物理驱动器
在主窗口中显示 , 38

物理设备
查看物理驱动器 , 108
Physical Drives 选项卡 , 103
View Physical Device 窗口 , 108

物理阵列 , 271

X
系统用户密码的使用 , 41

陷阱
Community Name 对话框 , 216
服务器地址和名称 , 219
Internet 协议 (IP), 218
IP 地址格式 , 217
Microsoft SNMP Properties 窗口 , 216
OID （对象标识符） , 219
Service Configuration 窗口 , 217
SNMP 陷阱消息 , 218
事件日期 , 219
事件时间 , 219
事件严重性 , 219
Trap Destinations 列表 , 216, 217
Traps 选项卡 , 216
网卡名称 , 219
未从服务器接收 , 226
陷阱接收者设置 , 216
在 Linux 上 , 218
在 Solaris 上 , 217
传输控制协议 (TCP), 218

陷阱设置 , 215

陷阱守护程序
故障排除 , 227

陷阱消息 , 218

消息变量 , 246

消息术语 , 246

写策略
定义 , 271

卸装
Sun StorEdge Configuration Service, 15, 32

Linux 操作环境 , 32
Solaris 操作环境 , 15
Windows, 23

选项卡
描述 , 38

选择 Configuration File 窗口 , 55, 79

Y
验证配置 , 53

严重级别 （事件） , 114

要求
安装

Linux 操作环境中的 Sun StorEdge 
Configuration Service Agent, 26

Linux 操作环境中的 Sun StorEdge 
Configuration Service Console, 25

Solaris 操作环境中的 Sun StorEdge 
Configuration Service Agent, 6

Solaris 操作环境中的 Sun StorEdge 
Configuration Service Console, 6

Windows 上的 Sun StorEdge Configuration 
Service Agent, 18

Windows 上的 Sun StorEdge Configuration 
Service Console, 18

内存
Linux 操作环境中的 Sun StorEdge 

Configuration Service Agent, 26
Solaris 操作环境中的 Sun StorEdge 

Configuration Service Agent, 6, 18
Windows 上的 Sun StorEdge Configuration 

Service Agent, 18

硬盘驱动器
在主窗口中显示 , 38

优化
顺序 I/O

最大大小 , 166
随机 I/O

最大大小 , 166
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Z
在开始安装 Sun StorEdge Configuration Service 之

前
步骤 , 3

诊断报告器
故障排除 , 229

阵列管理
Array Admin Progress 命令 , 127, 131, 132, 133
菜单 , 133
查看进度 , 127

阵列管理控制器分配 , 45

直写高速缓存
定义 , 271

主窗口 , 91

主机 ID
在 Fibre 配置中更改 , 165

主机 LUN
删除 , 78
添加 , 77

注销 , 44

装入配置，请参阅恢复逻辑驱动器配置

状态
电池 , 102
设备 , 93
组 , 94

自动重建 , 131
定义 , 272

紫色设备状态图标
设备状态状况 , 93

组
定义 , 272
符号颜色 , 94
View Group 窗口 , 99
View Group 命令 , 99
颜色 , 95
状态 , 94
组名 , 39
索引   283
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